BMC Change Manager User Guide
for DB2® Universal Database™

Supporting
BMC Change Manager version 5.0.10 for DB2

May 2010
Contacting BMC Software

You can access the BMC Software website at http://www.bmc.com. From this website, you can obtain information about the company, its products, corporate offices, special events, and career opportunities.

United States and Canada

<table>
<thead>
<tr>
<th>Address</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMC SOFTWARE INC</td>
<td>713 918 8800 or</td>
<td>713 918 8000</td>
</tr>
<tr>
<td>2101 CITYWEST BLVD</td>
<td>800 841 2031</td>
<td></td>
</tr>
<tr>
<td>HOUSTON TX 77042-2827</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USA</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Outside United States and Canada

<table>
<thead>
<tr>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>(01) 713 918 8800</td>
<td>(01) 713 918 8000</td>
</tr>
</tbody>
</table>

© Copyright 2006-2009 BMC Software, Inc.

BMC, BMC Software, and the BMC Software logo are the exclusive properties of BMC Software, Inc., are registered with the U.S. Patent and Trademark Office, and may be registered or pending registration in other countries. All other BMC trademarks, service marks, and logos may be registered or pending registration in the U.S. or in other countries. All other trademarks or registered trademarks are the property of their respective owners.

AIX, DB2, IBM and Universal Database are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both.

Linux is the registered trademark of Linus Torvalds.

Solaris and Sun are trademarks or registered trademarks of Sun Microsystems, Inc., in the U.S. and other countries.

UNIX is the registered trademark of The Open Group in the US and other countries.

The information included in this documentation is the proprietary and confidential information of BMC Software, Inc., its affiliates, or licensors. Your use of this information is subject to the terms and conditions of the applicable End User License agreement for the product and to the proprietary and restricted rights notices included in the product documentation.

Restricted rights legend

U.S. Government Restricted Rights to Computer Software. UNPUBLISHED -- RIGHTS RESERVED UNDER THE COPYRIGHT LAWS OF THE UNITED STATES. Use, duplication, or disclosure of any data and computer software by the U.S. Government is subject to restrictions, as applicable, set forth in FAR Section 52.227-14, DFARS 252.227-7013, DFARS 252.227-7014, DFARS 252.227-7015, and DFARS 252.227-7025, as amended from time to time. Contractor/Manufacturer is BMC SOFTWARE INC, 2101 CITYWEST BLVD, HOUSTON TX 77042-2827, USA. Any contract notices should be sent to this address.

Customer support

You can obtain technical support by using the BMC Software Customer Support website or by contacting Customer Support by telephone or e-mail. To expedite your inquiry, see “Before contacting BMC.”
Support website
You can obtain technical support from BMC 24 hours a day, 7 days a week at http://www.bmc.com/support. From this website, you can
■ read overviews about support services and programs that BMC offers
■ find the most current information about BMC products
■ search a database for issues similar to yours and possible solutions
■ order or download product documentation
■ download products and maintenance
■ report an issue or ask a question
■ subscribe to receive proactive e-mail alerts when new product notices are released
■ find worldwide BMC support center locations and contact information, including e-mail addresses, fax numbers, and telephone numbers

Support by telephone or e-mail
In the United States and Canada, if you need technical support and do not have access to the web, call 800 537 1813 or send an e-mail message to customer_support@bmc.com. (In the subject line, enter SupID:<yourSupportContractID>, such as SupID:12345). Outside the United States and Canada, contact your local support center for assistance.

Before contacting BMC
Have the following information available so that Customer Support can begin working on your issue immediately:
■ product information
  — product name
  — product version (release number)
  — license number and password (trial or permanent)
■ operating system and environment information
  — machine type
  — operating system type, version, and service pack or other maintenance level such as PUT or PTF
  — system hardware configuration
  — serial numbers
  — related software (database, application, and communication) including type, version, and service pack or maintenance level
■ sequence of events leading to the issue
■ commands and options that you used
■ messages received (and the time and date that you received them)
  — product error messages
  — messages from the operating system, such as file system full
  — messages from related software
License key and password information

If you have questions about your license key or password, contact BMC as follows:

■ **(USA or Canada)** Contact the Order Services Password Team at 800 841 2031, or send an e-mail message to ContractsPasswordAdministration@bmc.com.

■ **(Europe, the Middle East, and Africa)** Fax your questions to EMEA Contracts Administration at +31 20 354 8702, or send an e-mail message to password@bmc.com.

■ **(Asia-Pacific)** Contact your BMC sales representative or your local BMC office.
# Contents

## Chapter 1 — Introducing BMC Change Manager for DB2

Overview ................................................................. 14  
  Summary of capabilities ............................................. 15
  Enhancements ........................................................... 15 
Exploring BMC Change Manager for DB2 ................................ 16 
  Exploring the GUI ......................................................... 16
  Viewing generated messages ....................................... 20
  Managing files ......................................................... 20
  Using the online help ............................................... 21
Using key components .................................................. 22
  Connecting to databases and repositories ...................... 22
  Managing schema ...................................................... 23
  Managing change ...................................................... 26
Taking the next step ................................................... 27

## Chapter 2 — Getting Started

Overview ................................................................. 30
Achieving your goals ................................................... 31
  Upgrading a packaged application by importing DDL ............ 32
  Upgrading a customized application by importing DDL ......... 33
  Granting user privileges .............................................. 34
  Creating an application’s initial baseline ......................... 34
  Creating new schema .................................................. 35
  Comparing schema ..................................................... 36
  Altering data structures ............................................. 36
  Replicating changes to another environment .................... 38

## Chapter 3 — Connecting to Databases and Repositories

Overview ................................................................. 42
Exploring the connection manager ................................... 42
  Exploring connections ............................................... 42
  Working online and offline ........................................ 44
Achieving your goals ................................................... 45
  Configuring a new host ............................................... 46
  Configuring a database connection ................................ 47
  Configuring a repository database connection .................. 48
  Setting up groups ...................................................... 50
  Distributing client configuration files ............................ 52
Figures

Toolbar .......................................................... 17
Job scheduler tool ........................................... 25
Application manager .......................................... 27
Workflow of Typical Tasks .................................... 31
Repository connection wizard — Welcome page ........ 49
Major work steps for altering database structures ...... 57
Filter Dialog Box ............................................... 59
Sample job log .................................................. 63
Job scheduler tool — What tab ......................... 76
Host login dialog box ........................................ 76
Major work steps for migration ............................ 87
Edit analysis options — Migrate Global tab (DB2) .... 89
Compare wizard — Welcome page ....................... 109
Compare wizard — specify compare types page ........ 110
Compare results window ..................................... 113
Edit OCDL tool showing an OCDL file ................ 116
Synchronization Workflow .................................. 118
Recovery Workflow .......................................... 119
Compare wizard—Specify filters page .................... 155
What tab of the job scheduler tool completed for processing OCDL files .... 167
Execute SQL tool .............................................. 173
Utilities tool ..................................................... 175
Privileges tab on the execute privileges tool ............ 178
Sample privileges grid showing actions .................. 186
Preview tab on the execute privileges tool ............... 187
# Tables

<table>
<thead>
<tr>
<th>Menu Commands Summary</th>
<th>16</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar Buttons</td>
<td>18</td>
</tr>
<tr>
<td>Accessing online Help</td>
<td>21</td>
</tr>
<tr>
<td>Where to go from here</td>
<td>27</td>
</tr>
<tr>
<td>Goals Achieved Using BMC Change Manager for DB2</td>
<td>32</td>
</tr>
<tr>
<td>Connection manager folders</td>
<td>43</td>
</tr>
<tr>
<td>Tasks for Configuring and Managing Connections</td>
<td>45</td>
</tr>
<tr>
<td>Where to Go from Here</td>
<td>54</td>
</tr>
<tr>
<td>Meaning and menu equivalents of action icons</td>
<td>60</td>
</tr>
<tr>
<td>Impact icons and the represented pending actions</td>
<td>62</td>
</tr>
<tr>
<td>Tasks for managing schema</td>
<td>66</td>
</tr>
<tr>
<td>Options for the patrolan command</td>
<td>72</td>
</tr>
<tr>
<td>Options for the patrolcl command</td>
<td>78</td>
</tr>
<tr>
<td>SVP environment variables</td>
<td>82</td>
</tr>
<tr>
<td>Options for the encrypt password command</td>
<td>83</td>
</tr>
<tr>
<td>Where to Go from Here</td>
<td>84</td>
</tr>
<tr>
<td>Tasks for migrating schema</td>
<td>94</td>
</tr>
<tr>
<td>Where to Go from Here</td>
<td>104</td>
</tr>
<tr>
<td>options for the patrolan command</td>
<td>115</td>
</tr>
<tr>
<td>Tasks for Managing Database Changes</td>
<td>120</td>
</tr>
<tr>
<td>Options for the patrolan command</td>
<td>127</td>
</tr>
<tr>
<td>Options for the patrolan command</td>
<td>128</td>
</tr>
<tr>
<td>Where to go from here</td>
<td>169</td>
</tr>
<tr>
<td>Tasks that use Change Manager tools</td>
<td>178</td>
</tr>
<tr>
<td>Where to Go from Here</td>
<td>191</td>
</tr>
</tbody>
</table>
Chapter 1 Introducing BMC Change Manager for DB2

The BMC Change Manager product for IBM® DB2® Universal Database™ (BMC Change Manager) provides a suite of tools that work together to form an integrated environment for browsing, modifying, and manipulating database structures.

This chapter discusses the following topics:

- product features and capabilities
- new features and enhancements added to the product since the last release

**Before you begin**

Before attempting to use BMC Change Manager for DB2, ensure that you have access to one or more of the supported platforms.

Before you use the product, also ensure that you have completed the tasks necessary to install both the client and server components of the product, and that the BMC Change Manager for DB2 server (`patroldb`) has been started on the necessary hosts. For details, see the *BMC Change Manager for DB2 Universal Database Installation Guide*.

**TIP**

For definitions of terminology used in this chapter, see the glossary at the back of this book and available in the Help.
BMC Change Manager for DB2 is a robust, production-level tool that enables you to globally manage change requests, application upgrades, and maintenance tasks for individual database objects, as well as custom or packaged applications. Whether you are a DBA, a system administrator, or a developer, you can use BMC Change Manager for DB2 to accomplish database administration goals.

BMC Change Manager for DB2 helps you to manage change simply in an increasingly complex database environment. The product, for example, enables you to automate and manage structural changes across your enterprise by supporting the following processes:

- **Change Management**
  Using the product’s Application Manager, you can take a snapshot, or *baseline*, of user applications. These baselines help you to maintain a record of changes to those applications as they evolve in development, test, or production environments. To help you manage these changes, the product enables you to determine the differences between two baselines and distribute the changes to other databases throughout your enterprise. The product also enables you to automate the process of propagating structural changes, while maintaining local modifications, such as authorizations and sizing parameters.

- **Synchronization**
  In development and replication environments, the product can help you synchronize data structures when differences arise between development efforts. After comparing the structures to identify the differences, you can apply the changes needed to synchronize them.

- **Recovery**
  If you discover that unwanted changes have been made to a data structure, you can use the product to quickly and easily restore the data structure to its pre-changed state.

**TIP**
BMC Change Manager for DB2 features an extensive online Help system to guide you through its features and functions while you work. You can access the Help through the Help menu or the Help buttons that appear on windows and dialog boxes.
Summary of capabilities

BMC Change Manager for DB2 gives you the tools to accomplish your database administration goals. The following list summarizes some of the tasks that you can perform with the product:

- modify or migrate database objects and data by using a GUI-based editor
- import DDL and validate it before implementing
- extract and manipulate objects according to customized scope and change rules
- analyze the impact of any proposed changes
- generate, edit, and save an optimized script to implement the changes
- specify when and where to run the change script
- simultaneously implement multiple structure changes enterprise-wide
- pinpoint and rectify the problem if the script fails
- create and run ad hoc SQL and other database commands
- maintain records of all changes
- compare data structures, objects, DDL, and application baselines
- back out changes to recover a stable data structure
- perform utility operations, including
  — exporting databases
  — importing databases
  — loading data into tables
- manage privileges for users and roles
- monitor multiple databases

Enhancements

The following enhancements apply to version 4.3 of BMC Change Manager for DB2:

- All BMC Change Manager product features now support table objects that contain columns with the XML data type.
- When you compare database objects, you can now compare the privileges of the objects as well as their structures.
- BMC Change Manager no longer requires the Change Manager License Server. If the Change Manager License Server is not available, BMC Change Manager skips the license server detection prompts. If you prefer, you can turn on the license server detection.
Exploring BMC Change Manager for DB2

BMC Change Manager for DB2 is a change management solution that ensures the availability of your critical packaged and custom applications. The product consists of several components that allow you to administer a consistent, reliable, and auditable change control process for implementing simple to complex changes across your enterprise.

The features and components of the product are discussed in the sections that follow.

Exploring the GUI

The following sections highlight key features of BMC Change Manager for DB2.

Window controls

BMC Change Manager for DB2 uses standard Windows conventions for window management, menu layout, and window presentation. You can use the basic Windows controls, such as menus and lists, for making selections. In addition, many product windows use labeled tabs to organize information.

NOTE

A gray background in a box or grid column indicates that it contains read-only information.

For more information about window controls, see the Help.

Menu descriptions

Common BMC Change Manager for DB2 commands are logically grouped in the menu bar. Table 1 lists and describes the menus.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Enables you to</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>manage session and command files, print scripts, and exit the product</td>
</tr>
<tr>
<td>Edit</td>
<td>select common editing commands</td>
</tr>
<tr>
<td>View</td>
<td>view or hide the Connection Manager and the status bar, and set display options for toolbars</td>
</tr>
</tbody>
</table>
The pop-up menus that are available throughout BMC Change Manager for DB2 offer quick access to context-relevant commands. Often, commands on the pop-up menu are also available on the Actions menu.

To access a pop-up menu, click the right mouse button in a product window. To dismiss the pop-up menu, move your cursor off the menu and click the mouse again. Note that some pop-up menus differ with context. To access commands that are specific to an object, right-click the object.

### Toolbar

The toolbar (see Figure 1) provides buttons to facilitate session and connection management. To enable or disable the display of the toolbar, from the menu, choose View => Customize Toolbars. Then, in the Toolbars dialog box, select or clear the check boxes displayed in the Toolbars pane.

![Figure 1 Toolbar](image)

The buttons on the toolbar are grouped by type and have corresponding menu commands. Table 2 describes each button.
<table>
<thead>
<tr>
<th>Button</th>
<th>Menu Equivalent</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New" /></td>
<td>File=&gt;New</td>
<td>opens a new command file for the Execute SQL tool</td>
</tr>
<tr>
<td><img src="image" alt="Open" /></td>
<td>File=&gt;Open</td>
<td>opens a saved session or file</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td>File=&gt;Save</td>
<td>saves an open session or file</td>
</tr>
<tr>
<td><img src="image" alt="Close" /></td>
<td>File=&gt;Close</td>
<td>closes a connection</td>
</tr>
<tr>
<td><img src="image" alt="Manager" /></td>
<td>View=&gt;Connection Manager</td>
<td>shows or hides the Connection Manager window</td>
</tr>
<tr>
<td><img src="image" alt="Connect" /></td>
<td>Connections=&gt;Connect</td>
<td>connects to a database</td>
</tr>
<tr>
<td><img src="image" alt="Disconnect" /></td>
<td>Connections=&gt;Disconnect</td>
<td>disconnects from a database</td>
</tr>
<tr>
<td><img src="image" alt="Refresh Connection" /></td>
<td>Connections=&gt;Refresh</td>
<td>refreshes your session</td>
</tr>
<tr>
<td><img src="image" alt="Stop Extraction" /></td>
<td>Connections=&gt;Stop Extraction</td>
<td>stops an extraction in progress</td>
</tr>
<tr>
<td><img src="image" alt="Help Topics" /></td>
<td>Help=&gt;Help Topics</td>
<td>displays online Help</td>
</tr>
<tr>
<td><img src="image" alt="Connection status" /></td>
<td>Connection status (display only)</td>
<td>becomes animated when the product makes or restores a connection or extracts an object</td>
</tr>
</tbody>
</table>
Status Bar

*NOTE*
Button and menu command functions may vary depending on the tools in use in the current session.

Located at the bottom of the product window, the status bar reflects such product parameters as the progress (in percent complete) of an object extraction, the DB2 status of the current session (online or offline), and descriptions of menu commands. You can enable or disable the display of the status bar by selecting or clearing the Status Bar command on the View menu.

Object trees and object detail view

An object tree is a structure that displays database objects by type. It also shows hierarchical object relationships and dependencies, and it enables the display of dependent objects.

When you select an object type in the object folder pane, the name of each associated object is listed in the object pane.

*NOTE*
- The object pane also includes columns that list various attributes of each object. You can sort the objects by their attributes, hide or display columns, and reorder the data in an attribute column.
- For details about the objects, see the Help.

Drag-and-drop

The product’s drag-and-drop feature is a convenient method of invoking actions. For example, you can use the drag-and-drop capability to

- open an object editor by dragging an object from the object tree to any blank area of the product window
- complete the object name and object type information in ad hoc SQL statements by dragging the relevant object to the Execute SQL window, as discussed in “Creating and running ad hoc statements” on page 179
- begin the Compare process for two extracted objects by dragging one object onto the other object on the Object pane of the Object Manager
Viewing generated messages

The Message Log displays the messages that are generated while you work within the BMC Change Manager for DB2 environment.

To view operational messages relevant to the active session, click the `host:database server` tab.

To view internal messages and connection-attempt errors that are not directly related to a specific session, click the `System Messages` tab.

You manage the Message Log and the data it displays by selecting options from a pop-up menu. To access the pop-up menu, right-click anywhere on the Message Log pane.

From the menu, you can perform the following actions:

- edit objects
- specify the types of messages displayed (Errors, Warnings, Information)
- save, print, copy, or clear all messages
- hide the Message Log pane

Other menu options include printing and saving messages in a text file.

*TIP*
To display a hidden Message Log, from the menu, choose `Tools => Message Log`.

Managing files

You use standard Windows file management commands, for instance, Create, Open, Close, and Save, to manage the files that you create and use in BMC Change Manager for DB2. Some of the files you can manage include

- **Command file (.mcp)** files contain commands that are generated on the Execute SQL tool.

- **Edit Scripts tool (.msl)** files contain work scripts that the product generates.

- **Utility commands (.utl)** files contain utility commands that are generated by a utility tool.
Work session (.mds) files contain work that you have saved using the Save or Save As command. You may save a session to a drive or diskette.

**TIP**
If you encounter problems while using the product, save the work session and copy the relevant items to a diskette or tape. You can send the diskette or tape to a BMC Software technical support analyst for analysis.

# Using the online help

BMC Change Manager for DB2 contains a comprehensive online Help system to assist you in using the product effectively. Table 3 lists the ways in which you can access the Help.

**Table 3 Accessing online Help**

<table>
<thead>
<tr>
<th>To access Help from a</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>menu</td>
<td>choose Help</td>
</tr>
<tr>
<td>window</td>
<td>click the Help button</td>
</tr>
<tr>
<td></td>
<td>The Help button may appear as a large question mark icon near the top right corner of the window.</td>
</tr>
<tr>
<td>dialog box</td>
<td>click the Help button</td>
</tr>
</tbody>
</table>

When you access the online Help, the product displays the Help Viewer. The viewer consists of a button bar positioned above two window panes. You can use the button bar to print Help topics, navigate between topics, and customize the viewer to suit your needs.

The left pane of the Help Viewer is called the Navigation pane. It contains features that enable you to quickly locate the information that you need. You can find the information by using any of the following techniques:

- **Find by topic**
  Click the Contents tab to browse through related topics.

- **Find by keyword**
  Click the Index tab to display an index of Help topics.

- **Search by word or phrase**
  Click the Search tab to display a full-text search utility. This utility enables you to find any word or phrase that is used in the Help.
Using key components

The following sections highlight the key components of BMC Change Manager for DB2.

Connecting to databases and repositories

To connect to a database or to a repository database, you must first define a connection profile and a host for that database or repository database. A connection profile is a set of connection settings, including user ID and password, server name, and host name. A host is a server with a BMC Change Manager for DB2 server and a DB2 Universal Database.

You configure BMC Change Manager for DB2 connections by using the Connection Manager.
Exploring the connection manager

You use the Connection Manager to set up and administer connections to databases and repository databases. You set up your connections by using wizards provided by the Connection Manager. The wizards guide you through the process of defining a host and creating connection profiles (see “Achieving your goals” on page 45). You manage these connections by using options on the Connections menu.

Managing schema

DBAs and application developers face a daily stream of requests for changes to their database environments. Business requirements demand that they answer the call for constant upgrades to applications to maintain performance, comply with standards, and leverage enhancements. Typically, though, the number of change requests exceeds the amount of resources and time needed to implement them. The solution is to have a tool that automates and simplifies the process of changing data structures.

BMC Change Manager for DB2 enables you to specify changes to multiple objects, analyze the impact of the changes to the objects and related structures before you change anything, build an optimized script to implement the changes, and schedule the time and place that the script runs. You perform all these actions from the Object Manager and the Job Scheduler tool.

Exploring the object manager

The Object Manager consists of a toolbar and three tabs.

Toolbar buttons

The following list describes the buttons located on the toolbar:

- **Reset**
  Click this button to clear all pending changes in the current session.

- **Analysis**
  Click this button to display the Analysis Wizard and analyze specified changes.

- **Build**
  Click this button to generate an optimized change script.

- **Compare**
  Click this button to open the Compare Wizard and initiate different Compare scenarios.
Managing schema

- **Reports**
  Click this button to open a dialog box that enables you to configure reports about pending changes and the objects affected by those changes.

**Objects tab**

The Objects tab displays folder icons on a collapsible tree structure. Each folder contains an object tree that lists the objects that you can manage.

---

**NOTE**

BMC Change Manager for DB2 uses icons to represent each type of database object on the object tree. For details about these icons, see the Help.

---

**Pending actions tab**

The Pending Actions tab displays the changes that you have requested during the current session.

**Impacted objects tab**

After you have run an analysis on the impact of your requested changes, BMC Change Manager for DB2 displays the objects affected by the pending actions. These objects are displayed on the Impacted Objects tab. Impact icons appear to the left of analyzed objects. These icons represent the change that occurs to that object when you implement the change script.

---

**NOTE**

You may choose to display the impacted objects with their dependents or by object type.

---

**Exploring the edit scripts tool**

The Edit Scripts tool enables you to edit and print change, migration, or utility scripts that you create using BMC Change Manager for DB2. You can also use the Edit Scripts tool to convert a script to DDL.
Exploring the job scheduler tool

The Job Scheduler tool (see Figure 2 on page 25) enables you to manage script execution jobs. You control elements of script execution using options displayed on the tool’s four tabs:

- The **What** tab enables you to specify the script that runs.
- The **When** tab enables you to schedule the date and time the job runs.
- The **Where** tab enables you to specify the groups or connection profiles against which the job runs.
- The **Notification** tab enables you to specify e-mail notification options when a job is complete or terminates abnormally.
- The **Job Queue** tab enables you to directly manage the job and view the job’s run status and statistics. You can also archive completed jobs to free up resources for active jobs.

**Figure 2  Job scheduler tool**

You have the following options for running a script using the Job Scheduler tool:

- Click the **Submit** button on the What tab. The script begins running immediately.

---

**NOTE**

The Job Scheduler tool handles all scripts that are generated by the product, with the exception of SQL that is generated by the Execute SQL tool.
Click the When tab and select the Schedule option button to schedule the script to run at a later date. Selecting this option enables the Start Date and Run Job boxes, which you use to specify when to run the script. After entering a date and time, click the Submit button to place the script in the job queue.

**NOTE**

The first time that you run or schedule a script, the product verifies your user login and password for the host.

When you successfully submit a script, a sequence number for that job appears in a message box, and an entry for the job is added to the appropriate host on the Job Queue tab. From this tab, you can

- restart the job if it ended due to a processing error
- view the job log for each job
- place a job on hold
- release a job from hold
- delete a scheduled job from the job queue
- archive a completed job, which removes it from the job queue and frees up resources but allows you to save the job information indefinitely

### Managing change

Managing change in your database requires a way to track changes, a process to evaluate the differences between data structures, and the means to synchronize the data structures, if necessary. BMC Change Manager for DB2 not only provides you with the ways and means to achieve these goals, but enables you to automate and expedite the process.

You manage change in your environments by using the Application Manager (see Figure 3 on page 27).

### Exploring the application manager

After you connect to a repository database, the Application Manager appears. On the Application Manager, you can view

- application profiles, which contain all the objects that correspond to a particular use of an application
- baselines, which give a point-in-time view of the state of an application
- filters, which you use to define and manage subsets of objects and their attributes
- change logs, which enable you to track all of the changes made to an application over time

**Figure 3  Application manager**

Now that you have an idea of the features and capabilities of BMC Change Manager for DB2, see Table 4 to discover some of the goals that the product can help you to achieve.

**Table 4  Where to go from here (part 1 of 2)**

<table>
<thead>
<tr>
<th>Goal</th>
<th>Where to go</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review steps for accomplishing typical DBA tasks.</td>
<td>Chapter 2, “Getting Started” on page 29</td>
</tr>
<tr>
<td>Learn about configuring BMC Change Manager for DB2 for use.</td>
<td>Chapter 3, “Connecting to Databases and Repositories” on page 41</td>
</tr>
<tr>
<td>Learn about modifying database objects, analyzing the impact of your changes before you implement them, and implementing them.</td>
<td>Chapter 4, “Altering Data Structures” on page 55</td>
</tr>
<tr>
<td>Learn about cloning objects and data in a database, migrating them to another environment, or using them to create an environment.</td>
<td>Chapter 5, “Cloning and Propagating Objects, Data, and Environments” on page 85</td>
</tr>
<tr>
<td>Goal</td>
<td>Where to go</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>Learn about tracking database changes, discovering the differences between data structures, synchronizing the structures, and recovering environments.</td>
<td>Chapter 6, “Managing Database Changes” on page 105</td>
</tr>
<tr>
<td>Learn about the BMC Change Manager for DB2 tools that help you administer your database environment.</td>
<td>Chapter 7, “Change Manager Tools” on page 171</td>
</tr>
</tbody>
</table>
You can use the BMC Change Manager for DB2 product for the DB2 product to administer and manage environments across your enterprise. And while the way you manage your environments is as unique to your company as your user ID, some tasks that you perform are common to all database shops. This chapter provides brief instructions for accomplishing some of these typical tasks using BMC Change Manager for DB2.

This chapter discusses the following topics:

■ importing DDL files
■ setting user privileges
■ creating a process to track changes
■ altering data structures
■ propagating changes

Before you begin

Before attempting to use BMC Change Manager for DB2 Universal Database, ensure that you have access to one or more of the supported platforms. A list of supported platforms appears on the Change Manager kit label.

Before you use the product, also ensure that you have completed the tasks necessary to install both the client and server components of the product, and that the BMC Change Manager for DB2 server (patroldb) has been started on the necessary hosts. For details, see the "BMC Change Manager for DB2 Universal Database Installation Guide".

NOTE

This chapter assumes that you are familiar with the features and functionality of the product. For more detailed information about any of the components or capabilities discussed in this chapter, see Chapter 1, “Introducing BMC Change Manager for DB2”, Chapter 3, “Connecting to Databases and Repositories”, Chapter 4, “Altering Data Structures”, Chapter 5, “Cloning and Propagating Objects, Data, and Environments”, and Chapter 6, “Managing Database Changes”.

Chapter 2  Getting Started  29
Overview

Every organization, every environment, and every application is unique. Change management within every organization, environment, and application, however, shares some common traits and needs.

Typically, an organization’s database personnel receive daily change and upgrade requests for both custom and purchased applications. In addition, they must administer the current environments, maintain data integrity, improve application performance, develop new applications, track changes in case of audits, and replicate the changes to multiple, even physically remote, sites.

BMC Change Manager for DB2 enables you to achieve all these goals efficiently and, in most cases, automatically. The next section provides instructions for performing the following goals:

- upgrade a packaged application by importing DDL
- upgrade a customized application by importing DDL
- provide privileges to a new DBA
- create a baseline to track changes to the Production (Prod) application
- create a new schema for the Development (Dev) environment in which to validate change requests
- compare the Development environment to the Production environment
- implement the changes in the Development environment
- replicate the changes to the Production environment

Figure 4 on page 31 maps the typical workflow that you follow to complete these tasks using the product.
Achieving your goals

This section provides step-by-step procedures for some typical tasks that you can perform with BMC Change Manager for DB2. Table 5 lists these procedures by goal and shows their locations in the chapter.
Upgrading a packaged application by importing DDL

You receive upgrade DDL for your uncustomized packaged applications. You import it, check it for accuracy, and execute the changes.

1. Connect to the appropriate database (For more information, see Chapter 3, “Connecting to Databases and Repositories”).

2. From the Tools menu, choose Import DDL/OCDL.

3. Complete the Import Objects to a Work Session dialog box.

4. On the toolbar of the Object Manager, click the Analysis button, and follow the instructions on the Analysis Wizard.

5. Review the impact of the changes.
   
   A. On the Pending Actions tab and the Impacted Objects tab, review the impact of the changes on the objects in your application.

   B. On the Edit Scripts tool, review the change script.

6. Click Run.

---

**NOTE**

You can monitor the progress of the running job by using the Job Scheduler tool (For more information, see “Scheduling a script from the client” on page 75).

---

**Table 5**  
Goals Achieved Using BMC Change Manager for DB2

<table>
<thead>
<tr>
<th>Task</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrading a packaged application by importing DDL</td>
<td>on page 32</td>
</tr>
<tr>
<td>Upgrading a customized application by importing DDL</td>
<td>on page 33</td>
</tr>
<tr>
<td>Granting user privileges</td>
<td>on page 34</td>
</tr>
<tr>
<td>Creating an application’s initial baseline</td>
<td>on page 34</td>
</tr>
<tr>
<td>Creating new schema</td>
<td>on page 35</td>
</tr>
<tr>
<td>Comparing schema</td>
<td>on page 36</td>
</tr>
<tr>
<td>Altering data structures</td>
<td>on page 36</td>
</tr>
<tr>
<td>Replicating changes to another environment</td>
<td>on page 38</td>
</tr>
</tbody>
</table>
Upgrading a customized application by importing DDL

You receive upgrade DDL for your customized packaged applications. You check it for accuracy and impact, modify the script to leave your customizations unchanged, and execute the changes.

1. Connect to the appropriate database (For more information, see Chapter 3, “Connecting to Databases and Repositories”).

2. On the toolbar of the Object Manager, click the **Compare** button.

3. Follow the instructions on the Compare Wizard for the “Compare a database instance with a DDL file” scenario.

4. On the Compare Results window, click the **Apply Changes** button.

   **NOTE**

   Clicking the Apply Changes button only specifies the changes for analysis; it does *not* implement them.

5. On the Object Manager, review the impact of the changes on your application.

   A. To remove changes to an object, right-click the object on the Objects tab, and choose **Reset** from the pop-up menu.

   B. On the toolbar of the Object Manager, click the **Analysis** button, and follow the instructions on the Analysis Wizard.

   C. Repeat step 5 until you are satisfied with the results.

6. On the toolbar of the Object Manager, click the **Build** button.

7. On the Edit Scripts tool, click **Run**.

   **NOTE**

   You can monitor the progress of the running job by using the Job Scheduler tool (For more information, see “Scheduling a script from the client” on page 75).
Granting user privileges

A new DBA joins your department. You use the Execute Privileges tool to grant your co-worker access to database objects.

1. On the Object Manager, right-click the objects of interest, and choose Privileges from the pop-up menu.

2. On the Privileges Filter Options dialog box, specify the requested information, and click OK.

3. On the Privileges tab, click Grant.

4. Complete the Grant Object Privileges dialog box, and click Apply.

5. Repeat step 4 to grant additional privileges for the active object, as needed, and click OK.

6. Click the Run button.

Creating an application’s initial baseline

The new DBA wants to work on the Production database (Prod). You prudently take a baseline of Prod, which gives you a snapshot of the unchanged environment to facilitate change tracking and recovery, if necessary. Because Prod has no previous baseline, you create a repository database (which stores the application profile), and then create an application profile (which houses the baseline and any associated filter objects). Then, you create the baseline.

To create a repository connection

1. On the Connection Manager, right-click the Change Manager Repositories folder and choose Configure New Repository Connection.

2. Follow the instructions on the Repository Connection Wizard.

To create a repository

1. Double-click the repository database connection in the Change Manager Repositories folder.

2. Complete the Create Repository dialog box, and click OK.
Creating new schema

You prefer that the new DBA not alter structures in the Production (Prod) database, so you create an alternative environment in which they can work. You copy all of the objects in Prod and replicate them, with edits, to the Development (Dev) database.

1. Open a connection to the Prod and Dev databases.
2. On the Object Manager of the Prod connection, extract and select the target objects and their dependent objects.
3. Right-click and choose Migrate from the pop-up menu.
4. Use the object editors to modify the objects as necessary.

TIP
Select or create a Scope filter to define the scope of the objects to include in the baseline.

TIP
You can schedule baseline creation to run on the server. Automate your change tracking process by scheduling periodic baselining using this feature.

Creating new schema

3. Click the Run now button.

To create an application profile

1. On the toolbar of the Application Manager, click the App Wiz button.
2. Follow the instructions on the Application Profile Wizard.

To create a baseline

1. Open the Application Profile that you created for Prod, right-click on Baseline, and choose Create.
2. Follow the instructions on the Create a baseline Wizard.
Comparing schema

To ensure that the Production (Prod) schema to Development (Dev) schema migration worked successfully, you compare the two schemas. You use a mask filter to hide the changes that you made to the migrated objects. If the migration is successful, the Compare Results window displays the message \textit{No changes}.

1. Open connections to the Prod and Dev databases.

2. On the Object Manager, click the \textit{Compare} button.

3. Follow the instructions on the Compare Wizard for the “Compare two schemas” scenario. On the Specify Filters page, select or create the mask filter.

### Altering data structures

A change request arrives requiring you to add a column to a table, create a table index on the table using the new column, and drop a trigger object. Working in the Development (Dev) database, you specify changes, run the impact analysis on the client, and schedule the change script to run on the server. For instructions on altering objects, see “Creating an object” on page 67, “Editing an object” on page 68, and “Dropping an object” on page 69.
To add a table column to an existing table

1. On the toolbar of the Object Manager, click the **Edit** button.
2. Select the **Table** icon, specify the table name on the Edit Assistant, and click **Finish**.
3. Create the new column on the Table Editor according to the specifications in the change request.
4. When you finish defining the new column, click **save** to save the changes.

**NOTE**
You are only requesting an action, not implementing it, at this point. The action does not occur in your database until you run the change script.

To add or modify partition of an existing table

1. On the toolbar of the Object Manager, click the **Edit** button.
2. Select the **Table** icon, specify the table name on the Edit Assistant, and click **Finish**.
3. Click **Edit Partition**.
4. Create or Modify partitions on the Table Partition Editor according to the specifications in the change request.
5. When you finish defining the new column, click **save** to save the changes.

To create an index

1. In the Object Manager window, right-click the **Index** object.
2. From the pop-up menu, choose **Create**.
3. Specify the requested information on the Index Editor.
4. When you finish defining the new column, click **save** to save the index.

To drop a trigger

1. On the toolbar of the Object Manager, click the **Drop** button.
2. Select the **Trigger** icon, specify the object name on the Drop Assistant, and click **Finish**.
To run an impact analysis of the changes

1. On the toolbar of the Object Manager, click the Analysis button.

2. Follow the instructions on the Analysis Wizard for a Changes analysis type run on the client.

**TIP**
Click the Advanced Analysis Options button on the Options page to set general analysis, script generation, and execution options.

To implement changes on the server

1. On the toolbar of the Object Manager, click the Build button to generate a change script, if necessary.

**TIP**
BMC Change Manager for DB2 automatically generates a change script at the end of an analysis if you select the Automatic Script Generation check box on the Location page of the Analysis Wizard.

2. On the Edit Scripts tool, click the Schedule button, and save the script.

**NOTE**
You can save the script as an optimized DDL file.

3. Complete the requested information on the Job Scheduler tool and click Submit.

Replicating changes to another environment

You replicate (migrate) the database changes from the Development (Dev) environment to the Production (Prod) environment. First, you compare the initial Dev baseline to the current Dev database. The results of the compare, the differences between the previous and the current state of the database, become a record of the changes made to the Dev environment. Next, you baseline Prod for safekeeping. Then, you apply the change record to Prod.
To generate a change record (OCDL file)

1. Open a repository connection to Dev.

2. On the Application Manager, click the Compare button.

3. Follow the instructions on the Compare Wizard for the “Generate changes between a baseline and a database instance” scenario.

   **TIP**
   Specify a mask filter on the Specify Filters page to preserve any differences that you know exist between Dev and Prod (such as storage spacings).

4. On the Compare Results window, click Export OCDL, and name and save the file.

To propagate changes

   **TIP**
   Prior to propagating changes to an environment, you should baseline the goal environment (Prod) to provide a point of reference to which to recover, if necessary.

1. Open a database connection to Prod.

2. From the Tools menu, choose Import DDL/OCDL.

3. Complete the Import Objects to a Work Session dialog box.

   **TIP**
   Specify change filters on the Import Objects to a Work Session dialog box to globally change attributes, such as object owner from Dev to Prod for example, during change record propagation.

4. Click the Analysis button and follow the instructions on the Analysis Wizard.

5. Review the impact of the changes.

   A. On the Pending Actions tab and the Impacted Objects tab, review the impact of the changes on the objects in your application.

   B. On the Edit Scripts tool, review the change script.

6. Click Run.
**NOTE**
You can monitor the progress of the running job by using the Job Scheduler tool (For more information, see “Scheduling a script from the client” on page 75).
Chapter 3 Connecting to Databases and Repositories

The product features the Connection Manager, a tool that helps you to configure the product so that you can connect to a database server. After you connect to a database server, you can use the BMC Change Manager for DB2 product to manage your environments.

This chapter discusses the following topics:

- using the Connection Manager
- creating connection profiles
- connecting to a database instance or to a repository database
- working online and offline

Before you begin

Before you attempt to use BMC Change Manager for DB2, ensure that you have access to one or more of the supported platforms.

Before you use the product, also ensure that you have completed the tasks necessary to install both the client and server components of the product, and that the BMC Change Manager for DB2 server (patroldb) has been started on the necessary hosts. For details, see the BMC Change Manager for DB2 Universal Database Installation Guide.

Before you attempt to configure the product for connecting to databases or repository databases, you should familiarize yourself with the features and functionality of the Connection Manager. For an overview of the Connection Manager, see “Connecting to databases and repositories” on page 22.
Overview

Before you can connect to a database or to a repository database, you must first configure the product for use. Configuring the product means specifying connection settings, such as user ID and password, server name, and host name.

NOTE

A host is a system on which both the BMC Change Manager for DB2 server are installed. The BMC Change Manager for DB2 server provides database access and job scheduling services for the BMC Change Manager for DB2 client.

BMC Change Manager for DB2 automatically stores the settings as a connection profile. To define a connection profile, you use the Connection Manager.

Exploring the connection manager

When you first start the product, the Connection Manager window appears on the left side of the window by default. The Connection Manager window contains host, connection, and group information for DB2 that you install.

TIP

You can position, or “dock,” the Connection Manager window on any side of the product window. You can also hide or display the Connection Manager by clicking . For instructions about customizing the Connection Manager, see the Help.

Exploring connections

You use the Connection Manager to help you to connect to databases and repositories. You can also use the Connection Manager to group your connections.

Connection manager folders

The Connection Manager displays a connection tree for DB2 Universal Database installed. A Connection Manager connection tree contains the folders described in Table 6 on page 3-43.
Table 6  Connection manager folders

<table>
<thead>
<tr>
<th>Folder</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Connections</td>
<td>contains the connections that are currently connected to a database or repository database</td>
</tr>
<tr>
<td></td>
<td>To enable you to distinguish multiple active connections to the same database instance, the</td>
</tr>
<tr>
<td></td>
<td>product inserts a number in parentheses at the end of the connection name. For example,</td>
</tr>
<tr>
<td></td>
<td>MYSERVER:RDBMS123[2].</td>
</tr>
<tr>
<td>Database Connections</td>
<td>contains all database connection profiles that are currently configured for DB2 Universal</td>
</tr>
<tr>
<td></td>
<td>Database.</td>
</tr>
<tr>
<td></td>
<td>A database connection profile specifies the host, database server, and database login or</td>
</tr>
<tr>
<td></td>
<td>user ID that you want to use for that connection.</td>
</tr>
<tr>
<td>Hosts</td>
<td>contains the currently configured hosts</td>
</tr>
<tr>
<td></td>
<td>Each host or server has both a BMC Change Manager for DB2 server and DB2 Universal Database</td>
</tr>
<tr>
<td>Change Manager</td>
<td>contains all of the currently configured repository database connections for the DB2 Universal Database</td>
</tr>
<tr>
<td>Repositories</td>
<td>Repository databases contain all the information associated with an application.</td>
</tr>
<tr>
<td>Groups</td>
<td>contains any currently defined groups for the DB2 Universal Database</td>
</tr>
<tr>
<td></td>
<td>Groups represent database connections that have a logical link to each other.</td>
</tr>
</tbody>
</table>

**Database connections**

A database connection enables you to access the objects and data in a database. You can have multiple database connections at one time. You may switch among multiple, open connections by double-clicking a connection name under the Active Connections folder in the Connection Manager. Each database connection has its own Object Manager window.

**Repository database connections**

A repository database connection enables you to access a repository database on a database server to create and manage application profiles. A repository database contains product-generated tables that store all of the data that are associated with applications, filters, and baselines. You may have multiple repository database connections at one time. Each repository database connection has its own Application Manager window (see Figure 3 on page 27).
Groups

A group is a container that you create to represent database connections that have some logical link to each other within your environment. For example, assume that you have the same application on four different servers. By defining one group that contains four database connections (that is, a connection for each server), you can manage the database objects on all four servers from a single location. You could, for instance, schedule a job to run at the group level and the job would run on each connection that is defined in the group.

When you add a connection profile to a group, the profile can have properties that differ from the original connection profile stored in the Database Connections folder. Say, for example, that you have a database instance named Zebra1, and you place it in the group connection profile named ZebraHerd. You can now specify that BMC Change Manager for DB2 apply a change filter to ZebraHerd each time it opens ZebraHerd. When you connect to Zebra1, however, the change filter is not applied.

Working online and offline

Typically, you work with BMC Change Manager for DB2 while connected to a database. The set of actions that you perform with the product from the time you connect to a database until you disconnect from that database is called an online work session. You can access the current online work sessions through the Active Connections folder on the Connection Manager.

You can have multiple sessions connected to a single database at one time, but each session can have only one connection.

NOTE

Repository sizing guidelines vary depending on the number, size, and complexity of the baselines being stored and the frequency with which you baseline your applications. For detailed repository sizing guidelines, see Distributed Systems Repository Sizing at ftp://ftp.bmc.com/pub/patroldb/change/3.3.01/patches/r84702.pdf.

TIP

To retrieve a defined set of objects from all profiles in a group, drag a scope filter to the group. To apply a set of changes to all profiles in a group, drag a change filter or change log to the group. For more information about filters, see “Exploring filters” on page 107.
When you are finished, you can save these online work sessions for later use. BMC Change Manager for DB2 saves work sessions as .mds files. You manage session (.mds) files through the options available from the File menu.

You may accept the pre-set work session options or change your work session default directory through the Edit User Preferences dialog box. You access this dialog box by choosing User Preferences from the Options menu.

BMC Change Manager for DB2 also offers a unique feature that allows you to take a work session offline and work in disconnected mode. An offline session is logically connected but physically disconnected. When you need to access the database again, you can restore the disconnected session.

In an offline session, you are limited to work that does not require database access. For example, you can disconnect a session and edit objects that you extracted and saved prior to disconnecting, but you must reconnect to the database to run analysis and execute the changes. The status of the current session is shown in the status bar.

**NOTE**
You cannot work offline with a repository database. You must be connected to a repository database to work in that repository database. Also, you cannot save a repository database connection as a saved session.

Working offline helps balance the system workload. For example, working offline with extracted objects reduces the amount of real-time traffic between the client and server.

Additionally, if you save a session before taking it offline, you can

- take work home or to another off-site location and continue working
- send work-in-progress to someone else
- send problematic work sessions to BMC Software for diagnosis

### Achieving your goals

This section provides step-by-step procedures for configuring and managing connections. Table 7 lists these procedures by task and shows their locations in the chapter.

#### Table 7 Tasks for Configuring and Managing Connections (part 1 of 2)

<table>
<thead>
<tr>
<th>Task</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring a new host</td>
<td>on page 46</td>
</tr>
<tr>
<td>Configuring a database connection</td>
<td>on page 47</td>
</tr>
</tbody>
</table>
Configuring a new host

Configuring a host means specifying the properties of the database servers, or hosts, to which you want to connect. After you define the host, you may configure one or more connection profiles for the host.

1 In the Connection Manager window, right-click the Hosts folder and choose Configure New Host from the pop-up menu.

The Host Wizard Welcome page appears.

**NOTE**
If you did not define a host in a previous work session, the Host Wizard automatically appears when you open the product.

2 Click Next to continue.

**TIP**
To go back and undo a selection, click Back. To continue, click Next.

3 On the Specify a Host page, enter the host name in the Host box.

**TIP**
You can type a host name or an IP number in the Host box. If you enter an IP number, you can enter a descriptive name in the Name box.

4 Click Next to continue.

The Description page appears.

5 To enter advanced host information, click the Advanced button.

---

Table 7  Tasks for Configuring and Managing Connections (part 2 of 2)

<table>
<thead>
<tr>
<th>Task</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring a repository database connection</td>
<td>on page 48</td>
</tr>
<tr>
<td>Setting up groups</td>
<td>on page 50</td>
</tr>
<tr>
<td>Distributing client configuration files</td>
<td>on page 52</td>
</tr>
<tr>
<td>Connecting to a database or to a repository database</td>
<td>on page 53</td>
</tr>
</tbody>
</table>
Configuring a database connection

To use a particular database instance for object and change management, you must create a database connection and a repository database connection. After you create a database connection, you can add it to a group in the Groups folder.

1 In the Connection Manager window, right-click the Database Connections folder and choose Configure New Database Connection from the pop-up menu.

The Connection Wizard appears.

2 Click Next to continue.

NOTE
If you defined a host in a previous work session, the Connect dialog box automatically appears when you open the product. Click Help for information about using the Connect dialog box.

3 On the Select a Host page, select a host name in the Hosts list and click Next.
**Configuring a repository database connection**

You use the Connection Manager to configure a repository database connection profile. You can have only one repository database connection per host.

1. In the Connection Manager window, right-click the Change Manager Repositories folder and choose **Configure New Repository Connection** from the pop-up menu.

   The Repository Connection Wizard appears (see Figure 5).

---

**NOTE**

If the host list is empty or does not contain the host that you want, you need to define the host by using the Host Wizard. To access the Host Wizard, click the **Define New Host** button.

4. On the Specify a Database Instance page, enter the name of the database server and the user ID.

   **A** In the **Database Instance** box, type the name of the database server.

   Alternatively, you can click the **Discovery** button to display the available database instances, select an instance, and click **OK**.

   **B** In the **Database User ID** text box, type the user ID that you use to connect to the database.

   **C** Click **Next** to continue.

5. On the Specify a Name page, provide a name and a description for the connection.

   **A** Type the name for this connection in the **Name** box, or accept the default name that the product creates (for example, `BMCREP:host:dbservername`).

   **B** Optionally, type a description for this connection in the **Description** box.

   **C** Click **Next** to continue.

6. On the Summary page, review your selections and click **Finish** to define the connection.
2 On the Welcome page, perform one of the following tasks:

- From the list, choose a connection where the repository database resides.
- If the connection where the repository database resides is not listed, click Next.

   **TIP**
   Use the Next and Back buttons to navigate through the Connection Wizard. To go back and undo a selection, click Back. To continue, click Next.

On the Select a Host page, select a host name in the Hosts list and then click Next.

   **NOTE**
   If the host list is empty or does not contain the host that you want, you need to define the host by using the Host Wizard. To access the Host Wizard, click the Define New Host button.

3 On the Specify a Database Instance page, provide a database instance and a user ID.

   **A** In the Database Instance box, type the name of the database server.

   Alternatively, you can click the Discovery button to display the available database instances, select an instance, and click OK.

   **B** In the Database User ID box, type the user ID that you will use to connect to the database.

   **C** Click Next to continue.
Setting up groups

4 On the Specify a Name page, provide a name and a description for the connection.

A Type the name for this connection in the Name box, or accept the default name that the product creates (for example, BMCREP:host:dbname).

B Optionally, type a description for this connection in the Description box.

C Click Next to continue.

5 On the Summary page, review your selections and click Finish to define the connection.

NOTE
Repository sizing guidelines and also vary depending on the number, size, and complexity of the baselines being stored and the frequency with which you baseline your applications. For detailed repository sizing guidelines, see Distributed Systems Repository Sizing at ftp://ftp.bmc.com/pub/patroldb/change/3.3.01/patches/r84702.pdf.

Setting up groups

You can group your database connection profiles in a way that makes sense within your enterprise. You can create your own groups and add connection profiles to them. You can edit, copy, and delete groups. You can also nest groups within groups.

To add a group

1 On the Connection Manager window, right-click the Groups folder and choose Add a Group from the pop-up menu.

2 In the Add a Group dialog box, type a group name and a group description, and click OK.

To add one or more database connections to a group

1 On the Connection Manager window, expand the Groups folder.

2 Right-click the group to which you want to add connections, and choose Add a Connection from the pop-up menu.

3 In the Add Connections dialog box, select one or more database connections to add to the group, and click OK.
To edit a group

1 On the Connection Manager window, expand the Groups folder.

2 Right-click the group that you want to edit, and choose Properties from the pop-up menu.

3 In the Edit Group dialog box, modify the group name, the group description, or both, and click OK.

To edit a connection profile

1 On the Connection Manager window, expand the Groups folder.

2 In the appropriate group folder, right-click the connection profile that you want to edit and choose Properties from the pop-up menu.

3 In the Edit Connection dialog box, you can modify any of the following values:

   ■ User ID
      This value is the default user ID for the connection.

   ■ Change Filter
      You can specify a change filter to apply when you connect using this profile.

   ■ Override main options
      When selected, the Analysis Options button becomes available. Click this button to edit remote analysis options for the connection.

   ... NOTE ...
   You cannot edit the Host and Database Server boxes. If you want to modify these, you must edit the original database connection profile in the Database Connections folder, or create a new connection profile.

4 Click OK.

To copy a group

1 On the Connection Manager window, expand the Groups folder.

2 Right-click the group that you want to copy, and choose Copy from the pop-up menu.

3 Type a new group name, new group description, or both, and click OK.
To delete a group or a connection

1. On the Connection Manager window, expand the Groups folder.

2. Right-click the group or connection that you want to delete, and choose Delete from the pop-up menu.

Distributing client configuration files

After you have configured hosts, connections, and groups, you can share this information with others in your organization. By maintaining a single master configuration that you can then distribute to other team members, you streamline database administration across your enterprise.

1. Define the hosts, connection profiles, and groups of interest.

   Use the following list to locate detailed instructions for completing these tasks:

   ■ “Configuring a new host” on page 46
   ■ “Configuring a database connection” on page 47
   ■ “Configuring a repository database connection” on page 48
   ■ “Setting up groups” on page 50

2. Make the following files available to other team members:

   ■ ACLPROF.INI

      Database and repository database connections are defined in this file. This file typically resides in the \config subdirectory of your install directory.

   ■ ACLHOSTS.INI

      Hosts are defined in this file. This file typically resides in the Windows or Winnt directory.

   ■ CMXGROUP.INI

      Groups are defined in this file. This file typically resides in the \config subdirectory of your install directory.
Connecting to a database or to a repository database

After you have configured hosts and defined connection profiles, you may then connect to a database or repository database. To connect to a database or repository database, you need to know the connection name, your database user ID, and password.

1 In the Connection Manager window, perform one of the following tasks:
   - To connect to a database, expand either the Database Connections folder or the Groups folder.
   - To connect to a repository database, expand the Change Manager Repositories folder.

   **NOTE**
   If you defined a host and connection profile in a previous work session, the Connection Wizard automatically appears when you open the product. If you defined a host in the current work session, the Connect dialog box appears. Click Help for information about using the Connect dialog box.

2 Double-click the connection profile that you want to use.
   The Database Login dialog box appears.

3 If the **User ID** box is empty, type your ID.

   **NOTE**
   Your product configuration may provide the product with your ID information.

4 In the **Password** box, type your password.

5 Click **Connect** to connect to the database or the repository database.
   The product completes the connection in the following manner:
   - If you have connected to a database, the Object Manager appears.
   - If you have connected to a Change Manager repository database, the Application Manager appears.
Taking the Next Step

After you connect to a database, use the Object Manager to manage schema (see Chapter 4, “Altering Data Structures”) or migrate schema (see Chapter 5, “Cloning and Propagating Objects, Data, and Environments”).

After you connect to a repository database, use the Application Manager to browse objects, modify application profiles and filters, and track changes across your enterprise (see Chapter 6, “Managing Database Changes”).

Table 8 lists some other goals you can accomplish using BMC Change Manager for DB2.

Table 8 Where to Go from Here

<table>
<thead>
<tr>
<th>Goal</th>
<th>Where to go</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review steps for accomplishing typical DBA tasks.</td>
<td>Chapter 2, “Getting Started” on page 29</td>
</tr>
<tr>
<td>Learn about the BMC Change Manager for DB2 tools</td>
<td>Chapter 1, “Introducing BMC Change Manager for DB2” on page 13</td>
</tr>
<tr>
<td>Learn about BMC Change Manager for DB2 features</td>
<td></td>
</tr>
<tr>
<td>Learn about BMC Change Manager for DB2 capabilities.</td>
<td>Chapter 7, “Change Manager Tools” on page 171</td>
</tr>
</tbody>
</table>
Altering Data Structures

You can use the BMC Change Manager for DB2 product to create and alter the attributes, dependent relationships, and data associated with database objects. To achieve these goals, you use the set of tools and components available on the Object Manager. These tools enable you to perform the following tasks:

- extract objects to begin a work session
- administer and change database objects
- analyze the impact of changes before you implement them
- generate and implement an optimized change script

This chapter discusses techniques for using BMC Change Manager for DB2 Universal Database to manage the change process.

**Before you begin**

Before you can use the product, you must configure the client. In addition, you must have an open work session to perform the procedures discussed in this chapter. For information about configuring the client and opening work sessions, see Chapter 3, “Connecting to Databases and Repositories”.

Before you begin to alter data structures, you should familiarize yourself with the features and functionality of the Object Manager. For an overview of the Object Manager, see “Managing schema” on page 23.

You may want to create a baseline of the environment before you alter its data structures. A baseline is a snapshot of an application’s data structures at a given point in time. For information about creating baselines, see Chapter 6, “Managing Database Changes.”

**TIP**

For definitions of terminology used in this chapter, see the glossary at the back of this book and available in the Help.
Overview

The pace of database administration is picking up. Demands for business availability are increasing, while the opportunities for database maintenance are dwindling. You have less time to make changes and more chances to make a rushed mistake.

BMC Change Manager for DB2 can help you meet these challenges. The product streamlines, automates, and validates the change process for you, saving you the substantial time and effort that is often required for even the most simple database changes.

BMC Change Manager for DB2 Universal Database provides you with

- GUI editors with which to make the changes
- a wizard to help you analyze the impact of your changes and automatically build an optimized change script
- various options for you to customize the way that you implement the changes

Exploring schema management

You use the tools and components available on the Object Manager to perform the major work steps for managing schema changes. Figure 6 on page 57 illustrates these steps. The sections that follow the illustration provide an overview of each step.
Step 1: Connect to a database

Managing schema requires an active database connection. For detailed information about connecting to a database, see “Connecting to a database or to a repository database” on page 53.

An active connection is also called a work session. When you connect to a database server, the product automatically opens a new work session. Each work session is connected to DB2 Universal Database.

More than one session may be active at a time. Each active session is listed in the Active Connections folder on the Connection Manager and on the Window menu.

When the product completes the connection, it opens the Object Manager. You can then begin specifying object changes.
Step 2: Specify object changes

You manage the change process for schema objects by using the Object Manager.

Retrieving objects from a database

To perform some database actions, you must first retrieve, or *extract*, from your database the object or set of objects of interest. When you extract an object (see “Extracting database objects” on page 66), the product lists the names of the extracted objects in the Object pane.

The product also extracts information about an object when you resolve that object’s dependencies (see “Resolving dependencies for an object” on page 67). This information appears in the Dependencies pane.

Filtering objects

You can use an extraction filter to specify the objects that you want to extract. To access the filter, double-click an object type name in the Object Folder pane. The Filter dialog box appears (see Figure 7 on page 59).

**TIP**

You can also access the Filter dialog box by clicking on an object editor or object browser. For more information about filtering objects, see the Help.

The Filter dialog box enables you to limit the number of objects extracted to only those that you want to view on the given tree or selection list. You can filter objects from many places in the product, including the following locations:

- object tree on the Objects tab
- object editors and object browsers
- Execute SQL tool
After an object is extracted, an extraction icon ➤ appears next to the object’s name in the Object pane, as shown in. Also, the object’s icon appears in color instead of grayscale.

You can extract detailed information about an object by double-clicking the object in the Object pane. This action opens an object editor.

**Altering objects**

You may administer object changes by using an object editor or by specifying changes from the pop-up menu.

The following object change actions are available from the pop-up menu:

- create
- create like
- drop
- edit
- migrate
- rebind
- rebuild

---

**NOTE**

For complete information about the change actions that are available, see the Help.

---

When you specify a change to an object, an action icon appears next to the object’s name in the Object pane. Table 9 describes each action icon.
Step 3: Verify object changes

As you specify changes to objects in a database, BMC Change Manager for DB2 Universal Database keeps track of your requests and displays them on the Pending Actions tab (see on page 24). Review the pending actions and modify them, if necessary.

If you change your mind about a pending change request, you can clear the request before generating a script. You may clear all requests or just the requests for a specific object. “Clearing all pending changes” on page 73 and “Clearing changes pending against a single object” on page 73 provide detailed steps.

When you are satisfied with the list of pending actions, you analyze the impact of the proposed changes on the database.

### Step 3: Verify object changes

You are only specifying changes, not implementing them, at this point. The requested actions do not occur in the database until you analyze the changes, generate a script, and run the script. For instructions for cancelling object changes, see “Clearing changes pending against a single object” on page 73.

### Table 9 Meaning and menu equivalents of action icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu Equivalent</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Actions=&gt;Create and Create Like" /></td>
<td>Actions=&gt;Create and Create Like</td>
<td>create a new object</td>
</tr>
<tr>
<td><img src="image" alt="Actions=&gt;Edit" /></td>
<td>Actions=&gt;Edit</td>
<td>edit (change) an object</td>
</tr>
<tr>
<td><img src="image" alt="Actions=&gt;Drop" /></td>
<td>Actions=&gt;Drop</td>
<td>drop an object</td>
</tr>
<tr>
<td><img src="image" alt="Actions=&gt;Rebuild" /></td>
<td>Actions=&gt;Rebuild</td>
<td>rebuild an object</td>
</tr>
<tr>
<td><img src="image" alt="Actions=&gt;Migrate" /></td>
<td>Actions=&gt;Migrate</td>
<td>migrate objects from one database to another, or duplicate objects in a database</td>
</tr>
</tbody>
</table>
Step 4: Analyze impact of changes

Rather than have you manually review the complex dependent relationships among database objects, BMC Change Manager for DB2 Universal Database analyzes them for you. The product evaluates each proposed change to determine its impact on the database and the optimal manner in which to propagate the changes that result from object interdependencies.

**NOTE**
Typically, you must analyze your requested changes before you may implement them. You do not, however, need to run an impact analysis after making changes to privileges or when making changes by using ad hoc SQL commands.

The analysis process consists of the following phases:

1. **Impact analysis** examines the pending changes and determines the impact of implementing your requests.

2. **Name propagation** propagates all name changes into the impacted objects.

**NOTE**
The analysis process does not propagate name changes into views, check constraints, summary tables, and triggers.

3. **Conflict analysis (detection)** validates your requests against other requested changes. It can also validate your requests against the objects in the catalog or data dictionary.

**Using the analysis wizard**

You analyze object changes by using the Analysis Wizard. To connect to the Analysis Wizard, click the **Analysis** button on the toolbar of the Object Manager.

The Analysis Wizard guides you through the steps for configuring the way BMC Change Manager for DB2 Universal Database assesses your proposed changes. On the wizard, you can specify the type of analysis to run, choose whether a change script generates after the analysis finishes, and establish whether the analysis runs on the client or server. “Analyzing changes on the client” on page 69 provides detailed steps for performing client-side analysis. “Analyzing Changes on the Server” on page 70 provides detailed steps for performing server-side analysis.
On the Analysis Wizard, you can also set options that affect every impact analysis that you run. To set options for analysis, click the **Advanced Analysis Options** button on the Options page. The Edit Analysis Options dialog box appears, and you can begin to specify options.

**TIP**
You can also specify analysis options by choosing from the main menu, **Options => Analysis Options**.

---

### Reviewing the results of analysis

After analysis runs on the client, the object tree on the Impacted Objects tab shows all of the objects that are directly or indirectly affected by the actions that you have specified. Impact icons appear to the left of analyzed objects on the object tree. These icons indicate the type of action that would result for each object that is affected by the pending actions. Table 10 on page 4-62 describes each impact icon.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Pending Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Create Icon" /></td>
<td>create the marked object</td>
</tr>
<tr>
<td><img src="image" alt="Drop Icon" /></td>
<td>drop the marked object</td>
</tr>
<tr>
<td><img src="image" alt="Change Icon" /></td>
<td>change the marked object</td>
</tr>
<tr>
<td><img src="image" alt="Invalidate Icon" /></td>
<td>invalidate the marked object</td>
</tr>
<tr>
<td><img src="image" alt="Migrate Icon" /></td>
<td>migrate the marked object</td>
</tr>
<tr>
<td><img src="image" alt="Rebuild Icon" /></td>
<td>rebuild the marked object</td>
</tr>
<tr>
<td><img src="image" alt="Rename Icon" /></td>
<td>rename the marked object</td>
</tr>
</tbody>
</table>
Step 5: Generate a script

NOTE

For server-side analysis, the impacted objects appear as text on the Job Log (see Figure 8 on page 63), instead of appearing in graphical form on the Impacted Objects tab. You can display and print the Job Log.

Figure 8 Sample job log

To modify impacted objects, right-click an object icon on the Impacted Objects tab and choose a command from the pop-up menu. When you finish, you must perform another analysis to incorporate the new change request.

TIP

To create a customized report detailing the results of the analysis, click the Reports button. You can print and distribute the report in a hardcopy format or publish it across your network in an electronic format.

If, after reviewing the results of the analysis, you are satisfied with the changes, you can then generate a script to implement the changes.

Step 5: Generate a script

To implement the changes that you specify during a work session, you must generate and save a change script. The generated script specifies discrete operations that must be performed to carry out your requests. It also includes a strategy that selects an optimal method for completing the necessary tasks.

You can generate change scripts from various locations in BMC Change Manager for DB2 Universal Database, depending on the kind of changes or operations that you want to specify.
To implement object changes, you generate a change script by performing one of the following tasks:

- On the toolbar of the Object Manager, click the Build button.

- On the Location page of the Analysis Wizard, select the Automatic Script Generation check box to automatically generate the change script after analysis has run. The check box is not selected by default.

To run utilities, you generate a utility script by clicking the Generate button on the Utilities tool.

**TIP**

To generate a DDL file from your script, click the Convert to DDL button on the Edit Scripts tool.

After generating a change or utility script, the product displays the script on the Edit Scripts tool. You may modify the script, if necessary.

**NOTE**

You must run at least one analysis cycle before you can generate a change script. Utility operations do not require analysis. If you complete an analysis and then specify more changes, BMC Change Manager for DB2 detects that the most recent analysis is not current. It then prompts you to decide whether to continue generating the script or redo the analysis.

“Generating a script to implement changes” on page 74 provides detailed steps for generating change scripts. For instructions for generating utility scripts, see the Help.

When you are satisfied with the generated change script, you can submit it to run immediately or schedule it to run at a later time.

**patrolan server-side command**

As an alternative to submitting analysis from the client, you can use the patrolan server command to submit analysis. You can run the patrolan command from the server’s command prompt. This command does not require the BMC Change Manager for DB2 client to be running.
Step 6: Run the change script

Running a script implements your requested changes. To run the script, click the Run button on the Edit Scripts tool. To schedule the script to run later, click the Schedule button.

--- NOTE ---
Clicking the Schedule button opens the Job Scheduler tool (see Figure 2 on page 25). “Scheduling a script from the client” on page 75 provides detailed steps about using the Job Scheduler tool to control script execution, see “Running a script from the server using the patrolcl command” on page 77.

patrolcl server-side command

As an alternative to submitting a change script for execution from the client, you can use the patrolcl server command to submit a script to run immediately or to schedule it to run later (see “Running a script from the server using the patrolcl command” on page 77). You can run the patrolcl command from the server’s command prompt. This command does not require the BMC Change Manager for DB2 client to be running.

Step 7: Save the session

After running the change script or scheduling it to run later, you have completed all the major work steps for schema management. If you ran the script, you can start a new session to see the completed changes. Be sure to save the current session before starting a new one. A saved session provides a record of your database changes.

Achieving your goals

This section provides step-by-step procedures for managing schema. Table 11 lists these procedures by task and shows their locations in the chapter.

--- TIP ---
The Help provides information about performing all BMC Change Manager for DB2 tasks.
Extracting database objects

Table 11  Tasks for managing schema

<table>
<thead>
<tr>
<th>Task</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extracting database objects</td>
<td>on page 66</td>
</tr>
<tr>
<td>Resolving dependencies for an object</td>
<td>on page 67</td>
</tr>
<tr>
<td>Creating an object</td>
<td>on page 67</td>
</tr>
<tr>
<td>Editing an object</td>
<td>on page 68</td>
</tr>
<tr>
<td>Dropping an object</td>
<td>on page 69</td>
</tr>
<tr>
<td>Analyzing changes on the client</td>
<td>on page 69</td>
</tr>
<tr>
<td>Analyzing Changes on the Server</td>
<td>on page 70</td>
</tr>
<tr>
<td>Clearing all pending changes</td>
<td>on page 73</td>
</tr>
<tr>
<td>Clearing changes pending against a single object</td>
<td>on page 73</td>
</tr>
<tr>
<td>Generating a script to implement changes</td>
<td>on page 74</td>
</tr>
<tr>
<td>Scheduling a script from the client</td>
<td>on page 75</td>
</tr>
<tr>
<td>Running a script from the server using the patrolcl command</td>
<td>on page 77</td>
</tr>
<tr>
<td>Deleting, Holding, Releasing, and Restarting patrolcl Jobs</td>
<td>on page 80</td>
</tr>
<tr>
<td>Retrieving information about patrolcl jobs</td>
<td>on page 81</td>
</tr>
<tr>
<td>Configuring the UNIX host for patrolcl and patrolan</td>
<td>on page 82</td>
</tr>
</tbody>
</table>

**TIP**

Commands that appear on the pop-up menu may also appear on the Actions menu.

**Extracting database objects**

After connecting to a database, you must retrieve, or extract, each object that you want to access during the work session.

1 In the Object Folder pane on the Objects tab, double-click the folder that is associated with the type of object that you want to access. For example, to see the names of specific table objects, double-click the Table folder in the Object Folder pane.

The names of extracted objects appear in the Object pane.

**TIP**

Use the Filter dialog box to limit the objects extracted to those objects of interest.
2 To extract detailed information about an object, double-click the object name in the Object pane.

A object editor opens, displaying the extracted information.

Resolving dependencies for an object

You can extract and display information about the dependent relationships of an object.

1 In the Object Folder pane on the Objects tab, double-click the folder that is associated with the type of object that you want to access.

2 Select a specific object in the Object pane and choose Dependencies from either the pop-up menu or the Actions menu.

The dependencies for that object appear in the Dependencies pane. This tree shows the referencing objects and the referenced objects for the selected object.

TIP
You can also click the Dependencies tab of an open object editor to resolve that object’s dependencies.

After you resolve an object’s dependent relationships, its dependencies appear in the Dependencies pane each time that you select that object in the Object pane.

Creating an object

After connecting to a database, you can create and define the properties of a new object.

1 In the Object Folder pane on the Objects tab, double-click the folder that is associated with the type of object that you want to create.

2 From the Actions menu, choose Create.

An empty object editor appears.
After connecting to a database and extracting objects, you can edit any of the objects. The editor for each object provides access to that object’s definitions and attribute settings.

1 In the Object pane, double-click the object that you want to edit.

   **TIP**
   You can also open an editor by selecting an object in the Object pane and choosing Edit from either the pop-up menu or the Actions menu, by dragging the object outside of the Object Manager window. (see “Exploring the object manager” on page 23).

2 When the object editor appears, enter your changes.

3 Define the new object by specifying information on the editor.

   **TIP**
   If you want your new object to have properties that are similar to those of an object that already exists, right-click that object in the Object pane and choose Create Like from the pop-up menu (if available), or open the object and click on the editor window (if available).

4 When you finish defining the new object, click to save your changes.

   **NOTE**
   You are only requesting an action, not implementing it, at this point. The action does not occur in your database until you run the change script.

5 Click to close the editor.

   A Create action icon appears next to the object name in the Object pane. Also, the action is reflected in the list of requested changes on the Pending Actions tab of the Object Manager.
3 When you finish making changes, click to write the changes to the Pending Actions tab.

**NOTE**

You are only requesting an action, not implementing it, at this point. The action does not occur in your database until you run the change script.

4 Click to close the editor.

An action icon appears next to the object name in the Object pane. Also, the action is reflected in the list of requested changes on the Pending Actions tab of the Object Manager.

**Dropping an object**

After connecting to a database, you can drop one or more objects.

1 In the Object pane, right-click the object that you want to drop and choose **Drop**.

   The action icon appears next to the selected object. Also, the action is reflected in the list of requested changes on the Pending Actions tab of the Object Manager.

2 When you finish selecting objects to drop, click to write the changes to the Pending Actions tab.

   **NOTE**

   You are only requesting an action, not implementing it, at this point. The action does not occur in your database until you run the change script.

**Analyzing changes on the client**

After you have made changes to database objects, you can analyze the resulting impact on the database. Use the following steps to run the analysis on a workstation.

1 Click the **Analysis** button on the toolbar of the Object Manager.

   The Analysis Wizard appears.

2 On the Strategy page, select **Changes** and then click **Next**.
3 On the **Options page**, specify your analysis preferences and then click **Next**.

---

**TIP**
Click the **Advanced Analysis Options** button on the Options page to set general and specific analysis, script generation, and execution options.

---

4 On the **Location page**, select **Run analysis on the client**.

5 If you want BMC Change Manager for DB2 to generate a script when the analysis finishes, select **Automatic Script Generation**.

6 On the **Summary page**, review your choices. To go back and undo a selection, click **Back**. To accept your choices, click **Finish**.

The analysis runs. A Message Log appears.

---

**TIP**
A status bar appears at the bottom of the window, indicating the progress of the analysis. To stop the analysis process, click the **Stop** button on the main toolbar.

---

When the analysis is complete, an object tree appears on the **Impacted Objects** tab. The object tree lists all of the objects affected by the current pending actions.

---

**TIP**
The Object Manager may minimize during analysis. To view the object tree on the **Impacted Objects** tab, maximize the window.

---

7 Review the object tree of impacted objects. To make additional modifications, right-click the object and choose **Edit**. “Editing an object” on page 68 provides more information.

---

**NOTE**
If you make new or further changes to any database objects, you must repeat the analysis process.

---

### Analyzing Changes on the Server

After you have made changes to database objects, you can analyze the resulting impact of your actions on the database. You can analyze these changes on the server using two methods: the Analysis Wizard or the patrolan command.
To Analyze Changes on the Server Using the Analysis Wizard

1 Click the Analysis button on the toolbar of the Object Manager.

   The Analysis Wizard appears.

2 On the Strategy page, select Changes and then click Next.

3 On the Options page, specify your analysis preferences and then click Next.

4 On the Location page, select Schedule analysis on a server and click Next.

5 Select Automatic Script Generation if you want BMC Change Manager for DB2 to generate a script when the analysis finishes. Then click Next.

   The Job Scheduler tool appears.

6 Click the Submit button to accept the displayed defaults and run the analysis immediately, or use the Job Scheduler tool to specify where and when the job runs.

   **TIP**

   The Help provides detailed information about using the Job Scheduler tool for server-side analysis.

   When you click the Submit button, the product may prompt you for connection or host login information.

   The Dispatch Status dialog box displays the progress of the submitted job.

7 When the analysis is complete, record the sequence number for the job. The number appears in the Results box of the Dispatch Status dialog box.

8 Click the Job Queue tab on the Job Scheduler tool and locate the job in the left pane by using the sequence number from the Dispatch Status dialog box.

   **NOTE**

   A status icon appears to the left of each script or file name listed on the Job Queue tab. This icon identifies a job’s run status. For example, a green ball indicates that a job has completed successfully. For a complete icon legend, see the Help.

9 Double-click the job.

   The Job Log appears.
10 On the Job Log, review the list of impacted objects. If necessary, make additional modifications to the objects using the tools available on the Object Manager.

**NOTE**

If you make modifications, you must repeat the analysis process.

11 When you are satisfied with the changes, click the View Script button to begin generating a script to implement the changes. For more information, see “Generating a script to implement changes” on page 74.

**To Analyze changes on the server using the patrolan command**

At the server’s command prompt, run the patrolan command using the following command syntax:

```
patrolan [-h host] -d database -u user -p password | -x encryptedPassword
- a analysis - t operation - o optionsFile - i inputFile - j fileType [- s scriptFile]
[ - r changeFiltersFile][- l logFile]
```

Table 12 details the options of the patrolan command.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>-c</td>
<td>specifies to compile the INI file</td>
</tr>
<tr>
<td>-h host</td>
<td>specifies the connection host name</td>
</tr>
<tr>
<td>-d database</td>
<td>specifies the database name to log into</td>
</tr>
<tr>
<td>-u username</td>
<td>specifies the database user</td>
</tr>
<tr>
<td>-p password</td>
<td>specifies the database login, if you did not specify a password, you are prompted to enter one from standard input.</td>
</tr>
<tr>
<td>-x encrypted_password</td>
<td>You can submit a server-side baseline job, place it on hold from the BMC Change Manager client, and then get values for options from the BASELINE file in the job directory on the server for the baseline job. The encrypted password is stored in the file aprescr.msl. For more information about encrypting the password, see “Generating encrypted password for patrolan” on page 83.</td>
</tr>
<tr>
<td>-a analysis</td>
<td>type of the script to be generated: migrate, change, drop, or html</td>
</tr>
<tr>
<td>-t operation</td>
<td>type of server-side analysis: analyze, generate, or force’</td>
</tr>
<tr>
<td>-o optionsFile</td>
<td>analysis options file</td>
</tr>
<tr>
<td>-i inputfile</td>
<td>input OCDL</td>
</tr>
<tr>
<td>-j filetype</td>
<td>cdl, ddl, cat, or mds’</td>
</tr>
</tbody>
</table>
Clearing all pending changes

Table 12  Options for the patrolan command (part 2 of 2)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>-s scriptfile</td>
<td>For analysis</td>
</tr>
<tr>
<td>-r changefiltersfile</td>
<td>name of the change filter file</td>
</tr>
<tr>
<td>-l logfile</td>
<td>Output log file for analysis</td>
</tr>
<tr>
<td>-?</td>
<td>command-line help information</td>
</tr>
</tbody>
</table>

If you are running patrolan from a UNIX® host, see “Configuring the UNIX host for patrolcl and patrolan” on page 82.

To Analyze changes on the server using the run patrolan command

To run the patrolan command for analyzing changes, use the following command syntax:

```
patrolan [-h host] -d database -u user -p password | -x encrypted_password
-a analysis -t operation -o optionsfile -i inputfile -j filetype [-s scriptfile] [-r
changefiltersfile] [-l logfile]
```

For the options on the patrolan command, see Table 12 on page 72.

If you are running patrolan from a UNIX host, see “Configuring the UNIX host for patrolcl and patrolan” on page 82.

Clearing all pending changes

You can clear all pending change requests.

Click  on the Object Manager.

All requested actions are cleared, and you can begin specifying new changes.

Clearing changes pending against a single object

You can clear pending actions against a single object from the Objects tab of the Object Manager. You might, for instance, decide to remove a drop request after analysis shows that the change would affect one or more objects in ways you had not anticipated.
1 On the Objects tab of the Objects Manager, select the folder containing the object that is marked for the changes that you want to clear.

**TIP**

An action icon (described in Table 9 on page 4-60) precedes the name of each object for which requested actions are pending.

2 Select the object name in the Object pane.

3 From the Actions menu, choose Reset.

All pending changes for the object are cleared and are no longer reflected on the Pending Actions tab of the Object Manager.

---

**Generating a script to implement changes**

After analyzing the requested changes, you can generate a change script to implement the actions against the database. You can save and reuse change scripts.

1 Create the script by using one of the following methods:

- To create the script on a client machine, click the **Build** button on the toolbar of the Object Manager.

- To create the script on the server after running a server-side analysis, click the **View Script** button on the Job Log.

**TIP**

To stop script generation, click the **Stop** button on the main toolbar.

After the product has generated the script, the Edit Scripts tool opens and displays the script contents.

2 If you want to change, delete, or add any statements, use the Edit Scripts tool to modify the script.

For example, you may want to add SQL statements to log more information, or delete SQL statements that you do not want to run.
Scheduling a script from the client

You use the Job Scheduler tool to run a generated change script immediately or to schedule it to run later.

1 To open the Job Scheduler tool (see Figure 2 on page 25), choose Job Scheduler from the Tools menu.

WARNING
Manually editing scripts can cause unexpected results. Be sure you fully understand the consequences of your script modifications before entering manual changes.

2 On the What tab of the Job Scheduler tool, choose Run Script from the Job Type list.

3 In the Script box, specify the name of the script.
   - Click to locate the name of the file on your system.
   - Click to edit the specified file on the Edit Scripts tool.

   The name of the script appears in the Files to Submit box at the bottom of the window. Repeat this step to add additional scripts.

4 In the Procedure list, specify the procedure within the script at which you want to start execution.

5 In the Group Name box, specify the general category to which the specified script belongs.

Figure 9 on page 76 shows an example of a completed What tab.
6 Click the **Where** tab, and select one or more groups or connection profiles on which to run the script.

**TIP**

You may, at this point, run the script immediately by clicking the **Submit** button.

7 Click the **When** tab and then select **Schedule**.

If the Host Login dialog box (see Figure 10 on page 76) appears when you click the When tab, supply the requested information and click **OK**.

Figure 10  Host login dialog box

8 In the Start Date text box, specify the month, day, year, and time to run the script using one of the following methods:
Scheduling a script from the client

- Click the portion of the date that you want to change, and click the up or down arrows to increase or decrease the value.

- Click the larger down arrow to display a calendar on which you can designate the start date.

- Type in the new start date and time values.

9 In the Run job list, specify the job run frequency.

10 Click the Submit button.

**NOTE**
The product may prompt you for connection or host login information.

The Dispatch Status dialog box displays the progress of your submitted job.

**NOTE**
When the script is successfully submitted, a sequence number for the job appears in a message box. Use this number to locate your job on the Job Queue tab.

11 To check the status of your job, click the Job Queue tab on the Job Scheduler tool. Locate your job using the number produced in step 10. Double-click on your job.

The Job Log appears.

**NOTE**
When you double-click a host on the Job Queue tab, a list of the jobs that have run or are scheduled to run on that host appears. A status icon appears to the left of each script or file name to identify its run status. For example, a green ball indicates that a job has completed successfully. For a complete icon legend, see the Help.

12 Schedule or run another script, or click x to close the Job Scheduler tool.

**Running a script from the server using the patrolcl command**

You can use patrolcl to submit a script to run immediately or to schedule a script to run later. You can run the patrolcl command from the command prompt. This command does not require the BMC Change Manager for DB2 client to be running.

The patrolcl command always runs on the host where the command was issued. The script runs as the user who issues the patrolcl command.
If you are running `patrolcl` from a UNIX host, see “Configuring the UNIX host for patrolcl and patrolan” on page 82.

To run the `patrolcl` command, use the following command syntax:

- **run a job immediately**

  ```bash
  patrolcl -s script -h host -d database -u user -p password -n DB2 [-h host] [-v port] [-f host_username -i host_password] -q 0|1
  ```

- **schedule a job**

  ```bash
  patrolcl -s script -d database -u user -p password -n DB2 -t "mm/dd/yyyy hh:mm" [-h host] [-v port] [-f host_username -i host_password]
  ```

- **assign a group ID**

  ```bash
  patrolcl -s script -d database -u user -p password -n DB2 -g GroupID [-h host] [-v port] [-f host_username -i host_password]
  ```

- **start at a specific procedure**

  ```bash
  patrolcl -s script -d database -u user -p password -n DB2 -r ProcName [-h host] [-v port] [-f host_username -i host_password]
  ```

- **request domain or user impersonation**

  ```bash
  patrolcl -s script -d database -u user -p password -n DB2 -t [-h host] [-v port] [-f host_username -i host_password]
  ```

Table 13 details the options for the `patrolcl` command.

### Table 13 Options for the patrolcl command (part 1 of 3)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>`-ai</td>
<td>-as`</td>
</tr>
<tr>
<td><code>-c checkpointfile</code></td>
<td>restarts the job from the specified checkpoint file</td>
</tr>
<tr>
<td><code>-d database</code></td>
<td>specifies the database instance to log into</td>
</tr>
<tr>
<td>`-ei</td>
<td>-es`</td>
</tr>
<tr>
<td><code>-f host_username</code></td>
<td>specifies the host username and is required when you start the Product Name Long server with user authentication</td>
</tr>
</tbody>
</table>
Table 13   Options for the patrolcl command (part 2 of 3)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
</table>
| -g group_id | specifies the parent group name with which the job will be associated  
The default is PATROLDB. |
| -h host | specifies the connection host name |
| -i host_password | specifies the host password and is required when you start the BMC Change Manager for DB2 server with user authentication  
If you do not specify a password, you are prompted to enter one from standard input. |
| -j job[job…] | specifies a job or range of jobs to which the patrolcl actions that you select will apply  
All of the jobs that fall within that range will have an action performed on them. These actions include:  
- releasing an immediate held job (-ei)  
- releasing a scheduled held job (-es)  
- restarting a job (-c)  
- requesting immediate job details (-ai)  
- requesting scheduled job details (-as)  
- requesting a job log (-o)  
- requesting an immediate job summary (-mi)  
- requesting a scheduled job summary (-ms)  
- deleting an immediate job (-yi)  
- deleting a scheduled job (-ys)  
The -j job_# parameter is required if you request any of these actions. |
| -mi | requests a summary of immediate (-mi) or scheduled (-ms) jobs |
| -ms | requests a summary of scheduled jobs (-ms) |
| -n DBMS | specifies the database name  
Use the following keywords to specify the corresponding database names:  
DB2. |
| -o | requests a job log |
| -p password | specifies the database login  
If you did not specify a password, you are prompted to enter one from standard input. |
Table 13  Options for the patrolcl command (part 3 of 3)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>-q 0</td>
<td>1</td>
</tr>
<tr>
<td>-r checkpoint</td>
<td>Restart a job from a specific checkpoint. Use this parameter along with -c option.</td>
</tr>
<tr>
<td>-s scriptpath</td>
<td>specifies the file path name of the script to be run. To place the running of a script on hold, you must specify this parameter with the -w parameter.</td>
</tr>
<tr>
<td>-t date/time</td>
<td>specifies the date and time to run the job. The format is &quot;[m]m/[d]d/yyyy [h]h:[m]:[s][s]&quot; enclosed in quotes. If you omit this parameter, the job runs immediately.</td>
</tr>
<tr>
<td>-u username</td>
<td>specifies the database user</td>
</tr>
<tr>
<td>-v port</td>
<td>specifies the port number. The default value is 1313.</td>
</tr>
<tr>
<td>-w</td>
<td>places the running of the specified script or job on hold This parameter must be specified with the -s scriptpath parameter or -j job parameter.</td>
</tr>
<tr>
<td>-x encrypt_password</td>
<td>specifies the database login password, which is provided in a secured BMC Software encrypted format For more information about encrypting the password, see “Generating encrypted password for patrolcl and patrolan” on page 83</td>
</tr>
<tr>
<td>-yi</td>
<td>-ys</td>
</tr>
<tr>
<td>-?</td>
<td>displays command-line help information</td>
</tr>
</tbody>
</table>

Deleting, Holding, Releasing, and Restarting patrolcl Jobs

You can delete, hold, release, and restart patrolcl jobs.

In the following command syntax example, DBMS represents a database name. Use the following keyword when specifying a database: DB2 for DB2 Universal Database.

To run the patrolcl command, use the following command syntax:
Scheduling a script from the client

- delete an immediate job
  
  ```
  patrolcl -yi -j job [... | job - job [-h host] [-v port]
  [-f host_username -i host_password]
  ```

- delete a scheduled job
  
  ```
  patrolcl -ys -j job [... | job - job [-h host] [-v port]
  [-f host_username -i host_password]
  ```

- place a scheduled job on hold
  
  ```
  patrolcl -w -j job [... | job - job [-h host] [-v port]
  [-f host_username -i host_password]
  ```

- release a held immediate job
  
  ```
  patrolcl -ei -j job [... | job - job [-h host] [-v port]
  [-f host_username -i host_password]
  ```

- release a scheduled job
  
  ```
  patrolcl -es -j job [... | job - job [-h host] [-v port]
  [-f host_username -i host_password]
  ```

- restart a halted job
  
  ```
  patrolcl -c -d database -u user -p password -n DB2
  -j job [-h host] [-v port] [-f host_username -i host_password]
  ```

Retrieving information about patrolcl jobs

You can view information about a `patrolcl` job.

To run the `patrolcl` command, use the following syntax:

- view details about an immediate job
  
  ```
  patrolcl -ai -j job [... | job - job [-h host] [-v port]
  [-f host_username -i host_password]
  ```

- view details about a scheduled job
  
  ```
  patrolcl -as -j job [... | job - job [-h host] [-v port]
  [-f host_username -i host_password]
  ```

- view an output log
Scheduling a script from the client

```
patrolcl -o -j job [job ...] | job -j host [-h host] [-v port] [-f host_username -i host_password]
```

- view a summary of immediate jobs
  
  ```
patrolcl -mi [-h host] [-v port] [-f host_username -i host_password]
  ```

- view a summary of scheduled jobs
  
  ```
patrolcl -ms [-h host] [-v port] [-f host_username -i host_password]
  ```

- restart a job from specific checkpoint
  
  ```
  ```

### Configuring the UNIX host for patrolcl and patrolan

For UNIX hosts, you must set and export the environment variable **BMC_HOME** before you can run **patrolcl** and **patrolan**.

1. Log in to the host where the **patroldb** service provider (SVP) is running.
2. If you do not accept the default values, export the environment variables that are listed in Table 14 to the same values used by the SVP.

#### Table 14  SVP environment variables

<table>
<thead>
<tr>
<th>Environment Variable</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMC_HOME</td>
<td>location where you start <strong>patrolcl</strong> or <strong>patrolan</strong></td>
</tr>
<tr>
<td>ML_ROOT</td>
<td>location to which BMC_HOME points</td>
</tr>
<tr>
<td>ML_LANG</td>
<td>en_US.iso88591 (English)</td>
</tr>
</tbody>
</table>

3. Set the shared library path to include the **$BMC_HOME** directory in the following manner:

- For Sun™ Solaris™:
  ```
  export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$BMC_HOME
  ```

- For IBM® AIX®:
  ```
  export LIBPATH=$LIBPATH:$BMC_HOME
  ```

- For SUSE Linux®:
  ```
  export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$BMC_HOME
  ```

4. Run **patrolcl** or **patrolan** from the command line.
Ensure that $BMC\_HOME$ is at the top of your $PATH$, or run `patrolcl` or `patrolan` using an absolute path, for example, `$BMC\_HOME/patrolcl`.

**Generating encrypted password for patrolcl and patrolan**

You can use the `encpwd` command line utility to encrypt a password for the `patrolcl` and `patrolan` commands.

To use the password encryption utility, use the following syntax:

```
encpwd [-p password] [-f filename] [-s]
```

If you do not specify any parameter, the utility will prompt for the password and will show the encrypted password on the standard output device.

**Table 15** details the options for the encrypt password utility.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-f filename</code></td>
<td>Saves the encrypted password in the given file instead of showing it on the screen. Use this parameter along with a filename. For example, <code>encpwd -f filename</code></td>
</tr>
<tr>
<td><code>-p password</code></td>
<td>Allows you to pass the password to be encrypted. In this case, the utility will not prompt for the password and will encrypt the given password. For example, <code>encpwd -p password</code> If you do not specify a password, you are prompted to enter one from standard input for encryption.</td>
</tr>
</tbody>
</table>
| `-s` | Allows the utility to work in silent mode that is the utility will not show any prompt. This is useful when you are assigning the encrypted password to a variable in the shell script. For example, `export newpass=`encpwd -s`
Taking the next step

Now that you can modify objects and data using BMC Change Manager for DB2, see Table 16 to discover other goals that the product can help you to achieve.

Table 16   Where to Go from Here

<table>
<thead>
<tr>
<th>Goal</th>
<th>Where to go</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learn about cloning objects and data in a database, migrating them to another environment, or using them to create an environment.</td>
<td>Chapter 5, “Cloning and Propagating Objects, Data, and Environments” on page 85</td>
</tr>
<tr>
<td>Review steps for accomplishing typical DBA tasks.</td>
<td>Chapter 2, “Getting Started” on page 29</td>
</tr>
<tr>
<td>Learn about connecting to a database repository.</td>
<td>Chapter 3, “Connecting to Databases and Repositories” on page 41</td>
</tr>
<tr>
<td>Learn about tracking database changes, discovering the differences between data structures, synchronizing the structures, and recovering environments.</td>
<td>Chapter 6, “Managing Database Changes” on page 105</td>
</tr>
<tr>
<td>Learn about the BMC Change Manager for DB2 tools that help you administer your database environment.</td>
<td>Chapter 7, “Change Manager Tools” on page 171</td>
</tr>
<tr>
<td>Learn about BMC Change Manager for DB2 features and capabilities.</td>
<td>Chapter 1, “Introducing BMC Change Manager for DB2” on page 13</td>
</tr>
</tbody>
</table>
You can use the BMC Change Manager product for the DB2 product to create entire environments or simply clone a few schema objects. You can also use the product to copy objects and data and move them (a process termed *migrating*) to another database, even if that database is on another server.

This chapter discusses the options, considerations, strategies, and steps available to you when migrating objects and data using BMC Change Manager for DB2.

**Before you begin**

Before you begin to migrate objects or data, you need to connect to your base and goal databases. For detailed instructions, see Chapter 3, “Connecting to Databases and Repositories”.

BMC Change Manager for DB2 treats migration as another type of schema change. To familiarize yourself with the steps involved in accomplishing schema changes, see Chapter 4, “Altering Data Structures.”

**TIP**

For definitions of terminology used in this chapter, see the glossaries at the back of this book and available in the Help.

**Overview**

Some things never change; a database, however, is not one of them. The developers want to implement new features, the data modelers want to test their ideas, and you have a schedule full of upgrades to move forward.
Despite this clamor for change, though, you are not about to risk crashing the production environment by implementing untested changes. Your goal in these situations, then, is to copy and move objects and data into a test environment. Here, the changes may be implemented without endangering the availability of the production database.

This process of replicating and propagating objects and data to another database server on the same or different servers is called migration.

Exploring migration

BMC Change Manager for DB2 enables you to migrate objects and data in the following combinations:

- objects only, in which only the DDL SQL statements that define the selected objects migrate
- data only, in which only the data contained in the selected objects migrate
- objects and data, in which the data contained in the objects and the DDL SQL statements that define the objects migrate.

Migrating objects between databases

You can migrate a single object or multiple objects from one database to another. These databases may be on the same or different database servers, or even on physically separate servers.

This type of migration is typically used to copy objects from a test environment to a production environment, or to copy objects and data from a production environment to create a development environment.
Cloning objects and data

You can duplicate, or *clone*, objects and their data by migrating them within the same database. For example, you may want to migrate all of the objects from a user named PRESIDENT to another user named LINCOLN. The process of cloning objects and data by migrating them within the same database is called *migrating objects locally*.

**Tip**
To avoid conflicts between the original and duplicated objects, specify a new name or owner for each duplicated object.

Major work steps

You use the tools and components available on the Object Manager to perform the major work steps for all types of migrations. Figure 11 illustrates these steps. The sections that follow the illustration provide an overview of each step.
Step 1: Connecting to a database

For detailed information about connecting to a database, see Chapter 3, “Connecting to Databases and Repositories” on page 41.

---

**NOTE**

If the BMC Change Manager for DB2 servers between which you want to migrate data were started by different user IDs, a permissions problem may hinder the migration. To avoid this problem, BMC Software recommends that you start the BMC Change Manager for DB2 servers with the same user ID or ensure that the current permissions grant the different users access to the files in use.

---

When BMC Change Manager for DB2 completes the requested connection, it opens the Object Manager. You can then begin specifying migration options and object changes, and selecting objects and data for migration.

Step 2: Specifying migration elements

Prior to migrating objects and data, you can specify your preferences for some elements of the migration process. The options available include

- the combination of objects and data that you want to migrate
- the object dependents that you want to include in the migration
- the types of changes that you want to make to the objects prior to migration
- the impact of the requested migrations on the goal database
- the method of implementing the migration script

Specifying preferences and options

You can define the way BMC Change Manager for DB2 analyzes and implements your requested migrations. You can create global settings that apply to all migrations or you can choose individual options that apply only to the current migration. You specify your preferences, option choices, and overrides on the Edit Analysis Options dialog box (see Figure 12 on page 89). To access this dialog box, from the menu, choose Options => Analysis Options.

---

**TIP**

You may also access the Edit Analysis Options dialog box by clicking the Advanced Analysis Options button on the Options page of the Analysis Wizard.
You use the Edit Analysis Options dialog box to set options for such tasks as

- analyzing the migrating objects and their dependents
- analyzing the impact of your requested migrations
- generating a migration script
- running a migration script
- setting the location of the Unload and Load directories

For example, when you select the Include Edited Objects check box and the Include Created Objects check box on the Migrate Global tab (see Figure 12 on page 89), any objects that you create or edit in the migration session are automatically included in the migration.

Figure 12  Edit analysis options — Migrate Global tab (DB2)

Specifying unload and load directories

If you are migrating between different database servers, you must specify unload and load directories. You can accomplish this task on the Execution tab of the Edit Analysis Options dialog box.

TIP

You may also specify unload and load directories on the Options page of the Analysis Wizard.

For DB2 Universal Database, you accomplish this task on the Unload and Load tabs of the Edit Analysis Options dialog box.
Step 2: Specifying migration elements

The Unload Directory serves as a destination for the data files and log file created by the unload process. The Migrate Load Directory is the directory from which the product retrieves data files for loading back into the database.

**NOTE**
The Unload Directory and the Migrate Load Directory must physically exist prior to you running the migration script.

If you do not specify an unload directory, the product unloads data into the execution directory on the base database server during the unload phase. This response, however, causes problems during the load phase of migration, when a new execution directory is created on the goal database server.

By default, the product looks for the unloaded data in the execution directory on the goal database server. The load operation fails when the product does not find the unloaded data in that directory.

To avoid the operations from failing, specify an unload directory. Alternatively, you can copy the unload data file from the base database server’s execution directory to the goal database server’s execution directory. Then, you must restart the job.

**TIP**
Specify multiple unload devices when your data exceeds the maximum file or partition size allowed by your operating system.

**NOTE**
Loading data will not work if table in cataloged remote databases contains LOB data-type column. It has a restriction that all data for LOBs must be on the server where the data is being loaded from or on NFS file system.

**Specifying objects and data for migration**

You specify the objects and data that you want to migrate on the Objects tab of the Object Manager. To specify an object for migration, right-click the object and choose Migrate from the pop-up menu.

“Specifying object migrations” on page 95 provides detailed steps. The Help provides additional procedures.

**TIP**
You can also specify objects for migration on the Mig. Dependents tab of the Edit Analysis Options dialog box (see Figure 12 on page 89).
Altering objects

You can change object attributes, such as owner, prior to migrating objects. You make the changes by using an object editor or by specifying changes from the pop-up menu. For detailed instructions about modifying objects, see Chapter 4, “Altering Data Structures.”

Step 3: Verify migrations

As you specify migrations and changes to objects in a database, BMC Change Manager for DB2 keeps track of your requests. The product displays them on the Pending Actions tab (see on page 24). Review your pending actions and modify them, if necessary.

**TIP**

For instructions about canceling migrations, see “Clearing pending migrations for an object” on page 99.

After you accept the list of pending actions, you analyze the changes to determine their impact on the goal database.

Step 4: Analyze impact of migrations

Analyzing your migration actions enables you to discover the impact of your proposed actions on objects and their dependents before you implement the changes. Analysis saves you time and effort, and maintains the availability of your environments. For more information about analyzing the impact of changes, see “Step 4: Analyze impact of changes” on page 4-61.

You must analyze any proposed changes before you can implement them. Use the Analysis Wizard to accomplish this goal.

Using the analysis wizard

To connect to the Analysis Wizard, click the Analysis button on the toolbar of the Object Manager.
The Analysis Wizard guides you through the steps for configuring the way BMC Change Manager for DB2 analyzes your migrations. On the wizard, you can select migration options, specify load and unload directories, and establish whether the analysis runs on the client or server. “Analyzing migrations on the client” on page 96 provides detailed steps for performing client-side analysis. “Analyzing migrations on the server” on page 97 provides detailed steps for performing server-side analysis.

**TIP**

Although running a client-side analysis reduces the load on your database server, running the analysis on the server is typically faster, allows simultaneous analysis of changes and migrations for multiple sessions, and frees the client for other tasks.

If, after reviewing the results of the analysis, you are satisfied with your changes, you may then generate a script to implement the migration.

**Step 5: Generate a script**

To implement the changes that you specify during a work session, you must generate and save a script. The generated script specifies discrete operations that must be performed to carry out your requests. It also includes a strategy that selects an optimal method for completing the necessary tasks.

To generate a migration script, perform one of the following tasks:

- On the toolbar of the Object Manager, click the **Build** button.

- On the Location page of the Analysis Wizard, select the **Automatic Script Generation** check box to automatically generate the migration script after analysis has run. The check box is not selected by default.

After generating a migration script, the product displays the script in the window of the Edit Scripts tool. You may modify the script, if necessary.

**TIP**

To generate a DDL file from a script, click the **Convert to DDL** button on the Edit Scripts tool.

When you are satisfied with the generated script, you may run it.
Step 6: Run a migration script

Running a script implements your requested changes. To run the script, click the Run button on the Edit Scripts tool. To schedule the script to run later, click the Schedule button.

A migration script executes through one or both of the following phases:

1. The Unload phase runs on the base database server. The RDBMS-specific utility performs the unload action.

   **NOTE**
   The Unload phase is not required when you are migrating objects only.

2. The Create and Load phase runs on the goal database server. During this phase, the script creates the objects, loads data (if applicable), and creates privileges and audit options (if specified).

You use the Job Scheduler tool to specify the phases and the order in which they run. “Migrating schema and data or data only between different databases” on page 99 provides detailed steps for performing a two-phase migration. “Scheduling a script from the client” on page 75 provides additional information about using the Job Scheduler tool to control script execution.

**NOTE**
You can use the patrolcl server command to schedule a script. For more information about patrolcl, see “patrolcl server-side command” on page 65.

When you run the script, BMC Change Manager for DB2 performs many actions, depending on the options that you set on the Edit Analysis Options dialog box. Some of the actions include

- unloading data from the table that you are copying
- creating the table, in one of several places:
  - in the database where it exists, under a new table name
  - in a database on a different database server
- creating dependent objects, as specified by your selections on the Migrate Dependents tab
- moving the data to the target NT server by using FTP
Step 7: Save the session

The standard procedure for migrating data assumes that the migration script being run on the goal database server(s) can find the unload directory on the base database server through NFS. In some migration scenarios, particularly when migrating to multiple servers at remote sites, the unload directory may not be accessible through NFS. In these cases, transfer the unloaded data files manually to the goal database server.

**TIP**

If both the base and goal servers reside on NT systems and your migration includes data, you can specify automatic transfer from the base server using FTP on the Migrate Global tab of the Edit Analysis Options dialog box (see Figure 12).

Step 7: Save the session

Be sure to save the current session before starting a new one. A saved session can provide a record of your database changes.

**NOTE**

If you specified a location for the Unload and Migrate Load directories, you must manually delete your unload data file after script implementation completes. If you accepted the directory defaults, the files are deleted automatically when you delete the job from the Job Queue tab on the Job Scheduler tool.

Achieving your goals

This section provides step-by-step procedures for migrating schema and data. Table 17 lists these procedures by task and shows their locations in the chapter.

**TIP**

The Help provides information about performing all BMC Change Manager for DB2 tasks.

<table>
<thead>
<tr>
<th>Task</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifying object migrations</td>
<td>on page 95</td>
</tr>
<tr>
<td>Analyzing migrations on the client</td>
<td>on page 96</td>
</tr>
<tr>
<td>Analyzing migrations on the server</td>
<td>on page 97</td>
</tr>
<tr>
<td>Clearing pending migrations for an object</td>
<td>on page 99</td>
</tr>
</tbody>
</table>
Specifying object migrations

You can select the objects for migration by using the Object Manager. You can also modify objects before you migrate them.

1 On the Objects tab of the Object Manager, double-click the object folder for the object that you want to migrate.

   **TIP**
   Use the Filter dialog box to limit the objects extracted to those objects of interest.

   A list of available object names appears in the Object pane.

2 In the Object pane, right-click the name of the object that you want to migrate.

3 Choose Migrate from the pop-up menu.

   A Migrate action icon appears next to the object in the Object pane.

4 If you want to modify the object name or any of the other object attributes for the migration, open the object editor, enter the changes, close the editor, and save your work.

---

### Table 17  Tasks for migrating schema (part 2 of 2)

<table>
<thead>
<tr>
<th>Task</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clearing all pending migrations</td>
<td>on page 99</td>
</tr>
<tr>
<td>Migrating schema and data or data only between different databases</td>
<td>on page 99</td>
</tr>
<tr>
<td>Migrating schema and data within the same database</td>
<td>on page 101</td>
</tr>
<tr>
<td>Migrating schema only between different databases</td>
<td>on page 103</td>
</tr>
</tbody>
</table>

---

**TIP**

Commands that appear on the pop-up menu may also appear on the Actions menu.
5 Repeat step 1 through step 4 for any additional objects that you want to migrate or modify.

**NOTE**

By saving your changes, you are requesting, but not implementing, a migration. The requested changes do not occur until you run the migration script on the goal database server. Because you run the migration script on another database server, the original objects on the base database server remain unchanged.

---

**Analyzing migrations on the client**

After you have made changes to database objects or marked them for migration, you analyze the impact of the pending actions on the database. Complete the following steps to run the analysis on a workstation.

1 Click the **Analysis** button on the toolbar of the Object Manager.

   The Analysis Wizard appears.

   Follow the instructions on the Analysis Wizard. On the Strategy page, select **Migration** and click **Next**.

   **NOTE**

   When you select the **Migration** option, the product analyzes object changes and migrations together in a single change script.

   On the Options page, specify the Unload Directory and the Migrate Load Directory, and then click **Next**.

   **TIP**

   To modify the configuration of the current analysis options, click the **Advanced Analysis Options** button and make your changes on the Edit Analysis Options dialog box.

2 On the Location page, select **Run analysis on the client**, specify whether the product generates a script when the analysis finishes, and then click **Next**.

3 On the Summary page, review your selections. To go back and undo a selection, click **Back**. To continue, click **Next**. To accept your selections, click **Finish**.
The analysis runs. A Message Log appears.

--- TIP ---
A status bar at the bottom of the window indicates the progress of the analysis. If necessary, you can stop the analysis process by clicking the **Stop** button on the main toolbar.

When the analysis completes, an object tree appears on the Impacted Objects tab. The object tree lists all of the objects affected by the current pending actions.

--- TIP ---
The Object Manager may minimize during analysis. To view the object tree on the Impacted Objects tab, maximize the window.

4 Review the object tree of impacted objects. To make additional modifications to an object, right-click the object and choose **Edit**. “Editing an object” on page 68 provides more information.

--- NOTE ---
If you make modifications, you must repeat the analysis process.

---

**Analyzing migrations on the server**

After you have made changes to database objects or marked them for migration, you analyze the impact of the pending actions on the database. Complete the following steps to schedule the analysis to run on the server.

1 Click the **Analysis** button on the toolbar of the Object Manager.

   The Analysis Wizard appears.

2 Follow the instructions on the Analysis Wizard. On the Strategy page, select **Migration** and then click **Next**.

--- NOTE ---
When you select the **Migration** option, the product analyzes object changes and migrations together in a single change script.
3 On the Options page, specify the Unload Directory and the Migrate Load Directory and then click Next.

**TIP**
To modify the configuration of the current analysis options, click the Advanced Analysis Options button and make changes on the Edit Analysis Options dialog box.

4 On the Location page, select Schedule analysis on a server and click Finish.

The Job Scheduler tool appears.

5 Click the Submit button to accept the displayed defaults and run the analysis immediately, or use the Job Scheduler tool to specify where and when the job runs. For additional information about using the Job Scheduler tool for server-side analysis, see the Help.

**NOTE**
When you click the Submit button, the product may prompt you for connection or host login information.

The Dispatch Status dialog box displays the progress of your submitted job.

6 When the analysis completes, record the sequence number for the job. The number appears in the Results box of the Dispatch Status dialog box.

7 Click the Job Queue tab on the Job Scheduler tool and locate the job in the left pane by using the sequence number from the Dispatch Status dialog box.

**NOTE**
A status icon appears to the left of each script or file name listed on the Job Queue tab. This icon identifies the run status of a job. For example, a green circle indicates that a job has completed successfully. For a complete icon legend, see the Help.

8 Double-click the job.

The Job Log tool appears.

9 On the Job Log, review the list of impacted objects. If necessary, make additional modifications to the objects using the Object Manager.

**NOTE**
If you make modifications, you must repeat the analysis process.
When you are satisfied with the changes, click the View Script button to display the generated migration script on the Edit Scripts tool (see “Exploring the edit scripts tool” on page 24).

### Clearing pending migrations for an object

You may decide to remove a migration request after reviewing the impact that the action has on other objects in the database. You clear pending migrations against a single object by using the tools on the Object Manager.

1. On the Objects tab of the Objects Manager, select the folder containing the object that is marked for the unwanted migration.

2. Right-click the object name in the Object pane and choose Reset from the pop-up menu.

   All pending changes for the object are cleared and are no longer reflected on the Pending Actions tab.

### Clearing all pending migrations

You may decide to remove all migration requests after reviewing the impact that the actions have on other objects in the database. You clear all unimplemented migration actions by using the tools on the Object Manager.

On the toolbar of the Object Manager, click .

All requested actions are cleared. You can begin specifying new migration actions.

### Migrating schema and data or data only between different databases

If your migration includes data and you are migrating elements between different databases on different or the same servers, you must use a two-phase migration process. Phase one consists of unloading migration elements from the base database. Phase two consists of loading migration elements to the goal database. Complete the following steps to accomplish your goal.
Migrating schema and data or data only between different databases

1. From the Options menu, choose **Analysis Options**.

2. On the Execution tab of the Edit Analysis Options dialog box, specify an Unload and Migrate Load Directory.
   - On the Unload tab of the Edit Analysis Options dialog box, specify an Unload Directory.

**NOTE**
If you do not specify an unload directory, the data is stored in the default execution directory. To store the data sets in a directory other than the unload directory or the execution directory, you must edit the migration script. Use the Edit Scripts tool to change the unload path setting specified in the *Init* procedure.

To unload migrating elements from the base database server

1. From the Tools menu, choose **Job Scheduler**.
   
The What tab of the Job Scheduler tool appears.

2. In the Job Type list, select **Run Script**.

3. In the Script box, type the name of your migration script, or click **Run Script** to locate the script.

4. In the Procedure list, select **MigUnload - Unload Migrated Tables**.

5. On the Where tab, specify a host or session that is running the server processes and has access to the goal database. You can specify multiple hosts or sessions.

6. On the When tab, run the script immediately, or schedule the script to run later.

7. On the Job Queue tab, track the status of the submitted script.

To load migrating elements to the goal database server

1. If the servers use different load and unload directories, FTP or (for NT) copy the data files from the base server to the goal server.

2. If the servers use the same load and unload directories, use the Job Scheduler tool to execute a script that creates the objects and loads data on the goal server. For detailed instructions for using the Job Scheduler tool to accomplish this goal, see “Migrating schema only between different databases” on page 103.
Migrating schema and data within the same database

Duplicating objects by migrating them within the same database is called migrating objects locally. When you migrate objects locally, the migration script unloads the data, creates the objects, and then loads the data.

1. From the Options menu, choose Analysis Options.

2. Specify the migration options and preferences on the Edit Analysis Options dialog box.

   **TIP**
   If you select the Include Edited Objects check box and the Include Created Objects check box on the Migrate Global tab of the Edit Analysis Options dialog box, any objects that you create or edit in the migration session are automatically included in the migration.

3. On the Objects tab of the Object Manager, right-click the object that you want to migrate, and choose Migrate from the pop-up menu.

4. Open the object editor for that object and change the object’s name. You can also use the editor to modify any of the object’s other attributes.

   **NOTE**
   You change the object’s name so that when the migration script runs, it creates an object with a new name and the original object remains unchanged.

5. Repeat step 3 and step 4 for all of the objects that you want to migrate locally.

6. Review the migration requests on the Pending Actions tab.

7. Click the Analysis button and follow the instructions on the Analysis Wizard.

   **TIP**
   For detailed instructions for running an impact analysis on the client, see “Analyzing migrations on the client” on page 96. For detailed instructions for running an impact analysis on the server, see “Analyzing migrations on the server” on page 97.

8. On the Impacted Objects tab, review the impact of the requested migrations. Modify your changes, if necessary.
Migrating schema and data within the same database

9 Generate a migration script, if necessary, by clicking the Build button.

---

**TIP**

To stop script generation, click the Stop button on the main toolbar.

---

10 To run the migration script immediately, complete the following steps:

A From the Edit Scripts tool displaying the migrate script, click Run.

B On the Job Scheduler - Specify Procedure dialog box, choose MigScript - Create Objects Locally.

C Click OK.

D Select the Display job queue check box to automatically display the Job Queue tab when the job completes.

E Click OK.

The script runs immediately.

11 To schedule the migration script to run later, complete the following steps:

A From the Tools menu, choose Job Scheduler.

The Job Scheduler tool appears.

B In the Job Type list, select Run Script.

C Type the name of your migration script or click to locate the script.

D In the Procedure list, select MigScript - Migrate Objects Locally.

E On the Where tab, specify the database.

F On the When tab, specify the date and time that the script runs.

G On the Job Queue tab, track the status of the submitted script.
Migrating schema only between different databases

If you are migrating schema only between different databases on different or the same servers, complete the following steps to accomplish your goal.

1. From the Options menu, choose Analysis Options.

2. Specify the migration options and overrides on the appropriate tabs on the Edit Analysis Options dialog box.

   **TIP**

   If you select the Include Edited Objects check box and the Include Created Objects check box on the Migrate Global tab of the Edit Analysis Options dialog box, any objects that you create or edit in the migration session are automatically included in the migration.

3. On the Objects tab of the Object Manager, right-click the object that you want to migrate, and choose Migrate from the pop-up menu.

4. Open the object editor for that object and modify it, if necessary.

5. Repeat step 3 and step 4 for all of the objects that you want to migrate.

6. Review the migration requests on the Pending Actions tab.

7. Click the Analysis button and follow the instructions on the Analysis Wizard.

   **TIP**

   For detailed instructions for running an impact analysis on the client, see “Analyzing migrations on the client” on page 96. For detailed instructions for running an impact analysis on the server, see “Analyzing migrations on the server” on page 97.

8. On the Impacted Objects tab, review the impact of the requested migrations. Modify the changes, if necessary.

9. Generate a migration script, if necessary, by clicking the Build button.

   **TIP**

   To stop script generation, click the Stop button on the main toolbar.

10. From the Tools menu, choose Job Scheduler.

    The What tab of the Job scheduler appears.

11. In the Job Type list, select Run Script.
Taking the next step

Now that you can migrate objects and data, see Table 18 to discover some other goals that the product can help you to achieve.

Table 18  Where to Go from Here

<table>
<thead>
<tr>
<th>Goal</th>
<th>Where to go</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review steps for accomplishing typical DBA tasks.</td>
<td>Chapter 2, “Getting Started” on page 29</td>
</tr>
<tr>
<td>Learn about connecting to a database repository.</td>
<td>Chapter 3, “Connecting to Databases and Repositories” on page 41</td>
</tr>
<tr>
<td>Learn about tracking database changes, discovering the differences between data structures, synchronizing the structures, and recovering environments.</td>
<td>Chapter 6, “Managing Database Changes” on page 105</td>
</tr>
<tr>
<td>Learn about the BMC Change Manager for DB2 tools that help you administer your database environment.</td>
<td>Chapter 7, “Change Manager Tools” on page 171</td>
</tr>
<tr>
<td>Learn about modifying database objects, analyzing the impact of your changes before you implement them, and implementing them.</td>
<td>Chapter 4, “Altering Data Structures” on page 55</td>
</tr>
<tr>
<td>Learn about BMC Change Manager for DB2 features and capabilities.</td>
<td>Chapter 1, “Introducing BMC Change Manager for DB2” on page 13</td>
</tr>
</tbody>
</table>
Managing Database Changes

The BMC Change Manager product for the DB2 product offers a superior solution for managing changes to databases throughout your enterprise. The product enables you to

- compare two data structures to identify their differences
- apply the changes required to make two data structures identical
- replicate changes to a single database across an entire networked enterprise without affecting local modifications

This chapter discusses the options, considerations, strategies, and steps available to you when using BMC Change Manager for DB2 to track and manage changes to your environments.

Before you begin

Before you can use the product, you must configure the client. In addition, you must have an open work session to perform the procedures discussed in this chapter. For information about configuring the client and opening work sessions, see Chapter 3, “Connecting to Databases and Repositories”.

Before you begin to manage database changes, you should familiarize yourself with the features and functionality of the Application Manager and the Object Manager. For an overview of the Application Manager, see “Managing change” on page 26. For an overview of the Object Manager, see “Managing schema” on page 23.

---

**TIP**

For definitions of terminology used in this chapter, see the glossaries at the back of this book and available in the Help.
Overview

Databases are dynamic. They evolve. They change. Constant pressures, such as scheduled database upgrades or unscheduled change requests, require you to create yet another version of the database. To comply with mandatory standards or satisfy audit requirements, however, you must track and control all changes to your business applications. To keep your sanity—and your job—you need to develop a change management process.

BMC Change Manager for DB2 can help you achieve this goal. The product enables you to develop and automate processes that track and manage updates to applications as they develop over time. Initiating these processes also provides you with the means to back out changes that are no longer wanted as business needs shift and new database changes take priority.

Developing change management processes

The key element in the process of managing enterprise-wide change using BMC Change Manager for DB2 is the application baseline. Think of the baseline as a snapshot picture of the state of your application. Baselines provide you with a historical record of the evolution of an application.

You can use these records to compare versions of your application. To perform these comparisons, you use the Compare Wizard (see Figure 13 on page 109). The Compare Wizard is the key tool in a change management process.

Based on the results of the comparisons, you can accomplish the following goals:

- discover the differences between versions
- update, or synchronize, one version to make it identical with the other
- distribute changes required to make one version identical to the other across your enterprise
- recover to any baselined state of your application

**TIP**

Use the Job Scheduler tool to automate periodic creation of application baselines (see “Scheduling Baseline Creation on the Server” on page 130).

The following sections provide general information about the components in a change management process. For step-by-step instructions for using these components, see “Achieving your goals” on page 120.
Exploring application baselines

“Creating a baseline for an application (Non-Interactive method)” on page 126 and “Creating a baseline for an application (Interactive Method)” on page 129 provide detailed instructions for creating baselines.

To work with a baseline, you must first connect to a repository. The repository is a set of database tables and related objects that serve as the storehouse for the application profile. For detailed information about connecting to a repository, see “Connecting to a database or to a repository database” on page 53.

After you connect to a repository, the Application Manager appears (see Figure 3 on page 27).

Exploring the application manager

The Application Manager is one of the primary components of BMC Change Manager for DB2. You use the tools available on this component to create and administer baselines, application profiles, and filters.

Exploring application profiles

Application profiles are containers that house all objects and their attributes that correspond to a particular use of an application. You use application profiles to define the applications that you want to manage. The boundaries of an application may be the software application to which the objects are related, such as an inventory system. Alternatively, you might define the application boundaries as object types for a particular application profile, such as all the tables in a production instance.

Exploring filters

Filters enable you to define and manage subsets of objects and their attributes. BMC Change Manager for DB2 stores all filters in the Filters folder on the Application Manager. You can use filters repeatedly to filter information for similarly related tasks. You can also edit filters to meet the ever-changing filtering needs of your database environment.

You may link and unlink different types of filters with an application profile, as needed. This flexibility enables you to baseline different views of the same objects. You can also create application-independent filters in the Filters folder (see “Creating a scope filter” on page 132, “Creating a change filter” on page 136, and “Creating a mask filter” on page 141). After you create a filter in the Filters folder, you can associate the filter with one or more application profiles (see “Associating filters with an application profile” on page 144).
Using scope filters

You use scope filters to define the set of database objects included in an application profile. If more than one scope filter is applied to an application instance, the resulting domain is the sum of all specified filters. Typically, the objects that you specify in a scope filter are logically related. For example, a scope filter might specify all of the objects that are owned by TEST or all of the objects that are dependent on a table named CUSTOMER.

Guidelines for scope filters are as follows:

- To create a scope filter, you define scope rules using the Scope Filter Editor.
  - Each scope rule applies to a particular object type.
  - Scope rules can include wildcard characters (% and _) to extract a group of similarly named objects.
  - You can select any or all dependent objects to include in a scope filter.

- You can create a new scope filter that is similar to an existing scope filter by editing the existing filter and saving it with a different name.

**NOTE**

After you define an application using a scope filter, you should not modify that filter for the life of the application. BMC Software recommends that you create a new scope filter every time you need to include additional objects to an application profile.

- You can associate one scope filter with many application profiles. Also, you can associate multiple scope filters with a single application profile.

**TIP**

You can drag a scope filter to a connection profile or a group in the Connection Manager to open an Object Manager session and extract a particular set of objects.

Making comparisons

The Compare process is a key element in managing change in your environments. This process identifies the differences between individual database objects (such as database tables) or sets of database objects (such as application baselines). You can then review these differences and decide the best manner in which to apply them to implement the necessary changes.
You compare two sets of database objects by using the Compare Wizard (see Figure 13). You can access the Compare Wizard by clicking on the Application Manager or the Object Manager.

**Figure 13  Compare wizard — Welcome page**

#### Using the compare wizard

You use the Compare Wizard to make the following types of comparisons, called Compare scenarios. You can compare

- two schemas
- two database objects
- two database instances
- a database instance to a DDL file
- two DDL files
- changes between two baselines
- changes between a baseline and a database instance
- changes to recover a database instance to a previous baseline
- a user-defined Compare scenario
Making comparisons on the object manager

A subset of Compare scenarios is accessible from the Object Manager.

- two schemas
- two database instances
- a database instance to a DDL file
- two DDL files
- two objects

On the Object Manager, you compare two objects by dragging one object in the object tree onto another object. This action displays the Specify Compare Types page of the Compare Wizard (see Figure 14). The Specify Compare Types page appears with the objects you selected to compare automatically specified.

Figure 14  Compare wizard — specify compare types page

TIP
Clear all pending actions on the Pending Actions tab before initiating the Compare process.

With some Compare scenarios, you may create or select a mask filter to omit certain object attributes from the comparison. In some cases, you may also create or specify a scope filter to include only a particular set of objects in the Compare scenario.

You can create or specify filters from the Specify Filters page of the Compare Wizard (see Figure 19 on page 155). To create a new filter, click .
For your convenience, the product displays a list of already-defined filters. These filters are drawn from the Filters folder on the Application Manager.

---

**NOTE**

On the Compare Wizard, you can also specify the repository database that contains the filters that you want to use. You do not have to be connected to a repository database to specify it.

---

**Using mask filters**

You use mask filters to specify the object attributes that you want to ignore during a particular Compare process. For example, suppose that you want to compare two tables to see how their columns differ. Because you are not interested in the segments and devices upon which the tables are built, you create and apply a mask filter that ignores these attributes during the comparison.

Guidelines for mask filters are as follows:

- To create a mask filter, you use the Mask Filter Editor to specify which attributes to ignore for particular object types. To simplify this task, the product displays a list box of available attributes for the object type that you specify.

- You can create a new mask filter that is similar to an existing mask filter by editing the existing filter and saving it with a different name.

- You can select and apply a mask filter to any data structure comparison, including individual object comparisons.

**Comparing privileges**

When you are comparing objects, you can also compare their privileges. You cannot compare privileges for DDL or Baseline comparisons.

Use the Compare Options tab to specify whether you want to compare privileges for objects.

- To compare privileges and not structures, select **Include Privileges Only**.

- To compare privileges and structures, select **Include Privileges and Structures**.

- To compare structures and not privileges, select **Ignore Privileges**.
Making comparisons

Structuring comparisons

Typically, you use the Compare process to compare an older data structure to a newer data structure. When you select the data structures, remember that BMC Change Manager for DB2 always identifies the changes that are required to make the *base* data structure the same as the *goal* data structure.

**NOTE**
You implement changes to the base structure only; the goal structure always remains unchanged during the Compare process.

With some Compare scenarios, the Compare Wizard sets up the base and goal of the comparison for you. Just follow the directions on the Specify Compare Types page.

Some examples of comparison order are as follows:

- For synchronizing two baselines, the base baseline is older than the goal baseline. You apply the resulting changes to the older baseline to synchronize it with the newer baseline.

- For restoring a set of objects to a previous baseline, you specify the database instance as the base of the recovery comparison and the baseline as the goal. The baseline is the older, more stable version to which you want to roll back.

- For checking a schema or database object against a master schema or database object, the base is the schema or database object that you want to verify. The goal is the master schema or database object.

- For comparing individual objects using the drag-and-drop feature, the object that you drag is the goal object. The object onto which you drop the dragged object is the base object that the product checks or changes.

Viewing the results of a comparison

Immediately after the Compare process is complete, BMC Change Manager for DB2 displays the difference between the compared structures. These differences represent the changes required to make the base data structure identical to the goal data structure. These changes are shown in the Compare Results window (see Figure 15 on page 113).

**NOTE**
DDL import or system error messages generated by the Compare process appear in a docked message log.
At this point, you have the following options:

- Review the changes and return to the Compare Wizard by clicking the Return to Wizard button.
- Analyze the changes for their impact on other objects by clicking the Apply Changes button.
- Generate an Open Change Definition Language (OCDL™) file (see “Exploring OCDL concepts” on page 115) to serve as a record of changes by clicking the Export OCDL button.
- Analyze the changes, create pending actions on the Object Manager, and generate a script to implement the changes by clicking the Build Script button.
- Generate a customized report of the Compare results by clicking the Display Report button.

Figure 15  Compare results window

Implementing changes resulting from a compare

After reviewing the results of a comparison on the Compare Results window, you can apply or publish the required changes to your development, test, or production environment. The manner in which you implement the changes depends on the type of work that you are doing. “Synchronizing data structures” on page 117 and “Recovering data structures” on page 119 provide examples of the goals that you can accomplish starting with the results of a comparison.

Implementing changes using change filters

You use change filters to apply changes to certain object attributes within your network enterprise. For example, suppose that you want to update a test database to a production database. The database name in the test database is TEST. The database name in the production database, however, is PROD.
To overcome this obstacle, you create and apply a change filter that instructs the product to substitute the database name PROD for the database name TEST before updating the production database.

Guidelines for change filters are as follows:

- To create a change filter, you define change rules by using the Change Filter Editor.
  - Each change rule applies to a particular object type.
  - You can use wildcard characters (\% and _) to change an attribute for a group of similar objects.

- You can create a new change filter that is similar to an existing change filter by editing the existing filter and saving it with a different name.

- You can make global database changes by applying a change filter, which substitutes one object attribute for another. For example, you can globally change the owner of a set of objects by applying a change filter to a connection profile or to a group.

- You can associate one change filter with many application profiles. Also, you can associate multiple change filters with a single application profile.

**TIP**

To apply a change filter to a connection profile or a group, drag the change filter onto the target connection or group on the Connection Manager.

### Using change logs

After BMC Change Manager for DB2 compares two baselines on the server, it automatically generates a change log. Change logs store the file containing the differences between the baselines and the changes required to synchronize them.

You can view the change log to see the updates made to the application over time, or you can drag it onto a database connection profile to execute the changes.

The file contained in a change log is an OCDL file.

### Running patrolan command to perform a the compare operation at the server-side

As an alternative to run the compare using the Compare Wizard, you can also fire the compare from the command line at server end.
Table 19 details the options of the **patrolan** command

### Table 19  options for the patrolan command

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>-C controlfile</td>
<td>control file name</td>
</tr>
<tr>
<td>-o options_file</td>
<td>name of the options file for compare</td>
</tr>
<tr>
<td>-s outputocdlfile</td>
<td>name of the output script file that will be generated</td>
</tr>
<tr>
<td>? Displays</td>
<td>command-line help information</td>
</tr>
</tbody>
</table>

### Exploring OCDL concepts

OCDL files are portable text files that enable you to transport sets of change records. You can use OCDL files to publish changes to any number of data structures throughout your network enterprise. When used in combination with a change filter, an OCDL file enables you to manage the basic elements of an application globally, without compromising any elements of the application that may vary locally. OCDL files have the file name extension **.cdl**.

### Generating OCDL files

You can generate OCDL files by using any of the following methods:

- After using the Object Manager to specify changes to objects, you can generate an OCDL file from actions that are listed on the Pending Actions tab of the Object Manager. To generate an OCDL file from pending actions, choose **Export OCDL** from the Tools menu.

- After you have run an analysis of change or migration requests on the server, you can generate an OCDL file from the Job Log that lists the requested actions. To generate an OCDL file from Job Log, click the **View OCDL** button.

- After comparing two data structures, you can generate an OCDL file from change records that are listed in the Compare Results window. Click the **Export OCDL** button on the Compare Results window to create an OCDL file.

- You can generate an OCDL file directly from a baseline. On the Application Manager, expand an application profile, right-click the baseline folder, and choose **Generate OCDL** from the pop-up menu.

---

**NOTE**

After performing a server-side comparison of two baselines from the same application profile, the product generates an OCDL file and puts it in a change log. This change log is stored with the application profile.
For detailed instructions, see “Generating OCDL files” on page 162.

**Editing OCDL files**

Editing OCDL files is not recommended. In addition to simple SQL-like statements, OCDL files include additional information that facilitates the use of OCDL in BMC Change Manager for DB2 and other BMC Software products. If you edit an OCDL file, you may inadvertently render information required by the product unusable.

You may, nonetheless, edit an OCDL file before implementing its changes. You edit OCDL files by using the Edit OCDL tool. Figure 16 shows a sample OCDL file displayed in the window of the Edit OCDL tool.

**Figure 16  Edit OCDL tool showing an OCDL file**

```octl
//***
// Start Table Commands
//***

/*OCDL 00000 Alter Table RACPROD_Number*/

ORDER changed from 'BACKROW' to 'CBSRID'

Modify Column TITLE ID
    NULLABLE changed from 'N' to 'Y'  

Modify Column TITLE_ID
    From Position 1 to Position 2

Modify Column DESCRIPTION
    From Position 2 to Position 1

ENDOCDL

/*OCDL 000000 Alter Table RACPROD_BSC_BASELINES*/

Drop Column BASELINE_STATUS

Modify Column PROTECT
    NULLABLE changed from 'N' to 'Y'

Modify Column OR_COMMIT
    From Position 7 to Position 4

```
Using OCDL files to implement changes

You can use the Object Manager to implement changes at either a single location or multiple locations. To implement changes at one location, you import an OCDL file into an active connection by choosing **Import DDL/OCDL** from the Tools menu. Importing OCDL files creates pending actions on the Pending Actions tab. To implement the changes, you analyze the changes, generate a script, and submit the script to run.

**TIP**

Use an OCDL file in combination with change filters to make changes across your enterprise without affecting local customizations. You can apply change filters when you import an OCDL file or process an OCDL statement. For more information about applying change filters, see the Help.

To implement changes at multiple locations, you use the Job Scheduler tool. Using the Job Scheduler tool to process OCDL files initiates server-side analysis. During server-side analysis, the product analyzes changes, generates a script, and submits the script to run automatically. For detailed instructions for implementing changes at multiple locations, see “Scheduling OCDL processing at one or more locations” on page 165.

**TIP**

You can also implement changes at multiple locations by dragging a change log from the Application Manager to one or more database connection profiles or groups on the Connection Manager.

Synchronizing data structures

Synchronization is the process of evaluating the differences between two similar data structures and applying the changes that are required to make the structures the same. It is used in a development or replication environment. BMC Change Manager for DB2 can help you to synchronize data structures when differences arise during development efforts.

Using BMC Change Manager for DB2, you can synchronize entire data structures or individual objects. You can synchronize two objects, two schemas, two database instances, or a database instance and a baseline.

**NOTE**

Synchronization involves applying changes to an older base structure to make it match a newer goal structure. The product can apply changes to database instances and individual objects, but not to baselines, which represent captured data at a specific point in time.
Figure 17 on page 118 illustrates a high-level overview of the workflow for synchronizing database instances and baselines.

**Figure 17  Synchronization Workflow**

- Baseline the goal and base structures
- Compare the structures
- Generate an OCDL file
- Run an impact analysis
- Generate and review the change script
- Run the script to implement the changes

**NOTE**

For details about completing the tasks outlined in the workflow, see “Achieving your goals” on page 120. In addition, for detailed information about accomplishing all change management tasks, see the Help.
Recovering data structures

If you discover that unwanted changes have been made to a data structure, you can use BMC Change Manager for DB2 to restore the data structure to a more stable point in time.

**NOTE**
Because the product always applies changes to the data structure that you specify first, choose the earlier, more stable database instance or baseline as the second data structure.

You can recover data structures from a database instance (schema) or from a previous baseline. Figure 18 on page 119 illustrates a high-level overview of the workflow for recovering a data structure.

**Figure 18  Recovery Workflow**

1. Compare the database to a previous baseline
2. Analyze the changes and generate OCDL
3. Generate and review the change script
4. Run the script to implement the changes

**NOTE**
For details about completing the tasks outlined in the workflow, see “Achieving your goals” on page 120. In addition, for detailed information about accomplishing all change management tasks, see the Help.
Achieving your goals

This section provides step-by-step procedures for managing change to data structures. Table 20 lists the procedures by task and shows their locations in the chapter.

**TIP**
The Help provides information about performing all BMC Change Manager for DB2 tasks.

<table>
<thead>
<tr>
<th>Task</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a repository database</td>
<td>on page 121</td>
</tr>
<tr>
<td>Creating an application profile</td>
<td>on page 122</td>
</tr>
<tr>
<td>Editing an application profile</td>
<td>on page 124</td>
</tr>
<tr>
<td>Deleting an application profile</td>
<td>on page 125</td>
</tr>
<tr>
<td>Creating a baseline for an application (Non-Interactive method)</td>
<td>on page 126</td>
</tr>
<tr>
<td>Creating a baseline for an application (Interactive Method)</td>
<td>on page 129</td>
</tr>
<tr>
<td>Scheduling Baseline Creation on the Server</td>
<td>on page 130</td>
</tr>
<tr>
<td>Browsing a baseline</td>
<td>on page 131</td>
</tr>
<tr>
<td>Creating a scope filter</td>
<td>on page 132</td>
</tr>
<tr>
<td>Creating a scope filter</td>
<td>on page 132</td>
</tr>
<tr>
<td>Editing a scope filter</td>
<td>on page 133</td>
</tr>
<tr>
<td>Extracting objects using a scope filter</td>
<td>on page 135</td>
</tr>
<tr>
<td>Creating a change filter</td>
<td>on page 136</td>
</tr>
<tr>
<td>Editing a change filter</td>
<td>on page 138</td>
</tr>
<tr>
<td>Applying a change filter to modify object attributes</td>
<td>on page 140</td>
</tr>
<tr>
<td>Creating a mask filter</td>
<td>on page 141</td>
</tr>
<tr>
<td>Editing a mask filter</td>
<td>on page 142</td>
</tr>
<tr>
<td>Associating filters with an application profile</td>
<td>on page 144</td>
</tr>
<tr>
<td>Disassociating a filter from an application profile</td>
<td>on page 145</td>
</tr>
<tr>
<td>Deleting a filter</td>
<td>on page 146</td>
</tr>
<tr>
<td>Comparing two baselines</td>
<td>on page 146</td>
</tr>
<tr>
<td>Viewing change logs</td>
<td>on page 149</td>
</tr>
<tr>
<td>Comparing two schemas</td>
<td>on page 149</td>
</tr>
<tr>
<td>Comparing two objects</td>
<td>on page 151</td>
</tr>
<tr>
<td>Comparing two objects</td>
<td>on page 151</td>
</tr>
<tr>
<td>Comparing two database instances</td>
<td>on page 153</td>
</tr>
<tr>
<td>Comparing a database instance and a baseline</td>
<td>on page 156</td>
</tr>
</tbody>
</table>
Creating a repository database

Before you can perform any change management actions, you should create application profiles in a repository database on a database server. To create a repository database, you first need to configure a repository database connection in the Connection Manager.

1. Configure a repository database connection.

2. Double-click the repository database connection in the Change Manager Repositories folder in the Connection Manager.

3. Specify login information, if necessary.

4. If no repository database exists on the specified server, a dialog box appears that asks if you want to create a repository database at this location.

   **NOTE**

   The Help provides detailed steps to create or select the repository database.

5. Click Yes to create the repository database.

6. In the Create Repository dialog box, provide the following information:

   A. In the **Tablespace** list, choose a tablespace for the repository database tables.

   B. Click OK.

7. On the Create Repository window, review the script to create the repository database and click the **Run now** button.

   When the repository database has been created, the product opens the Application Manager.
Creating an application profile

You create an application profile to store resources, such as baselines, scope filters, change filters, and mask filters, that are associated with an application. You create an application profile by using the Application Profile Wizard.

1 On the Application Manager window, click the AppWiz button.

--- TIP ---
Alternatively, you can right-click the Application Profiles folder, and choose Create from the pop-up menu.

The Application Profile Wizard’s Welcome page appears.

2 On the Welcome page, perform one of the following actions:

- Choose an existing connection from the list.
- If the connection that you want to use for the application is not listed, click Next.

--- TIP ---
Use the Next and Back buttons to navigate through the Application Profile Wizard. To go back and undo a selection, click Back. To continue, click Next.

3 On the Select a Host page, select the host where the database that you want to use resides, and click Next.

If you chose an existing connection on the Welcome page, the host is already selected. If the host that you want to use is not on the list, click Define New Host to launch the Host Wizard.

4 On the Specify a Database Instance page, type the name of the database instance. Then, click Next.

--- NOTE ---
If you chose an existing connection on the Welcome page, a default name is provided. You can accept the default or type a new name.

5 On the Select Scope Filters page, create a new scope filter and choose pre-defined scope filters that you want to associate with the application profile.
To create a new scope filter, click .

In the Available Scope Filters box, select one or more scope filters.

Click to move the selected scope filters to the Associated Scope Filters box.

Click Next.

**TIP**

To associate all available scope filters with the application profile, click .

On the Select Change Filters page, create a new change filter and choose pre-defined change filters that you want to associate with the application profile.

To create a new change filter, click .

In the Available Change Filters box, select one or more change filters.

Click to move the selected change filters to the Associated Change Filters box.

Click Next.

On the Select Mask Filters page, create a new mask filter and choose the mask filters that you want to associate with the application profile.

To create a new mask filter, click .

In the Available Mask Filters box, select one or more mask filters.

Click to move the selected mask filters to the Associated Mask Filters box.

Click Next.

On the Specify a Baseline Template page, you can optionally enter a template that the product will use to automatically generate baseline names as baselines are created for this application profile.

Use the following wildcards to specify the template:

- ####
  
  Indicates a four-character sequence. You must use exactly four # signs. The first baseline will be automatically numbered 0000, the second will be 0001, the third will be 0002, and so forth.
Editing an application profile

- Indicates the date the baseline was created, in eight digits. The date format is yyyymmdd.

  For example, you can have a template that looks like this:

  BMC#### @@@@@@@@

  A baseline that uses this template might be named like this:

  BMC0128 19990101

B Click Next.

9 On the Specify a Name page, add descriptive information about the application profile. Information such as category and description appears on the Object pane when you select an application profile in the Application Profiles tree.

A In the Name text box, specify a descriptive name for the application profile.

  This name will appear in the Application Profiles folder, prefaced by the owner name. For example: USER.PROFILENAME.

B In the Category text box, specify an optional category for this application profile.

C In the Description text box, specify an optional description for this application profile.

D Click Next.

10 On the Summary page, review the application profile and click Finish to create it.

Editing an application profile

You can modify the configuration for a particular instance of an application. You can modify the name, host, and database instance, as well as the scope, change, and mask filters that are defined for the application.

1 On the Application Manager, expand the Application Profiles folder, if necessary.

2 Select the application that you want to edit, and choose Edit from the pop-up menu.

3 In the Application Profile Properties dialog box, click a tab to edit information. The following tabs are available:
Deleting an application profile

Deleting an application profile removes the application profile from the application tree and deletes it from the repository database. You can decide whether to delete the application’s baselines, as well.

1 On the Application Manager, expand the Application Profiles folder, if necessary.

2 In the Application Tree pane, right-click the application profile that you want to delete and choose Delete from the pop-up menu.

3 Click Yes in the confirmation dialog box to delete the application profile. Otherwise, click No.

For details about defining an application profile, see “Creating an application profile” on page 122.

4 Click OK to save your changes and close the dialog box.
Creating a baseline for an application (Non-Interactive method)

You can create a baseline of an application profile to examine the way the application develops over time. The baseline represents the state of the database objects that are specified in one or more scope filters at the moment the baseline is created. In the non-interactive method, the product creates the baseline by using all the scope filters already associated with the application to extract and capture objects. In BMC Change Manager for DB2, you can also create a baseline by using database objects that are specified in a DDL file. For baselines created from DDL files, the scope is implicitly defined within the DDL as it is imported.

1 In the Application Profiles folder of the Application Manager, expand the application profile for which you want to create a baseline.

2 Ensure that at least one scope filter is associated with the application profile.

   For information about creating a scope filter, see “Creating a scope filter” on page 132.

3 Right-click the Baselines folder in the application profile and choose Create from the pop-up menu.

4 In the Create a baseline Wizard, specify the following information:

   A Select either the Scope filters associated with this application profile option or the DDL file option.

   If you specify the DDL file option, click the Browse button to locate the file that you want to use and complete the requested information.

   B Specify a name for the baseline.

   If you specified a baseline name template for the application, the Generate name from template option button is available. Otherwise, type a name for the baseline in the Use the Name text box.

   C Click OK to create the baseline on the client.

   **NOTE**

   If you want to perform baseline creation on the server, click the Schedule button. The Job Scheduler tool appears with the Baseline Creation job type already specified. For more information, see “Scheduling Baseline Creation on the Server” on page 130.

   When baseline creation completes, a dialog box appears indicating the success of your baseline creation.
5 Click OK.

The Application Manager appears.

- If baseline creation was successful, the status column on the Object pane of the Application Manager shows Complete.

- If baseline creation was unsuccessful, the status column on the Object pane of the Application Manager shows Incomplete.

BMC Change Manager for DB2 adds the baseline to the application profile.

**TIP**

For more information about a baseline creation failure, see the Message Log. You can correct any errors and attempt to create the baseline again.

---

### Using patrolan to create baseline at server-side

You can create a baseline of an application profile from server-side using the `patrolan` command.

Table 21 details the options of the `patrolan` command.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-h host</code></td>
<td>specifies the connection host name</td>
</tr>
<tr>
<td><code>-d persistent_database</code></td>
<td>specifies the database name to log into</td>
</tr>
<tr>
<td><code>-u user</code></td>
<td>specifies the database user</td>
</tr>
<tr>
<td><code>-p password</code></td>
<td>specifies the database login if you did not specify a password, you are prompted to enter one from standard input</td>
</tr>
<tr>
<td><code>-x encrypted_password</code></td>
<td>submits a server-side baseline job, places it on hold from the BMC Change Manager for DB2 client, then gets values for options from the BASELINE file in the job directory on the server for the baseline job. The encrypted password is stored in the file aprescr.msl</td>
</tr>
<tr>
<td><code>-n channel</code></td>
<td>“d22mr” for DB2 Universal Database</td>
</tr>
<tr>
<td><code>-A appname</code></td>
<td>name of the application (in CAPs)</td>
</tr>
<tr>
<td><code>-B baseline</code></td>
<td>name for the baseline (in CAPs)</td>
</tr>
<tr>
<td><code>-U user</code></td>
<td>user for the repository session login</td>
</tr>
<tr>
<td><code>-P password</code></td>
<td>password for the repository session login</td>
</tr>
</tbody>
</table>
Taking a baseline from CDL or DDL

You can create a baseline from CDL and DDL using the `patrolan` command.

Table 22 details the options of the `patrolan` command.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-h host</code></td>
<td>specifies the connection host name</td>
</tr>
<tr>
<td><code>-d database</code></td>
<td>specifies the database name to log into</td>
</tr>
<tr>
<td><code>-u user</code></td>
<td>specifies the database user</td>
</tr>
<tr>
<td><code>-p password</code></td>
<td>specifies the database login. If you did not specify a password, you are prompted to enter one from standard input</td>
</tr>
<tr>
<td><code>-x encrypted_password</code></td>
<td>submits a server-side baseline job, places it on hold from the Change Manager client, then gets values for options from the BASELINE file in the job directory on the server for the baseline job. The encrypted password is stored in the file aprescr.msl</td>
</tr>
<tr>
<td><code>-n channel</code></td>
<td>“d22mr” for DB2 Universal Database</td>
</tr>
<tr>
<td><code>-A appname</code></td>
<td>name of the application (in CAPs)</td>
</tr>
<tr>
<td><code>-i inputfile</code></td>
<td>input file name</td>
</tr>
<tr>
<td><code>-j filetype</code></td>
<td>type of file (’cdl’, ’ddl’, ’cat’, or ’mds’)</td>
</tr>
<tr>
<td><code>-B baseline</code></td>
<td>name for the baseline (in CAPs)</td>
</tr>
<tr>
<td><code>-U user</code></td>
<td>user for the repository session login</td>
</tr>
<tr>
<td><code>-P password</code></td>
<td>password for the repository session login</td>
</tr>
<tr>
<td><code>-X encrypted_password</code></td>
<td>encrypted password for the repository session login</td>
</tr>
<tr>
<td><code>?</code></td>
<td>command-line help information</td>
</tr>
</tbody>
</table>

Table 21 Options for the patrolan command (part 2 of 2)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-X encrypted_password</code></td>
<td>encrypted password for the repository session login</td>
</tr>
<tr>
<td><code>?</code></td>
<td>displays command-line help information</td>
</tr>
</tbody>
</table>
Creating a baseline for an application (Interactive Method)

You can create a baseline of an application profile to examine the way the application develops over time. The baseline represents the state of the database objects that are specified in one or more scope filters at the moment the baseline is created. In the interactive method, you manually specify the database objects to extract, thereby defining the scope of the application and creating a baseline of those objects.

1. In the Application Profiles folder of the Application Manager, expand the application profile for which you want to create a baseline.

2. Ensure that no scope filters appear in the application’s Scope Filters folder by double-clicking on the Scope Filters folder. If no number appears in parentheses beside the folder, then no scope filters are associated with the application.

3. Right-click the Baselines folder in the application profile and choose Create from the pop-up menu.

   The Create a baseline Wizard appears.

4. Click Continue.

   An Object Manager session opens, defined for the application profile.

5. Expand the database from which you want to extract objects.

6. Extract the objects and dependents that you want to baseline.

   **TIP**
   
   For instructions for working with objects and dependencies on the Object Manager, see Chapter 4, “Altering Data Structures”.

7. When you have finished selecting objects, click to close the Object Manager.

   The Save baseline and filter dialog box appears.

8. Specify a baseline name and a scope filter name, and click OK.

   When baseline creation completes, a dialog box appears indicating the success of your baseline creation.

9. Click OK.

   The Application Manager appears.
Scheduling Baseline Creation on the Server

- If baseline creation was successful, the status column on the Object pane of the Application Manager shows *Complete*.

- If baseline creation was unsuccessful, the status column on the Object pane of the Application Manager shows *Incomplete*.

BMC Change Manager for DB2 adds the baseline to the application profile and the scope filter to the Scope Filters folder.

---

**TIP**

For information about a baseline creation failure, see the Message Log. You can correct any errors and attempt to create the baseline again.

---

### Scheduling Baseline Creation on the Server

When you create a baseline, you can choose to run the job on the server instead of on the client. By running the job on the server, you make the client system available for other tasks.

1. Follow the directions in “Creating a baseline for an application (Non-Interactive method)” on page 126 to the end of step B.

2. Click the **Schedule** button on the Create a baseline Wizard to run the job on the server.

   The Job Scheduler tool appears with the Baseline Creation job type already specified.

3. On the What tab, modify the job name and the group name, or accept the defaults.

4. Click the **Where** tab of the Job Scheduler tool, and select one or more connections on which to run the baseline creation job.

5. Click the **When** tab.

   If the Host Login dialog box (see Figure 10 on page 76) appears, supply the user ID and password, then click **OK**.

6. Select one of the following options:

   - Select **Immediately** to specify that the job runs immediately.
   - Select **Schedule** to specify a date and time for the job to run.
7 Click the **Submit** button.

The product may prompt you for connection or host login information.

The Dispatch Status dialog box displays the progress of the submitted job.

8 To check the status of the baseline creation, click the **Job Queue** tab on the Job Scheduler tool. Double-click any job to view the associated Job Log (see Figure 8 on page 63).

---

**TIP**

When you double-click a host on the Job Queue tab, a list of the jobs that have run or are scheduled to run on that host appears. A status icon appears to the left of each script or file name to identify its run status. For example, a green ball indicates that a job has completed successfully. For a complete icon legend, see the Help.

9 Click **X** to close the Job Scheduler tool.

---

**Generating DDL from a baseline**

You can generate the DDL for the selected baseline. The generated DDL displays the DDL statements for all objects from the selected baseline. The saved DDL can be used as required.

**To generate DDL from an existing baseline**

1 On the Application Manager, select the Application Profile folder that contains the baseline.

2 Double-click the Baseline folder to display the names of the existing baselines.

3 In the Object pane, right-click on the baseline, and choose **Show DDL** from the pop-up menu.

4 In the Save As dialog box, specify a name for the DDL file, and click **OK**

   The Edit DDL tool appears, displaying the generated DDL.

---

**Browsing a baseline**

After you create a baseline, you can browse the objects that it contains. Remember that you cannot edit objects in a baseline, but you can view them.
Creating a scope filter

You can use the Scope Filter Editor to create a scope filter that extracts specific objects. To create a scope filter, you specify one or more scope rules. Alternatively, you can also create a new scope filter by editing an existing scope filter and saving it with a different name.

1 In the Application Tree pane of the Application Manager, create a scope filter by using one of the following methods:

- To create an additional scope filter for a particular application profile, expand the Application Profiles folder, right-click the Scope Filters folder, and then choose Create from the pop-up menu.

- To create a scope filter independently of any application profile, right-click the Scope Filters folder in the Filters folder, and choose Create on the pop-up menu.

   The Scope Filter Editor appears.

2 Click the New rule button.

   The New Scope Rule dialog box appears.

3 Define a scope rule by supplying the following information:
A From the Object Type list, choose the type of object to which this rule applies.

B In the Pattern box, type a naming pattern for the objects of the specified object type.

Wildcard characters (\% and \_\_) are valid. Use \% to indicate 0 or more characters. Use \_\_ to indicate exactly one character.

--- NOTE ---
The **Keys** box provides read-only information to indicate the naming convention. You can use it as an aid to specifying the pattern.

C In the **Object Dependents** group box, select which dependent objects to include in the filter. To choose all available objects, click the **Select All** button.

--- NOTE ---
For BMC Change Manager for DB2, the Exclude Filter option is available only for the table, tablespace, and schema object.

D Click the **Add Rule** button.

--- TIP ---
To add multiple scope rules, repeat step 3.

4 Click \[ \] to close the New Scope Rule dialog box.

When the Scope Rule Editor reappears, each rule that you defined appears in the grid and is assigned the next number in sequence. You can click the **Move rule up** or **Move rule down** buttons to change the sequence.

5 To save your work, click \[ \] and specify a name for the scope filter.

6 To close the Scope Filter Editor, click \[ \].

The product updates the application tree with the new scope filter.

--- Editing a scope filter ---

You can use the Scope Filter Editor to add, edit, and delete scope rules for a scope filter.
**To add a scope rule**

1. To display the Scope Filter Editor, locate and open the scope filter that you want to edit:
   
   A. Either in the application profile folder or in the Filters folder, double-click the Scope Filters folder to extract the names of existing scope filters.
   
   B. In the Object pane, double-click the scope filter name.

2. On the Scope Filter Editor, select the row below which you want to add a scope rule, and then click the **New rule** button.

   The New Scope Rule dialog box appears.

3. Define the scope rule by supplying the following information:
   
   A. From the Object Type list, choose the type of object to which this rule applies.
   
   B. In the Pattern box, type a naming pattern for objects of the specified type.

      Wildcard characters (% and _) are valid. Use % to indicate 0 or more characters. Use _ to indicate exactly one character.

      **NOTE**
      The **Keys** box provides read-only information to indicate the naming convention.

   C. In the Object Dependents group box, select which dependent objects to include in the filter. To choose all objects, click the **Select All** button.

   D. Click the **Add Rule** button.

   **TIP**
   To add multiple scope rules, repeat step 3.

4. To close the New Scope Rule dialog box, click **x**.

5. To save your work, click **✓**.

6. To close the Scope Filter Editor, click **x**.
To edit a scope rule

1 On the Scope Filter Editor, double-click the scope rule that you want to edit.

   **TIP**
   
   You can also select the rule and then click the **Edit rule** button.

   The Edit Scope Rule dialog box appears.

2 Enter your changes, and click **x** to return to the Scope Filter Editor.

   On the Scope Filter Editor, each rule that you edited is updated in the grid. You can change the sequence of the rules by clicking the **Move rule up** or **Move rule down** buttons.

3 To save your work, click **.**

4 To close the Scope Filter Editor, click **x**.

To delete a scope rule

1 On the Scope Filter Editor, select the scope rule that you want to delete.

2 Click the **Delete rule** button, or press the **Delete** key on your keyboard.

3 On the confirmation dialog box, click **Yes** to delete the scope rule.

   The Scope Filter Editor reflects the changes.

4 To save your work, click **.**

5 To close the Scope Filter Editor, click **x**.

Extracting objects using a scope filter

On the Application Manager, you can apply a scope filter to one or more database connections to extract the set of objects with which you want to work. You can fully extract the objects, or you can extract the object names only. Only fully-extracted objects may be used in a comparison.

1 Create and save a scope filter that specifies the objects that you want to extract.

   For more information, see “Creating a scope filter” on page 132.
Creating a change filter

2 In the Application Tree pane, select the scope filter, and drag it onto a database connection profile in the Connection Manager.

A dialog box appears.

TIP
You can drag the scope filter onto a connection profile that is in the Database Connections folder or in a group folder. If you drag the scope filter onto a group connection profile, the product opens the session using the scope filter plus any additional scope filters that are specified for that connection profile.

3 In the dialog box, click one of the following buttons:

■ Click Yes to open the connection with full object extraction.

■ Click No to open the connection with object name only extraction.

■ Click Cancel to discontinue the operation.

The product opens the specified sessions by using information that you have already provided. You may be prompted to enter your user ID and password in the Database Login dialog box.

TIP
Extracting only object names takes significantly less time than extracting entire objects.

Creating a change filter

Change filters enable you to substitute one value of an object attribute for another value, thereby retaining local modifications to the data structure. You can use the Change Filter Editor to create change filters. To create a change filter, you specify one or more change rules. You can create change filters in the Application Profiles folder as part of an application profile, or you can create change filters individually in the Change Filters folder.

TIP
To create a new change filter, edit an existing change filter and save it with a different name. You can also import a filter from a delimited ASCII file.
Creating a change filter

1 In the Application Tree pane of the Application Manager, create a change filter by using one of the following methods:

- To create a change filter for a particular application profile, expand the application profile folder, right-click the Change Filters folder, and then choose Create from the pop-up menu.

- To create a change filter independently of any application profile, right-click the Change Filters folder in the Filters folder, and choose Create from the pop-up menu.

The Change Filter Editor appears.

2 Click the New rule button.

The New Change Rule dialog box appears.

3 Define the change rule by supplying the following information:

A From the Object Type list, choose the type of object to which this rule applies.

B In the Pattern box, type a naming pattern for the objects of the specified type. Wildcard characters (\% and \_) are valid.

C From the Attribute list, choose the object attribute to which this rule applies.

D In the Old Value box, type the current value of the attribute that you want to change.

E In the New Value box, type the value that you want to replace the old value.

When the product applies change filters, it searches for attributes that have the old value. If found, the product replaces the old value with the new value.

NOTE

The Keys box provides read-only information to indicate the naming convention.

NOTE

Wildcard characters are valid. Typically, the wildcards that you specify in the New Value box and in the Old Value box must match in number and order. However, two exceptions apply: the new value can have more underscore (_) wildcards than the old value; and the old value can include the percent (%) wildcard when the new value has no wildcards.
Editing a change filter

You can use the Change Filter Editor to add, edit, and delete change rules for a change filter.

To add a change rule

1 To display the Change Filter Editor, locate and open the change filter that you want to edit:
   
   A Either in the application profile folder or in the Filters folder, double-click the Change Filters folder to extract the names of existing change filters.
   
   B In the Object pane, double-click the change filter name.

2 In the Change Filter Editor, select the row below which you want to add a change rule, and then click the New rule button.

   The New Change Rule dialog box appears.

3 Define the change rule by supplying the following information:
   
   A From the Object Type list, choose the type of object to which this rule applies.
   
   B In the Pattern box, type a naming pattern for objects of the specified type.

4 Click ✗ to close the New Change Rule dialog box.

   When the Change Filter Editor reappears, each rule that you defined appears in the grid in sequence. Use the Move rule up or Move rule down buttons located at the bottom of the editor to change the sequence of the rules.

5 To save your work, click ✉ and specify a name for the change filter.

6 To close the Change Filter Editor, click ✗.

   The product updates the application tree with the new change filter.
Wildcard characters (\% and \_) are valid.

**NOTE**
The *Keys* box provides read-only information to indicate the naming convention.

C From the *Attribute* list, choose the object attribute to which this rule applies.

D In the *Old Value* box, type the current value of the attribute that you want to change.

   Wildcard characters are valid.

E In the *New Value* box, type the value that you want to replace the old value.

   Wildcard characters are valid.

F Click the *Add Rule* button.

**TIP**
To add multiple change rules, repeat step 3.

4 To close the New Change Rule dialog box, click \[x\].

5 To save your work, click \[\].

6 To close the Change Filter Editor, click \[x\].

**To edit a change rule**

1 On the Change Filter Editor, double-click the change rule that you want to edit.

**TIP**
You can also select the rule and then click the *Edit rule* button.

The Edit Change Rule dialog box appears.
Applying a change filter to modify object attributes

2 Enter your changes and click the Update Rule button to return to the Change Filter Editor.

**TIP**

You can use the buttons located across the bottom of the Edit Change Rule dialog box to display the other rules in the change filter: top of filter «, bottom of filter »», previous rule «, and next rule ».

On the Change Filter Editor, each rule that you edited is updated in the grid. You can change the sequence of the rules by using the Move rule up or Move rule down buttons.

3 To save your work, click .

4 To close the Change Filter Editor, click .

**To delete a change rule**

1 On the Change Filter Editor, select the change rule that you want to delete.

2 Click the Delete rule button, or press the Delete key on your keyboard.

3 On the Confirm dialog box, click Yes to delete the change rule.

   The Change Filter Editor reflects the changes.

4 To save your work, click .

5 To close the Change Filter Editor, click .

**Applying a change filter to modify object attributes**

Because change filters substitute one value of an object attribute for another value, you can propagate attribute changes to multiple data structures at one time, while retaining any local modifications (such as naming conventions) that may exist.

1 In the Application Tree pane of the Application Manager, select the change filter that contains the changes that you want to distribute.

2 Drag the change filter from the application tree onto a group or single database connection profile on the Connection Manager.

   If you drag the filter onto a group, the product applies the filter to all database connection profiles in that group.
3. Respond to the dialog box that asks whether you want to resolve objects that use patterns in the change filter before applying the change filter.

The Apply Change Filter Results dialog box appears.

4. Analyze the changes, build a script, or generate an OCDL file in one of the following ways:

- To analyze the changes for their impact on other objects, click the Apply Changes button.
- To analyze the changes and generate a script to implement the changes, click the Build Script button.
- To generate an OCDL file for import or application, click the Export OCDL button.

5. Implement the changes in one of the following ways:

- Review the changes, and then generate and execute the script. For more information, see Chapter 4, “Altering Data Structures,” or the Help.
- Use the Job Scheduler tool to process the OCDL file. For more information, see “Scheduling OCDL processing at one or more locations” on page 165.

Creating a mask filter

A mask filter omits specific object attributes from a comparison. You create a mask filter by specifying mask rules on the Mask Filter Editor. Mask filters reside in the Filters folder. Apply the mask filters as needed for the Compare process.

1. In the Application Tree pane of the Application Manager, create a mask filter by using one of the following methods:

- To create an additional mask filter for a particular application profile, expand the application profile folder and right-click the Mask Filters folder, and choose Create from the pop-up menu.
- To create a mask filter independently of any application profile, right-click the Mask Filters folder in the Filters folder, and choose Create from the pop-up menu.

The Mask Filter Editor appears.

2. Click the New rule button.
The New Mask Rule dialog box appears.

3 Define the mask rule by supplying the following information:

A From the Object Type list, choose the type of object to which this rule applies.

B From the Available Attributes list box, select the attributes that you want to mask, and then click.

The product moves the specified attributes to the Masked Attributes list box.

C When you have selected the attributes to mask, click the Add Rule button.

4 To close the New Mask Rule dialog box, click .

When the Mask Filter Editor reappears, each rule that you defined appears in the grid in sequence. You can click the Move rule up or Move rule down buttons to change the sequence of the mask rules.

5 To save your work, click and specify a name for the mask filter.

6 To close the Mask Filter Editor, click .

The product updates the application tree with the new mask filter.

**Editing a mask filter**

You can use the Mask Filter Editor to change the object attributes that are specified in a mask filter.
To add a mask rule

1. To display the Mask Filter Editor, locate and open the mask filter that you want to edit:

   A. Either in the application profile folder and in the Filters folder, double-click the Mask Filters folder to extract the names of existing mask filters.

   B. In the Object pane, double-click the mask filter name.

2. On the Mask Filter Editor, select the row below which you want to add a mask rule, and then click the New rule button.

   The New Mask Rule dialog box appears.

3. Define the mask rule by supplying the following information:

   A. From the Object Type list, choose the type of object to which this rule applies.

   B. From the Available Attributes list, select the attributes that you want to mask, and then click .

   The product moves the specified attributes to the Masked Attributes list box.

   **TIP**

   To quickly select multiple attributes, hold down the Shift key (for adjacent choices) or the Ctrl key (for nonadjacent choices) and click . To select all attributes, click .

   You can remove an attribute from this list by clicking .

   **TIP**

   To add multiple mask rules, repeat step 3.

4. To close the New Mask Rule dialog box, click .

5. To save your work, click .

6. To close the Mask Filter Editor, click .
To edit a mask rule

1 On the Mask Filter Editor, double-click the rule that you want to edit.

   **NOTE**
   You can also select the rule, and then click the **Edit rule** button.

The Edit Mask Rule dialog box appears.

2 Enter your changes, and click ✕ to return to the Mask Filter Editor.

   On the Mask Filter Editor, each rule that you edited is updated in the grid. You can change the sequence of the rules by using the **Move rule up** or **Move rule down** buttons.

3 Finish making your changes, and click ✕ to close the editor.

4 To save your work, click ✏.

5 To close the Mask Filter Editor, click ✕.

To delete a mask rule

1 On the Mask Filter Editor, select the mask rule that you want to delete.

2 Click the **Delete Rule** button, or press the **Delete** key on your keyboard.

3 On the confirmation dialog box, click **Yes** to delete the mask rule.

   The Mask Filter Editor reflects the changes.

4 To save your work, click ✏.

5 To close the Mask Filter Editor, click ✕.

Associating filters with an application profile

You can associate one or more predefined filters with one or more application profiles. An application does not have to have associated filters.
1 In the Application Profiles folder, right-click the application profile with which you want to associate a filter, and choose Edit from the pop-up menu.

2 In the Application Profile Properties dialog box, click one of the following tabs:

- **Scope Filters tab**
  Associate scope filters with the application.

- **Change Filters tab**
  Associate change filters with the application.

- **Mask Filters tab**
  Associate mask filters with the application.

3 From the Available Filters list, select one or more filters that you want to associate with this application.

4 Click .

The filter names move to the Associated Filters list.

5 Click Apply if you want to change other application properties, or click OK to save your changes and close the dialog box.

The product adds the filter to the appropriate Filters folder for the application profile.

### Disassociating a filter from an application profile

You can disassociate a filter from an application profile without deleting the filter from the repository database. When you disassociate a filter, the filter is still available in the appropriate subfolder of the Filters folder.

1 In the Application Profiles folder, expand the application profile that contains the filter that you want to disassociate.

2 Double-click the appropriate filters folder (Scope Filters, Change Filters, or Mask Filters) to extract object names, if necessary.
Deleting a filter

You can delete individual filters from the repository database.

1 In the Filters folder in the Application Tree pane, double-click the appropriate filters folder to extract object names, if necessary.

2 Right-click the name of the filter that you want to delete, and choose Delete from the pop-up menu.

   A confirmation dialog box appears.

3 Click Yes to delete the filter from the repository database.

   The application tree reflects the changes.

Comparing two baselines

You can compare two baselines to determine the changes that have been made to objects that are within the scope of an application profile. You use the Compare Wizard to specify the options that apply for this comparison. After the comparison, you can generate a portable OCDL file to use for distributing the changes within your network enterprise.

1 Click on the Application Manager window.

2 On the Welcome page of the Compare Wizard, choose Generate changes between two baselines from the Compare Scenarios list.
3 Click Next to continue.

**NOTE**
Use the Next and Back buttons to navigate through the Compare Wizard. To go back and undo a selection, click Back. To continue, click Next.

4 On the Specify Compare Types page, provide the following information:

A Specify the application profile and baseline that you want to update.

**TIP**
For comparing baselines, select the older baseline. For recovery, you can select a newer baseline.

B Specify the application profile and baseline that you want the base baseline to resemble.

**NOTE**
For comparing baselines, select the newer baseline. For recovery, select an older baseline.

C Click Next to continue.

5 On the Specify Filters page, you can create or specify an already-defined mask filter to hide certain object attributes, then click Next to continue.

- To create a mask filter, click .
- To specify an already-defined mask filter, choose a mask filter from the list.

6 On the Object Locations page, specify one of the following options, then click Next.

- Specify whether the comparison should use database names when matching objects.
- Specify whether the comparison should use owner names when matching objects.

7 On the Compare Options page, you can specify options to customize the baseline comparisons.
Comparing two baselines

A  To locate and extract objects that are not found during the Compare process, select the If a corresponding object isn’t found, try to extract it check box.

B  To ignore textual differences when comparing object attributes, select the whitespace or lettercase check boxes. These options reduce the number of changes that the product locates.

C  To display the types of changes required to make the first object like the second object, select one or more check boxes in the Show the following differences group box.

**NOTE**
The Creates, Edits, and Drops check boxes are selected by default. Clear the check boxes for those types of changes that you do not want to appear.

D  Click Next to continue.

8 On the Summary page, specify the location of the comparison. The client is the default location.

- If you want the product to perform the comparison on the client, click Finish to start the comparison.

- If you want the product to perform the comparison on the server, complete the following steps:

  A. Select the Perform this comparison on the server check box.

  B. Click Finish.

  C. On the Job Scheduler tool, schedule the time and the server on which the comparison runs.

When the product completes the comparison, the Compare Results window displays the change records that are required to make the first baseline identical to the second baseline.

If you are planning to distribute the changes to one or more locations (or for baseline comparisons), the next step is to generate an OCDL file. For instructions, see “Generating OCDL files” on page 162.

**TIP**
You can also use the product’s drag-and-drop feature to initiate a baseline-to-baseline Compare scenario. Simply drag the newer baseline onto the older baseline, click Next on the Specify Compare Types dialog box, and continue with Step 5 of this procedure.
Viewing change logs

After you compare two baselines, generate an OCDL file from the differences, and execute the script, the OCDL file becomes a change log that is stored with the application profile. Change logs are .cdl files that you use to track all of the changes that are made to the baselines of a particular application profile.

1. Expand the Application Profiles folder in the Application Tree pane.
2. Expand the folder of the application profile whose change logs you want to view.
3. If necessary, double-click the Change Log folder to extract the names of the available change logs.
4. Select the Change Log folder in the application profile.
5. In the Object pane, double-click the name of the change log that you want to view.

The change log file appears in the window of the Edit OCDL tool.

**TIP**

You can also use the product’s drag-and-drop feature to apply a change log to a database connection profile or group. Simply drag the change log onto the target connection or group in the Connection Manager.

Comparing two schemas

You can use BMC Change Manager for DB2 to compare two schemas. In DB2 Universal Database, the comparison uses schema objects.

1. Click on either the Object Manager or the Application Manager window.
2. On the Welcome page of the Compare Wizard, choose Compare two schemas from the Compare Scenarios list.
3. Click Next to continue.

**NOTE**

Use the Next and Back buttons to navigate through the Compare Wizard. To go back and undo a selection, click Back. To continue, click Next.

4. On the Specify Compare Types page, provide the following information:
Comparing two schemas

A Specify the schema that you want to change or check.

   ■ Specify the database connection and the schema object name.

   **NOTE**
   The product will synchronize data structures by applying the change records to the first schema.

B Specify the schema that contains the master set of objects.

   **NOTE**
   You may compare only active connections for this Compare scenario. An active connection is any open session or saved session that is currently available through the product.

C Click Next to continue.

5 On the Specify Dependents page, you can specify the dependent objects that you want to include in the comparison by using one of the following methods:

   ■ Individually select the check boxes for the dependent objects that you want to include in the comparison.

   ■ Click the Select All button to include all dependent objects in the comparison.

6 Click Next to continue.

7 On the Object Locations page, specify one of the following options, and then click Next.

   ■ Specify whether the comparison should use database names when matching objects.

   ■ Specify whether the comparison should use owner names when matching objects.

8 On the Compare Options page, you can specify options to customize the schema comparisons.

   A To include privileges in the comparison, select Include Privileges and Structures.

   B To locate and extract objects that are not found during the Compare process, select the If a corresponding object isn’t found, try to extract it check box.
Comparing two objects

You can use BMC Change Manager for DB2 to compare two objects within a database.

1 Click on either the Object Manager or the Application Manager window.

2 On the Welcome page of the Compare Wizard, choose Compare two objects from the Compare Scenarios list.

3 Click Next to continue.

NOTE
Use the Next and Back buttons to navigate through the Compare Wizard. To go back and undo a selection, click Back. To continue, click Next.

4 On the Specify Compare Types page, provide the following information for the object that you want to change or check (the base object):

C To ignore textual differences when comparing object attributes, select the whitespace or lettercase check boxes. These options reduce the number of changes that the product locates.

D To display the types of changes required to make the first object like the second object, select one or more check boxes in the Show the following differences group box.

NOTE
The Creates, Edits, and Drops check boxes are selected by default. Clear the check boxes for those types of changes that you do not want to appear.

E Click Next to continue.

9 On the Summary page, click Finish to start the comparison.

If you are comparing sessions for synchronization, the next step is to apply the resulting changes to the base data structure. For more information, see “Applying a change filter to modify object attributes” on page 140.

TIP
You can also use the product's drag-and-drop feature to initiate a comparison. Simply drag the newer schema onto the older schema, click Next on the Specify Compare Types page, and continue with Step 5 of this procedure.
Comparing two objects

A Use the **Connection** list to specify the database connection, if necessary.

B Specify the object type that you want to change or check.

C Use the **Object** list to specify the base object.

---

**TIP**

Click ![Icon](image) to populate the Object list, if necessary.

---

5 On the Specify Compare Types page, provide the following information for the goal object:

A Use the **Connection** list to specify the database connection, if necessary.

---

**NOTE**

The goal object type appears automatically based on your selection for base object type in Step 4.B.

---

B Use the **Object** list to specify the goal object.

C Click **Next** to continue.

6 On the Specify Filters page, you can select a repository database and mask filter to use for the comparison. Then, click **Next** to continue.

7 On the Compare Options page, you can specify options to customize the object comparisons.

A To include privileges in the comparison, select **Include Privileges and Structures** or **Include Privileges Only**.

A To locate and extract objects that are not found during the Compare process, select the **If a corresponding object isn’t found, try to extract it** check box.

B To ignore textual differences when comparing object attributes, select the **whitespace** or **lettercase** check boxes. These options reduce the number of changes that the product locates.
Comparing two database instances

You can use BMC Change Manager for DB2 to compare two database instances. A database instance is an active database connection or an inactive database connection profile. You must use the inactive database connection profile for server-side Compares. Before comparing an inactive database connection, the product must open the connection and extract objects. The objects that you want to compare must be fully extracted in each database instance. For example, if an active connection has extracted object names only, those objects are not used in a comparison.

1. Click on either the Object Manager or the Application Manager window.

2. On the Welcome page of the Compare Wizard, choose Compare two database instances from the Compare Scenarios list.

3. Click Next to continue.

4. On the Specify Compare Types page, provide the following information:

   - **NOTE**
     Use the Next and Back buttons to navigate through the Compare Wizard. To go back and undo a selection, click Back. To continue, click Next.

C To display the types of changes required to make the first object like the second object, select one or more check boxes in the **Show the following differences** group box.

**NOTE**
The Creates, Edits, and Drops check boxes are selected by default. Clear the check boxes for those types of changes that you do not want to appear.

D Click Next to continue.

8 On the Summary page, click Finish to start the comparison.

**TIP**
You can also use the product’s drag-and-drop feature to compare two objects. Drag one object (the goal) onto the other (the base), and then follow the instructions beginning with step 5 on page 152.
Comparing two database instances

A Specify the database instance that you want to change or check.

**TIP**
The product synchronizes data structures by applying the change records to the first database instance.

B Specify the database instance that contains the master set of objects.

**NOTE**
You can compare active connections or inactive connection profiles. An active connection is any open session or saved session that is currently available through the product. A connection profile is a defined host and database instance configuration. To extract the appropriate objects for the comparison, the product opens any connection profiles. You may have to specify a user ID and password for the product to log in.

C Click Next to continue.

5 On the Specify Filters page, you can create filters and specify already-defined filters for the comparison by using the following methods:

- To create a filter, click .
- If you specify filters, choose the repository database where the filters reside from the list at the top of the page.
- To specify a mask filter to hide certain object attributes, choose a mask filter from the first list.
- To specify a scope filter for the first database instance, choose a scope filter from the list on the lower-left side of the page.
- To specify a scope filter for the second database instance, choose a scope filter from the list on the lower-right side of the page.
Figure 19 shows an example of a completed Specify Filters page.

**Figure 19  Compare wizard—Specify filters page**

6 Click Next to continue.

7 On the Object Locations page, specify one of the following options, and then click Next.

- Specify whether the comparison should use database names when matching objects.
- Specify whether the comparison should use owner names when matching objects.

8 On the Compare Options page, you can specify options to customize the comparison of the database instances.

A To include privileges in the comparison, select Include Privileges and Structures.

B To locate and extract objects that are not found during the Compare process, select the If a corresponding object isn't found, try to extract it check box.

C To ignore textual differences when comparing object attributes, select the whitespace or lettercase check boxes. These options reduce the number of changes that the product locates.

D To display the types of changes required to make the first object like the second object, select one or more check boxes in the Show the following differences group box.
Comparing a database instance and a baseline

156

BMC Change Manager for DB2 Universal Database User Guide

Comparing a database instance and a baseline

You can compare a database instance with a baseline to determine the differences. When a baseline is used for comparison, the product applies any scope filters that are associated with the application profile to extract objects from the database instance.

For this task, the product generates change records to make the baseline resemble the database instance. You cannot, however, directly apply any changes to a baseline. Instead, you determine the changes that must be made to the data structure and generate an OCDL file, which you use to apply changes to other data structures.

NOTE

The Creates, Edits, and Drops check boxes are selected by default. Clear the check boxes for those types of changes that you do not want to appear.

E Click Next to continue.

9 On the Summary page, specify the location of the comparison. The client is the default location.

■ If you want the product to perform the comparison on the client, click Finish to start the comparison.

■ If you are comparing inactive connections, you may choose to perform the comparison on the server by completing the following tasks:

A. Select the Perform this comparison on the server check box.

B. Click Finish.

C. On the Job Scheduler tool, schedule a time and a server on which to run the comparison.

When the product completes the comparison, the Compare Results window displays the change records that are required to make the first database instance identical to the second database instance.

TIP

If you are comparing sessions for synchronization, the next step is to apply the resulting changes to the base data structure. For more information, see “Applying a change filter to modify object attributes” on page 140.
Comparing a database instance and a baseline

1. Click on the Application Manager window.

2. On the Welcome page of the Compare Wizard, choose **Generate changes between a baseline and a database instance** from the Compare Scenarios list.

3. Click **Next** to continue.

   **NOTE**
   Use the **Next** and **Back** buttons to navigate through the Compare Wizard. To go back and undo a selection, click **Back**. To continue, click **Next**.

4. On the Specify Compare Types page, provide the following information:
   
   **A** Specify the application profile and baseline that you want to update.

   **NOTE**
   For updating, select the older baseline. For recovery, you can select a newer baseline.

   **B** Specify the database instance that contains the set of objects that you want to use to update the baseline.

   **NOTE**
   You can specify active connections or inactive connection profiles for the database instance. An active connection is any open session or saved session that is currently available through the product. A connection profile is a defined host and database instance configuration. To extract the appropriate objects for the comparison, the product will attempt to open any connection profiles. You may have to specify a user ID and password for the product to log in.

   **C** Click **Next** to continue.

5. On the Specify Filters page, you may create filters and specify already-defined filters for the comparison by using the following methods:

   **NOTE**
   The fully extracted objects are used in a comparison. For example, if you apply a scope filter to a session and extract the object names only, those objects are not used in the comparison.

   - To create a filter, click .
   - If you specify filters, choose the repository database where the filters reside from the list at the top of the page.
To specify a mask filter to hide certain object attributes, choose a mask filter from the first list.

To specify a scope filter for the first database instance, choose a scope filter from the list on the lower-left side of the page.

To specify a scope filter for the second database instance, choose a scope filter from the list on the lower-right side of the page.

Figure 19 on page 155 shows an example of a completed Specify Filters page.

6. Click Next to continue.

7. On the Object Locations page, specify one of the following options, and then click Next.

   - Specify whether the comparison should use database names when matching objects.
   - Specify whether the comparison should use owner names when matching objects.

8. On the Compare Options page, you can specify options to customize the data structure comparisons.

   A. To locate and extract objects that are not found during the Compare process, select the **If a corresponding object isn’t found, try to extract it** check box.

   B. To ignore textual differences when comparing object attributes, select the **whitespace** or **lettercase** check boxes. These options reduce the number of changes that the product locates.

   C. To display the types of changes required to make the first object like the second object, select one or more check boxes in the **Show the following differences** group box.

   **NOTE**

   The **Creates**, **Edits**, and **Drops** check boxes are selected by default. Clear the check boxes for those types of changes that you do not want to appear.

   D. Click Next to continue.

9. On the Summary page, specify the location of the comparison. The client is the default location.

   - If you want the product to perform the comparison on the client, click **Finish** to start the comparison.
If you have specified an inactive database connection profile as the database instance for this Compare scenario, you may choose to run the comparison on the server by completing the following tasks:

A. Select the **Perform this comparison on the server** check box.

B. Click **Finish**.

C. On the Job Scheduler tool, schedule a time and a server on which to run the comparison.

When the product completes the comparison, the Compare Results window displays the change records that are required to make the first baseline identical to the database instance.

**TIP**

After comparing the data structures, you can generate an OCDL file that can be applied elsewhere. For more information, see “Generating OCDL files” on page 162.

### Comparing two DDL files

You can compare two sets of DDL files to determine their differences. This task briefly describes how to compare DDL files.

1. Click ![Object Manager](image) on either the Object Manager or the Application Manager window.

2. On the Welcome page of the Compare Wizard, choose **Compare two DDL files** from the Compare Scenarios list.

   Click **Next** to continue.

**NOTE**

Use the **Next** and **Back** buttons to navigate through the Compare Wizard. To go back and undo a selection, click **Back**. To continue, click **Next**.

3. On the Specify Compare Types page, provide the following information:

   A. Specify the base DDL file.

   B. Specify the goal DDL file.
Comparing two DDL files

C Specify the default DDL owner.

**TIP**
You can use the **Browse** button to locate the DDL file.

D Click **Next** to continue.

4 On the Specify Filters page, you can specify a mask filter to hide certain object attributes. Then, click **Next**.

- If you specify a mask filter, choose the repository database where the filter resides from the list at the top of the page.
- Choose a mask filter from the second list.

5 On the Object Locations page, specify one of the following options, and then click **Next**.

- Specify whether the comparison should use database names when matching objects.
- Specify whether the comparison should use owner names when matching objects.

6 On the Compare Options page, you can specify options to customize the DDL file comparisons.

A To locate and extract objects that are not found during the Compare process, select the **If a corresponding object isn’t found, try to extract it** check box.

B To ignore textual differences when comparing object attributes, select the **whitespace** or **lettercase** check boxes. These options reduce the number of changes that the product locates.

C To display the types of changes required to make the first object like the second object, select one or more check boxes in the **Show the following differences** group box.

**NOTE**
The **Creates**, **Edits**, and **Drops** check boxes are selected by default. Clear the check boxes for those types of changes that you do not want to appear.

D Click **Next** to continue.
Applying Changes Directly to a Data Structure

7 On the Summary page, specify the location of the comparison. The client is the default location.

- If you want the product to perform the comparison on the client, click Finish to start the comparison.

- If you want the product to conduct the comparison on the server, perform the following tasks:
  
  A. Select the Perform this comparison on the server check box.
  
  B. Click Finish.
  
  C. On the Job Scheduler tool, schedule a time and a server on which to run the comparison.
  
  D. When the product completes the comparison, the Compare Results window displays the changes that are required to make the first DDL file identical to the second DDL file.

8 On the Compare Results window, perform any of the following tasks:

- To create a .cdl file from the changes, click the Export OCDL button. The Edit OCDL tool displays the OCDL for you to view or edit. Click the Schedule button to implement the changes.

- View the differences and close the Compare Results window without taking action.

Applying Changes Directly to a Data Structure

To synchronize two data structures, or to recover an earlier data structure, the product applies to the first structure all of the change records that are identified in a comparison. You typically perform this task immediately after a comparison.

Use this method to apply changes only to a schema, a database instance, or an individual object. To apply changes to a data structure other than the specified database instance or object, generate an OCDL file. For more information, see “Generating OCDL files” on page 162.

1 Review the changes that are listed on the Compare Results window (Figure 15 on page 113).

These changes are required to make the first structure that you specified identical to the second structure.
2 Click the **Apply Changes** button.

---

**NOTE**
The **Apply Changes** button is not available if one of the compared data structures is a baseline.

---

The product analyzes the changes and displays pending actions on the Pending Actions tab of the Object Manager.

3 Review the required changes, and generate and run a script to implement the changes (for detailed instructions, see “Generating a script to implement changes” on page 74).

---

**TIP**
To analyze the changes, create pending actions on the Object Manager, and generate the script in one step, click the **Build Script** button.

---

## Generating OCDL files

OCDL files contain changes that you can publish across similar data structures in your network enterprise. After generating an OCDL file, you can publish the changes to one or more data structures.

**To generate OCDL from a comparison**

1 Perform a comparison to generate changes. Use one of the following methods:

- Use the Compare Wizard from the Application Manager to compare database instances or baselines.

  For more information, see “Comparing two baselines” on page 146, “Comparing two database instances” on page 153, or “Comparing a database instance and a baseline” on page 156.

- Use the Compare Wizard from the Object Manager to compare objects or DDL files.

  For more information, see “Comparing two objects” on page 151 or “Comparing two DDL files” on page 159.
Apply a change filter to a database connection profile or group by dragging the change filter onto a connection profile or group on the Connection Manager. Alternatively, you can choose **Apply Change Filter** from the Tools menu.

After a comparison, the Compare Results window displays the changes that are required to make the first structure identical to the second structure.

1. Click the **Export OCDL** button on the Compare Results window.

2. In the Save As dialog box, specify a file name for the OCDL file, and click **OK**.

   The Edit OCDL tool appears, displaying the generated OCDL.

   **WARNING**

   Although you can edit the OCDL file, editing OCDL is **not** recommended. For more information, see “**Editing OCDL files**” on page 116.

3. Click the **Schedule** button to access the Job Scheduler tool and run the script, or click ✗ to close the editor. For more information, see “**Scheduling OCDL processing at one or more locations**” on page 165.

**To generate OCDL from Pending Actions on the Object Manager**

1. Create pending actions by using the object editors to specify changes to objects.

2. Choose **Export OCDL** from the Tools menu.

3. In the Save As dialog box, specify a name for the OCDL file, and click **OK**.

   The Edit OCDL tool appears, displaying the generated OCDL.

   **WARNING**

   Although you can edit the OCDL file, editing OCDL is **not** recommended. For more information, see “**Editing OCDL files**” on page 116.

4. Click the **Schedule** button to access the Job Scheduler tool and run the script, or click ✗ to close the editor. For more information, see “**Scheduling OCDL processing at one or more locations**” on page 165.
To generate OCDL from an existing baseline

1 On the Application Manager, select the application folder that contains the baseline.

2 Double-click the Baselines folder to extract the names of existing baselines.

3 In the Object pane, right-click the baseline, and choose Export OCDL from the pop-up menu.

4 In the Save As dialog box, specify a name for the OCDL file, and click OK.

   The Edit OCDL tool appears, displaying the generated OCDL.

5 Click the Schedule button to access the Job Scheduler tool and run the script, or click ✗ to close the editor. For more information, see “Scheduling OCDL processing at one or more locations” on page 165.

Importing OCDL to a Single Location

You can import an OCDL file into the Object Manager as pending actions. You can then analyze or migrate the actions, generate a script, and run the script.

1 With the Object Manager open, choose Import DDL/OCDL from the Tools menu.

   The Import Objects to a Work Session dialog box appears.

2 Provide the following information:

   A In the Import File type group box, select the OCDL option.

   B In the Import File Name box, type the name of the OCDL file that you want to import.

       You can click the Browse button to locate and select the .cdl file.

   C To use a change filter when you import the OCDL file, select the Use Change Filter check box, and type the name of the change filter in the available box.

       You can click the Browse button to locate and select the change filter.

   TIP

   For more information about change filters, see “Implementing changes using change filters” on page 113.
D  Click OK.

The product displays actions on the Pending Actions tab. If errors occur, the Message Log displays the errors for your review.

3  Review the pending actions on the Pending Actions tab of the Object Manager. You may use the Analysis Wizard to analyze the actions and generate a script, or click to build an implementation script.

4  Use the Job Scheduler tool to run the script that will implement the changes. For more information, see “Scheduling OCDL processing at one or more locations” on page 165.

TIP

You can also publish changes to more than one location at one time. For instructions, see “Scheduling OCDL processing at one or more locations” on page 165.

Scheduling OCDL processing at one or more locations

To implement changes at one or more locations, process the OCDL file using the Job Scheduler tool. This method uses server-side analysis to analyze the changes, generate a script, and run the script automatically. You can also specify a change filter file to apply with the OCDL file.

This task assumes that you have already generated an OCDL file. “Generating OCDL files” on page 162 provides details about generating OCDL files.

To Specify a Change Filter for OCDL Processing

In some cases, the systems to which you intend to apply OCDL may have different naming standards than the standards that were used to generate the OCDL. You can use a change filter to substitute names so that the objects will match and the changes can be implemented at the appropriate sessions. The product uses the change filter while implementing the OCDL. You can specify a change filter only for connection profiles that are part of a group. Use the following instructions to associate a change filter with a particular database connection profile.
1 On the Connection Manager, select a database connection profile that belongs to a group in the Groups folder, and choose **Properties** from the pop-up menu.

2 In the Edit Connection dialog box, select the **Use Change Filter** check box and type a change filter in the available text box.

---

**TIP**
You can click the Browse button to locate and select a change filter.

3 Click **OK**.

The rules that are defined in the change filter are applied to the OCDL as the OCDL is implemented at the specified locations. As with most of the steps for change migration, adding change filters to a connection is a one-time action. The product will continue to use the designated filter for that connection until you edit or remove it.

### To Process OCDL Using the Job Scheduler

1 Open the Job Scheduler tool in one of the following ways:

   - When you want to implement OCDL changes by using a .cdl file that is not currently open, choose **Job Scheduler** from the Tools menu.

   - If you just generated or opened an OCDL file, the .cdl file appears on the Edit OCDL tool. Click the **Schedule** button on the Edit OCDL tool.

The Job Scheduler tool appears (see Figure 20).
2 Enter the following information on the What tab:

A From the Job Type list, choose **Server-Side Analysis**.

B In the OCDL File box, specify the name of the OCDL file.
   - Click to locate the name of the file on your system.
   - Click to edit the specified file on the **Edit OCDL** tool.
   - The name of the OCDL file appears in the Files to Submit box at the bottom of the window. You can add additional OCDL files by repeating this step.

C In the first Action list, choose **Analyze and Generate**.

D In the second Action list, choose **Changes**.

E In the Group Name box, type the name of the group to which this job applies, or accept the default.

F In the Generated Script box, type the name (and path, if necessary) of the script to be generated, or accept the default.

**NOTE**

When you access the Job Scheduler tool from the **Edit OCDL** tool, most of the options are already specified for you.
Scheduling OCDL processing at one or more locations

3 Click the **Where** tab of the Job Scheduler tool, and select one or more database instances on which to implement the OCDL.

You can specify scheduling at the individual database connection level or at a more encompassing level by selecting a combination of connections or groups. For example, the connections to update were selected at the group level. By default, the OCDL file runs on each connection in that group.

4 Click the **When** tab and select the **Schedule** option.

If the Host Login dialog box (see Figure 10 on page 76) appears when you click the When tab, supply the user ID and password, and click **OK**.

5 In the Start Date text box, enter the month, day, year, and time to run the OCDL file.

- You can click the portion of the date that you want to change, and click the up or down arrows to increase or decrease the value.
- You can click the larger down arrow to display a calendar on which you can designate the start date.
- You can also type in the new start date and time values.

6 Click the **Submit** button.

The product may prompt you for connection or host login information.

The Dispatch Status dialog box displays the progress of your submitted job.

7 To check the status of your OCDL file, click the **Job Queue** tab on the Job Scheduler tool. Double-click any job to view the associated Job Log (see Figure 8 on page 63).

**TIP**
When you double-click a host on the Job Queue tab, a list of the jobs that have run or are scheduled to run on that host appears. A status icon appears to the left of each script or file name to identify its run status. For example, a green ball indicates that a job has completed successfully. For a complete icon legend, see the Help.

8 Schedule or run another OCDL file, or click **X** to close the Job Scheduler tool.
Taking the next step

Now that you can track and control changes to your environments using BMC Change Manager for DB2, see Table 23 to discover some other goals that the product can help you to achieve.

Table 23  Where to go from here

<table>
<thead>
<tr>
<th>Goal</th>
<th>Where to go</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learn about the BMC Change Manager for DB2 tools that help you administer your database environment.</td>
<td>Chapter 7, “Change Manager Tools” on page 171</td>
</tr>
<tr>
<td>Review steps for accomplishing typical DBA tasks.</td>
<td>Chapter 2, “Getting Started” on page 29</td>
</tr>
<tr>
<td>Learn about modifying database objects, analyzing the impact of your changes before you implement them, and implementing them.</td>
<td>Chapter 4, “Altering Data Structures” on page 55</td>
</tr>
<tr>
<td>Learn about cloning objects and data in a database, migrating them to another environment, or using them to create an environment.</td>
<td>Chapter 5, “Cloning and Propagating Objects, Data, and Environments” on page 85</td>
</tr>
<tr>
<td>Learn about BMC Change Manager for DB2 features and capabilities.</td>
<td>Chapter 1, “Introducing BMC Change Manager for DB2” on page 13</td>
</tr>
</tbody>
</table>
Change Manager Tools

The BMC Change Manager for DB2 product provides a variety of tools to help you administer your database environment. You can use these tools to accomplish such goals as executing ad hoc SQL statements, editing table data, monitoring applications, managing BMC Software utilities, including load, unload, reorg, export, and import, and managing database privileges.

This chapter discusses the features and functionality of the following tools:

- Execute SQL tool
- Edit Data tool
- Monitors tool
- Utilities tool
- Execute Privileges tool

Before you begin

Before you can use the product, you must configure the client. In addition, you must have an open work session to perform many of the procedures discussed in this chapter. For information about configuring the client and opening work sessions, see Chapter 3, “Connecting to Databases and Repositories”.

Before you use the tools discussed in this chapter, you should become familiar with product features and their functionality. For detailed information about the components or capabilities of BMC Change Manager for DB2, see Chapter 1, “Introducing BMC Change Manager for DB2,” Chapter 4, “Altering Data Structures,” Chapter 5, “Cloning and Propagating Objects, Data, and Environments,” and Chapter 6, “Managing Database Changes.”

**TIP**

For definitions of terminology used in this chapter, see the glossaries at the back of this book and available in the Help.
Overview

You have a formidable goal to achieve: effective administration of environments across an enterprise. In the past, achieving this goal required completing difficult, complex, and, at times, tedious tasks. You conducted careful evaluations of proposed changes, constantly monitored your environments, and hand-coded script after script in an effort to simplify processes.

Today, achieving your goal is as easy as using the tools provided in BMC Change Manager for DB2. These tools enable you to increase efficiency, improve and automate processes, and reduce the risk of error as you manage your environments.

The following tools are included with BMC Change Manager for DB2:

- Execute SQL
- Edit Data
- Monitors
- Utilities
- Execute Privileges
- Job Scheduler
- Message Log
- Queries
- Import DDL/OCDL
- Apply Change Filter
- Export OCDL
- Edit Scripts
- Edit OCDL
- OCDL Report

Using the execute SQL tool to make ad hoc changes

Sometimes you have to make immediate changes to the database to ensure application performance. To make these types of changes, you use the Execute SQL tool or the Edit Data tool.

The Execute SQL tool (see Figure 21 on page 173) can process any dynamic SQL command that BMC Change Manager for DB2 supports, including issuing ad hoc SQL and native database commands to your database. Using the Execute SQL tool, you build a command file that specifies the actions that you want to perform. When you click the Run button, the command file executes immediately.

**TIP**

To access the Execute SQL tool from the main menu, choose Tools => Execute SQL.
To build a command file, you first specify on the tool the type and name of the object of interest. The product automatically supplies the syntax for SQL statements, such as CREATE, INSERT, UPDATE, and DELETE, and you select or enter the variable information for the statements. You may also type SQL statements and database commands manually.

**Figure 21 Execute SQL tool**

You can run the statements that you create using the Execute SQL tool only from the window of the Execute SQL tool. You may run the statements immediately or save them in a command file for later execution. The command file is created with an .mcp extension.

--- **TIP**

For details about creating and issuing ad hoc SQL statements, see “Creating and running ad hoc statements” on page 179.

When you run a SELECT statement, the Query Results window automatically displays the results in a results table. The Query Results window stores the results table for each SELECT statement that you issue.

--- **TIP**

For details about using the Query Results window, see “Viewing the results table for a SELECT query” on page 180.

The results tables are preserved for as long as the Execute SQL tool remains open. When you close the Execute SQL tool, you can save the SQL commands to a file. When you close the Query Results window, you can save the results of the queries. If you save the results, the results tables are retained on the client until you close the session.
Using utilities

One way to optimize your time is to use utility programs. These programs can save you time by facilitating routine operations, such as backing up a database, defragmenting table rows, or updating table statistics.

BMC Change Manager for DB2 enables you to use database manager specific utilities as well as utilities developed by BMC Software. You manage both kinds of utilities through the Utilities tool.

Using the utilities tool

The Utilities tool (see Figure 22 on page 175) enables you to specify the parameters and syntax for a script that runs a utility program. After you generate the utility script, you can use the Job Scheduler tool to run the script immediately or schedule it to run later.

To run a utility, follow these steps:

1. From the main menu, choose Tools => Utilities.
2. Accept the utility’s default command syntax, or specify customized parameters.
3. Generate and run the utility script.

NOTE
The Help provides detailed steps for this procedure.
You can save the utility command syntax and the parameters in a utility command file. The Help provides detailed steps for this procedure.

The list specifies which utilities that are available for DB2 Universal Database. For details about these utilities, see the Help.

- Backup Database
- Export
- Import
- Load
- Rebind
- Reorg
- Restore Database
- Runstats
Setting edit utility options

You can customize the manner in which BMC Change Manager for DB2 works with utilities and utility-related options. You can, for example, alter or reinstate system defaults for options affecting utility command files and script files. You accomplish this goal on the Edit Utility Options dialog box.

NOTE
The most recent parameters are saved for each utility unless you restore the default parameters through the Edit Utility Options dialog box.

To access the Edit Utility Options dialog box, from the main menu, choose Options => Utility Options. Alternatively, you can access the dialog box on the Utilities tool by clicking the Options button.

NOTE
You must be in an open session to set these options.

Using the execute privileges tool to manage object and system privileges

Like a doorman allowing only selected partygoers entrance to a popular discotheque, you control who gains access to your database. Instead of using a doorman’s velvet rope to control entry, though, you control access by managing privileges.

Some goals that you can achieve by managing privileges include

- keeping data confidential
- safeguarding the integrity of the data model
- controlling the insertion and modification of data or the modification of the database itself

By granting or revoking privileges, you control the manner in which users approach, view, modify, and manage their part of the database. You accomplish this goal by using the Execute Privileges tool.
You can use the Execute Privileges tool (see Figure 23 on page 178) to grant, alter, and revoke object and system privileges. You can control global access to the database, as well as exercise precise control over specific objects. You can also manage the privileges among different classes of users with varying degrees of authorization.

**TIP**

To access the Execute Privileges tool from the main menu, choose **Tools => Execute Privileges**.

Typically, you use the Execute Privileges tool to accomplish the following goals:

- modify newly granted or existing privileges
- review the SQL commands before implementing the changes
- implement specified privilege changes immediately without review
- save a privilege editing script

You can manage privileges from the perspective of a user, a group, or a role (if applicable to your DB2 database).

The Privileges tab on the Execute Privileges tool contains a grid that displays the attributes of the privileges that are granted for the following objects:

- function
- group
- index
- nickname
- package
- procedure
- role
- schema
- sequence
- server
- snapshot
- table
- table space
- user
- view

When you specify changes to privileges, the Action column (see Figure 23 on page 178) indicates any changes that are pending.
The Preview tab on the Execute Privileges tool enables you to review and edit the command syntax, if necessary, prior to implementing the privilege changes. For more information about editing command syntax, see the Help.

To implement privilege changes, click the Run button. After the privilege change script runs, the Preview tab displays the results.

**NOTE**

Granting, updating, and revoking privileges has an immediate impact on the database. Privilege changes do not undergo analysis before you run them.

---

**Figure 23  Privileges tab on the execute privileges tool**

---

### Achieving your goals

This section provides step-by-step procedures for using some of the tools available in BMC Change Manager for DB2. Table 24 lists these procedures by task and shows their locations in the chapter.

<table>
<thead>
<tr>
<th>Task</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating and running ad hoc statements</td>
<td>on page 179</td>
</tr>
<tr>
<td>Viewing the results table for a SELECT query</td>
<td>on page 180</td>
</tr>
<tr>
<td>Defining a Query on the edit data tool</td>
<td>on page 181</td>
</tr>
<tr>
<td>Editing the returned data on the edit data tool</td>
<td>on page 182</td>
</tr>
</tbody>
</table>
Creating and running ad hoc statements

To issue ad hoc commands to the database, you create command statements on the Execute SQL tool and then run the statements. You may type the statement syntax yourself or, for selected commands, have the product automatically generate the syntax.

1. To open the Execute SQL tool, choose **Execute SQL** from the Tools menu.

2. From the Database list (if available), select the database that contains the object that you want to use in the first statement.

3. From the Object Type list, select the type of object that you want to use in the statement.

4. From the Object Name list, select the specific object for which you are creating the statement.

   **TIP**
   
   You can drag an extracted object from an object tree on the Objects tab of the Object Manager to the Execute SQL tool.

5. To create the statement text, use one of the following methods:

   - In the Command list, double-click a command to perform against the specified object, or select a command and click the **Prepare** button.
     
     The correct syntax appears in the Command Text box.

   **NOTE**

   The commands available in the Command list vary with the object type that you specify in step 3.

   - Place the cursor in the Command Text box, and type any supported statement.
6 Review the statement. If necessary, edit the statement syntax and provide any variable information that is needed to complete the statement.

**NOTE**
You can include comments within SQL statements. The Help provides details for this procedure.

7 For each additional statement that you want to add, place the cursor in the Command Text box where you want to insert the new statement and repeat step 5 and step 6.

8 When you finish adding statements, click the **Run** button to run the statements.

Alternatively, you can save the statements in a command file to further edit or run later. The Help provides details for this procedure.

**NOTE**
If an error occurs while multiple statements are executing, processing stops. The product does not run any statements following the problematic statement.

---

### Viewing the results table for a SELECT query

When you run a SELECT statement using the Execute SQL tool, the Query Results window displays the results in a table. The Execute SQL tool uniquely names the results table for each query. These names appear in the Results list on the Query Results window.

1 Open the Query Results window by clicking the **Results** button on the Execute SQL tool, if necessary.

2 From the Results list, select the name of the desired results table.

**TIP**
The last digits in the results table names indicate the order in which the statements ran.

**NOTE**
The results of the query are available until you close the session.
Defining a Query on the edit data tool

The Query tab of the Edit Data tool simplifies constructing SELECT statements that instruct the product to retrieve and filter table data for editing. You can also run a preselect count of the rows to be returned.

The Edit Data tool is unavailable in DB2 Universal Database.

1. If necessary, extract table names by double-clicking the Table folder on the Objects tab of the Object Manager.

2. Right-click the name of the table that you want to edit, and choose Edit Data from the pop-up menu.

---

**NOTE**
The Edit Data command is available only for table objects.

---

The table’s available columns appear in the Select text box.

---

**TIP**
You can use the Table Name list at the top of the window to choose another table to edit.

---

3. From the Select list, choose the type of SELECT statement that you want to run.

4. Click individual columns to include in the SELECT statement, or click the All button to include all columns.

5. To restrict the returned data, define one or more WHERE clauses.

   Build each WHERE clause by using the boxes at the top of the Where group box. Click the Add button to add a clause. Click the Clear button to delete the selected clause.

6. To sort the returned data, define one or more ORDER BY clauses.

   Build each ORDER BY clause by using the boxes at the top of the Order By group box. Click the Add button to add a clause. Click the Clear button to delete the selected clause.

   Optionally, you can also select the Wait check box.

7. To view the generated SQL command text before you run it, click the Preview tab.

8. To run the SELECT query, click the Run button.
The product returns the queried data and displays it on the Data tab.

**Tip**
To resubmit your SELECT query, edit the query but do not edit the returned data, and click the Run button. You may also click the Reset button and define another SELECT query. For instructions for editing returned data, see “Editing the returned data on the edit data tool” on page 182.

---

**Editing the returned data on the edit data tool**

The results table on the Data tab of the Edit Data tool enables you to update the displayed data and add or remove entire rows.

**To update specific data values on the Data tab’s results table**

1. Select the cell that you want to edit.
2. Type a new data value in the cell, or edit the existing value.

**Tip**
To apply a null value to a cell, type the literal string `<null>`.

3. To undo a change, click the **Undo** button.

**To add a row**

1. Select a row by clicking either a cell in the row or the row number itself.
2. Click the **Insert** button to insert an empty row below the selected row.
3. Enter a value for each cell in the new row.
To remove a row

1 Select a row by clicking either a cell in the row or the row number itself.

2 To remove the selected row, click the Delete button.

**TIP**
To remove a new row that you inserted in step 2, click the Undo button.

To reset a pending change

1 Click the change in the ACTION column.

2 Click the Undo button.

The product removes the relevant change code from the ACTION column.

**NOTE**
The ACTION column dynamically updates to show which rows have changes pending from your editing session.

To view the generated SQL command text before you run it

1 Click the Preview tab.

The Preview tab displays the current SQL statements that the product uses to modify the RDBMS table.

**TIP**
You can copy Edit Data tool command text, paste it into the Execute SQL tool, and save the text as a command (.mcp) file.

2 To run the commands, click the Run button.
Viewing database statistics

Database monitors display statistical information about your system and database. Each monitor provides data in tabular format. Some monitors also include a Graph tab, which provides data in graphical format.

1 Choose Monitors from the Tools menu.

2 From the Monitors list, select a monitor to view.

3 Choose the format in which you want to view information.
   - For tabular or textual format, click the Data tab.
   - For graphical format, click the Graph tab (if available).

4 To dynamically update the monitor information, select the Auto Refresh check box and enter the refresh rate, in seconds.

5 To view the information as a static snapshot in time, clear the Auto Refresh check box.

   **TIP**
   Except for pie charts, you can update the monitor information at any time by clicking the Refresh button. To update the data in a pie chart, click the Data tab, click the Refresh button, and then click the Graph tab.

6 To view any graph for a monitor that has more than 15 rows of information, you must specify filtering information to filter the data.

7 When you finish viewing the monitor, you can either select another monitor from the Monitors list, or click to close the tool.

Managing object privileges

The Execute Privileges tool (see Figure 23 on page 178) enables you to grant privileges, limit privileges to specific columns, revoke privileges, and run the generated SQL text.
To grant privileges on an object

1. On the Objects tab of the Object Manager, expand the relevant database and double-click the appropriate object folder.

   The object names appear in the Object pane.

2. Right-click the object for which you want to modify privileges, and choose Privileges from the pop-up menu.

   The Privileges - Filter Options dialog box appears.

3. On the Privileges - Filter Options dialog box, specify the requested information, and click OK.

   The Execute Privileges tool appears.

   **TIP**
   
   To redefine the types of privileges that you view on the Execute Privileges tool, click .

4. Click the Grant button.

   The Grant Object Privileges dialog box appears.

   **A.** To view the available type of grantees, click a Grantee Type option button.

      The list box on the left displays the available grantee types.

   **B.** From the Grantors list box (if present), select a user other than the logged-in user, if needed.

   **C.** Select the With Grant Option check box (if present) to provide the grantee with the authority to grant the same privilege to others.

   **D.** In the Available Users or Available Group/Roles list (depending on the grantee type that you selected), select a grantee.

   **E.** In the Available Privileges list, select one or more privileges.

   **F.** Click Apply.

      The pending action appears in the Granted Privileges table on the Privileges tab.
Repeat these steps to grant additional privileges for the active object, as needed, and click OK.

**TIP**

To clone privileges from one user, role, group, or object to another, click the **Copy** button.

On the Privileges tab (see Figure 24 on page 186), the Action column of the privileges table displays the word **Grant** beside all new privileges.

**Figure 24  Sample privileges grid showing actions**

![Sample privileges grid showing actions](image)

**TIP**

To toggle the Grant/Admin column setting for a privilege with a grantee type of User, double-click the appropriate row.

5 Click the **Run** button.

The outcome appears in the Results box on the Preview tab.

**To limit privileges to specific columns**

To grant INSERT, SELECT, or UPDATE privileges for a table or view, or REFERENCES privileges for a table, and limit the columns on which you grant privileges, use the following procedure:

1 On the Privileges tab, double-click a column cell, or select a column cell, and click the **Columns** (or **Cols/Frags**) button.

The Privileges Column Editor dialog box appears.

2 Modify the Granted Columns list using the following methods:
To add columns, select the target columns in the Available Columns list, and click 

The columns appear in the Granted Columns list.

To remove columns, select the target columns in the Granted Columns list, and click 

The columns are removed from the Granted Columns list.

3 To change the With Grant option for the columns that you selected in the Granted Columns list, select or clear the With Grant check box.

4 Click OK.

5 Click the Run button.

The outcome appears in the Results box on the Preview tab.

To verify and run SQL statements

1 To verify the syntax of your Grant statements, click the Preview tab on the Execute Privileges tool (see Figure 25).

Figure 25  Preview tab on the execute privileges tool

The Preview Text box displays the SQL statements for all of the grants that you requested in the Grant Object Privileges dialog box.
2 Edit these statements directly in the Privilege Text box, if needed.

**TIP**
To cancel all impending actions or to re-extract the privileges from the database, click the ReExtract button.

3 To implement the database changes that are specified in the Preview Text box, click the Run button.

The outcome appears in the Results box on the Preview tab.

**To revoke privileges from an object**

1 On the Object Name list of the Privileges tab, choose the name of the object from which you want to revoke privileges.

2 Select one or more rows, and click the Revoke button.

**TIP**
Click the Revoke All button if you want to revoke all of the privileges that are displayed in the table.

3 Click to close the Execute Privileges tool.

**Using built-in scripts to set product privileges**

The BMC Change Manager for DB2 client contains two scripts that enable you to create roles in the database that you can assign to users who need access to BMC Change Manager for DB2 features. These scripts enable you to provide product access to users who do not have DBA authority.
Creating roles that can use the object manager

You can use the Execute SQL tool to run the alorole.mcp script that is provided with the product. This script creates the role PATROLDB, which provides a set of the minimum select table grants that are needed to work on the Object Manager. You can edit this script as required.

**NOTE**
Grants may fail on tables that have not been created.

1. Open a database connection and log in as DBA.
   
   For information about connecting to a database, see “Connecting to a database or to a repository database” on page 53.

2. From the Tools menu, choose Execute SQL.
   
   The Execute SQL tool appears.

3. Open the alorole.mcp file in an ASCII text editor.

   **NOTE**
   This file resides in the *installdir*\bin directory of the client installation program.

4. Copy and paste the contents from this file into the Command Text box on the Execute SQL tool.

5. Edit the script to customize it for your organization.

6. Click the Run button to execute the script.
   
   The script creates the PATROLDB role in the database.

7. Assign the PATROLDB role to users as needed.
Creating roles that can use the Application Manager

You can use the Execute SQL tool to run the cmrole.mcp script that is provided with the product. This script creates the role PATROLCM, which grants authority for repository database objects. The script also creates a system grant, SELECT ANY TABLE, for this role. You can change the statement to grant this privilege to the PATROLDB role. You can edit this script as required.

**NOTE**
Grants may fail on tables that have not been created.

1. If necessary, create the repository database.

**NOTE**
Only a DBA can create a repository database.

2. Open a database connection and log in as DBA.

   For information about connecting to a database, see “Connecting to a database or to a repository database” on page 53.

3. From the Tools menu, choose Execute SQL.

   The Execute SQL tool appears.

4. Open the cmrole.mcp file in an ASCII text editor.

   **NOTE**
   This file resides in the installdir\bin directory of the client installation program.

5. Copy and paste the first two statements from this file into the Command Text box on the Execute SQL tool. These statements are as follows:

   ```sql
   CREATE ROLE PATROLCM
   NOT IDENTIFIED;
   GRANT SELECT ANY TABLE TO PATROLCM;
   ```

6. Edit these statements as necessary, to customize them for your organization.

7. Click the Run button to execute the script.
The script creates the PATROLCM role in the database.

8 Close the Execute SQL tool and the connection.

9 Open a new database connection and log in as BMCREP.BMCREP.

This user is created in the database when you create a repository database.

10 From the Tools menu, choose Execute SQL.

The Execute SQL tool appears.

11 Copy and paste the remaining statements from the cmrole.mcp file into the Command Text box on the Execute SQL tool.

12 Edit these statements as necessary, to customize them for your organization.

13 Click the Run button to execute the script.

14 Assign the PATROLCM role to users as needed.

Taking the next step

Now that you are familiar with the features and capabilities of a few of the tools available to you in BMC Change Manager for DB2, see Table 25 to discover other goals that the product can help you to achieve.

Table 25 Where to Go from Here

<table>
<thead>
<tr>
<th>Goal</th>
<th>Where to go</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review steps for accomplishing typical DBA tasks.</td>
<td>Chapter 2, “Getting Started” on page 29</td>
</tr>
<tr>
<td>Learn about modifying database objects, analyzing the impact of your changes before you implement them, and implementing them.</td>
<td>Chapter 4, “Altering Data Structures” on page 55</td>
</tr>
<tr>
<td>Learn about cloning objects and data in a database, migrating them to another environment, or using them to create an environment.</td>
<td>Chapter 5, “Cloning and Propagating Objects, Data, and Environments” on page 85</td>
</tr>
<tr>
<td>Learn about tracking database changes, discovering the differences between data structures, synchronizing the structures, and recovering environments.</td>
<td>Chapter 6, “Managing Database Changes” on page 105</td>
</tr>
<tr>
<td>Learn about BMC Change Manager for DB2 features and capabilities.</td>
<td>Chapter 1, “Introducing BMC Change Manager for DB2” on page 13</td>
</tr>
</tbody>
</table>
Glossary

A

action icon
   Icon that appears next to an impacted object in the object panes of the Object Manager and the Application Manager. BMC Change Manager for DB2 removes the action icon after you implement the action or reset the object.

analysis process
   Process by which BMC Change Manager for DB2 determines the manner in which a set of changes or migrations will affect a relational database.

application instance
   Copy of the schema to which you migrate data structures or changes.

Application Manager
   Tool that you use to manage applications and associated resources.

application profile
   Container for all of the objects that correspond to a particular use of an application. These objects include the configuration profile, baselines, filters, and change logs.

application tree
   List of applications and their resources that appears on the Application Manager

B

base
   When comparing database structures, the base is the data structure that will change to match the goal data structure. Some examples of base selection follow:

   ▪ For synchronizing two data structures, the base is the data structure to which changes will be applied.

   ▪ For updating applications, the base is the older version and the goal is the updated version.

   ▪ For recovering a data structure, the base is the newer data structure that contains changes that you want to undo.
baseline
Snapshot of a data structure at a particular point in time. The baseline represents the set of objects that is defined by scope filters that are associated with the application.

BMC Change Manager for DB2
BMC Software product that enables database administrators, system administrators, and developers to manage user applications and individual database objects locally and globally, and streamline the process of managing changes to data structures across entire business enterprises.

BMC Change Manager for DB2 client
Desktop PC application that provides a graphical user interface for BMC Change Manager for DB2 and also performs a variety of compare and data analysis functions. The client connects to multiple BMC Change Manager for DB2 servers on your network, enabling you to manage multiple database servers. See also host.

BMC Change Manager for DB2 server
Set of server processes run on a host that provide database access and scheduling services between BMC Change Manager for DB2 clients and the database servers installed on the host. A BMC Change Manager for DB2 server can support multiple BMC Change Manager for DB2 clients, allowing database administrators, system administrators, and developers across the enterprise to simultaneously work with the database servers on the host.

C

CDL
See Change Definition Language.

Change Definition Language
BMC Software proprietary language for specifying changes to DB2 data structures.

change filter
Set of change rules that apply global changes to a named set of objects or to an object type. Change filters enable you to substitute the current value of one or more object attributes with a new value, or retain local modifications made to the application.

change log
OCDL file that records the changes that are required to make two baselines of a data structure identical to each other. Change logs enable you to track all of the changes made to an application instance over time.

change record
List of differences that are required to make the base structure identical to the goal structure. Change records appear in OCDL files and on the Compare Results window after a comparison.

change rule
One or more user-defined statements that you can specify in a change filter.
change script
   SQL file that uses a single-phase process that can include CREATE, ALTER, DROP, UNLOAD, LOAD, COMMENT, RENAME, and GRANT statements. These scripts run on the database server where the requested actions are specified.

client
   See BMC Change Manager for DB2 client.

clonen
   Act of duplicating an object using the Create Like command.

command file
   File containing the ad hoc command statements created using the Execute SQL tool. Instead of running statements immediately, you may save them in a command file. Command files have a .mcp file extension.

Compare process
   Process that identifies the differences between individual database objects (such as database tables) or sets of database objects (such as application baselines or catalogs).

configuration
   Process of defining hosts and creating connection profiles for the client. You use the Connection Manager to configure the client.

Connection Manager
   Tool in BMC Change Manager for DB2 that enables you to define hosts, connection profiles for databases and repositories, and groups.

connection profile
   Group of settings that specify which host, database server, and user ID to use when you connect to a database or to a repository.

D

database connection
   Link that gives the product access to a selected database server or repository.

database server
   Collective term for an RDBMS in a client/server environment (as used here, refers only to the RDBMS software). See also host and BMC Change Manager for DB2 server.

DDL file
   Script file that contains the EXEC SQL statements from your work script. DDL (Data Definition Language) files have a .sql extension.

dependencies
   Names or values of objects that another object uses as part of its definition.
dependencies pane
Lower right portion of the Object Manager window, on which extracted dependencies for the selected object appear.

dependent object
Object that is defined by the name or the values of another object. The dependent object references the other object (known as the referenced object).

detail view
See object detail view.

E
Edit Data tool
Tool that enables you to directly edit table data in the database.

Edit Scripts tool
Tool that enables you to edit and print scripts.

Execute SQL tool
Tool that enables you to create and run ad hoc SQL statements.

Execute Privileges tool
Tool that enables you to grant and to revoke roles and object and system privileges for users or roles.

export
Act of preparing and transferring an object or an object-set definition on the current database for use on another database.

extraction
Act of retrieving objects or object names from the connected database to view or manipulate them.

F
filter
Generic name for the mechanism by which you manage subsets of objects and their attributes.

G
goal
When comparing database structures, the goal is the data structure against which the base data structure is compared. The goal does not change. Some examples of goal selection follow:

- For synchronizing two data structures, the goal is the data structure that contains the wanted changes.
For updating applications, the goal is the newer version, which contains the updated data structure.

For recovering a data structure, the goal is the older, more stable structure that you want to restore.

group
Container for related database connection profiles that you define using the Connection Manager.

H

Hold status
Status for a script in the Job Scheduler tool’s job queue. A job will not execute until released from this status.

host
Workstation or system on which both the BMC Change Manager for DB2 server and a database server are installed. A BMC Change Manager for DB2 client cannot communicate with a host unless the BMC Change Manager for DB2 server (patroldb) has been started on the host.

I

icon
Graphical representation of an object, an action, an impact, or other attributes.

impact icon
Icon that represents the manner in which an object will be affected by a pending action.

import
Act of obtaining an object or object-set definition from a file or an external database and applying it to the current database.

J

job
Set of user-defined specifications. A job consists of a job name, a job log file name, and job actions.

Job Scheduler tool
Tool that you use to schedule or submit scripts to run on a server and to monitor and manage jobs that you have submitted to the job queue.
mask filter
Set of user-defined rules that specify which object attributes BMC Change Manager for DB2 ignores when comparing two data structures.

Message Log
Window that displays generated messages or errors, or records of events that pertain to database actions. Also, when it appears in all lowercase text, a message log is a file that stores Message Log contents.

migrate
Process of moving objects and data from one RDBMS instance to another, and of converting an RDBMS to another release version of the RDBMS.

name filter
Set of user-defined rules that specify the object name pattern against which BMC Change Manager for DB2 filters, matches, and extracts objects.

name propagation
Process of extending to dependent objects the changes that you make in a referenced object.

object browser
Product window that displays read-only definitions and attribute settings for a specific object.

object editor
Product window in which you create objects and specify changes to objects.

object filter
Tool by which you can specify a subset of objects for BMC Change Manager for DB2 to match and extract from a database.

object folder
Folder that contains objects of a particular type, identified by an object icon.

object folder pane
Left portion of the Object Manager window, in which object folders for the RDBMS appear.

object icon
Icon that represents an object that you can manipulate or view.
Object Manager
   Product window from which you can manipulate objects that you extract from a database during a session.

object pane
   Upper right portion of the Object Manager window, in which extracted object names and attributes appear for the selected object type. See also object detail view.

object tree
   List of objects that you can manipulate or view.

OCDL
   See Open Change Definition Language.

offline
   Status of a session that is disconnected from a database server, a saved session that has been restored, or a session that is used as an application baseline.

on-demand extraction
   Act of retrieving objects or object names from the connected database to view or manipulate them.

online
   Status of a session that is connected to a database server.

Open Change Definition Language
   Commands that are used to specify changes to the database. BMC Change Manager for DB2 generates OCDL from the change records that result from a comparison.

P

pattern
   Rule that is applied to the naming of objects of a specified type.

pending action
   Action that specifies a change that must be made to a database so that an ALTER statement or a migration may be implemented. You create pending actions by specifying changes on the Object Manager or by applying change records.

pop-up menu
   Menu of commonly used commands that appears when you click the right mouse button.

procedure
   Set of SQL or other script language statements (such as PL/SQL, Transact-SQL, or SPL) that are stored as an object in the database. A procedure is executed as a unit to perform a set of related tasks.
profile
   See connection profile.

R

referenced object
   Object that a dependent object references.

referencing object
   See dependent object.

repository database
   Database containing product-generated tables that stores all of the files that are associated with applications and filters.

S

scope filter
   Set of user-defined scope rules that you can apply against a group of objects to define the domain of an application. Scope filter file names have the .fil extension.

scope rule
   One or more user-defined statements that you specify in a scope filter to define objects within the domain of a user application.

script
   Automatically generated, editable file that contains SQL statements and proprietary script syntax.

server
   See database server and BMC Change Manager for DB2 server.

session
   Unit of work in which you perform all activities within the product.

SQL statement
   Structured Query Language (SQL) command and its parameters. SQL is the ANSI standard language that is used to manage information that is stored in a relational database.

status bar
   Indicator bar that appears at the bottom of the main product window.

synchronization
   The process of identifying structural or data differences between two copies of the same data structure, and then making the data structures identical.
T

tab
Element of a GUI application window or dialog box. Tabs are typically used to organize information into layers. A window or dialog box may have multiple tabs, and each tab may have different fields and information. Click a tab to see the information that it contains.

toolbar
Strip of buttons that, when clicked, provides immediate access to product functionality.

user preferences
Application defaults that you can change.

U

Utilities tool
Tool that you use to launch utilities that are supported for your RDBMS.

W

wildcard
Symbol used to represent a value in SQL statements, filters, and name patterns.
Index

A
action icons 59, 74
Actions menu 17, 60
Active Connections folder 43
ad hoc SQL commands 172, 179
altering database objects 57
analysis
client-side 69, 96
detecting conflict 61
impact of changes 61, 69
impact of migrations 91, 96, 97
invoking from Compare Results 162
name propagation 61
phases 61
reviewing the results 62
server-side 70, 117, 165
analysis options 62, 88
Analysis Wizard 61, 69, 71, 96, 97
Application Manager 26, 43, 107
Application Profile Wizard 122
application profiles
associating filters 144
creating 43, 122
creating baselines 126, 129, 130
deleting 125
disassociating filters 145
editing 124
applications
associating filters 144
configuring 122, 124
creating a baseline 126, 129
creating a profile 122
deleting a profile 125
disassociating filters 145
editing a profile 124
filters 107
management 107
applying changes 161
archiving
changes 65
scripts 26
baselines
base baseline 147, 157
browsing 131
comparing 146
comparing with database instances 156
creating 34, 126, 129, 130
creating an application profile 43, 122
goal baseline 147, 157
naming templates 123, 125
overview 106
use of scope filters 126
viewing 131
window 132
BMC Software, contacting 2
buttons, toolbar 17, 18

C
change
applying 161
management 113, 115, 120
objects 57
propagating 61, 140
publishing 115
resulting from comparison 113
Change Filter Editor 137
change filters
adding change rules 138
applying 36, 113
creating 136
deleting change rules 140
editing 138
editing change rules 139
propagating changes 140
change logs 114, 149
Change Manager Repositories folder 43
change rules
adding 138
defining 114
deleting 140
editing 139
clearing change requests 73
cloning objects 87
Close button 18
column privileges 186
command files 20, 172, 173
commands
database 173
patrolcl 65, 77, 82
Compare process
comparing a database instance and baseline 156
comparing two baselines 146
comparing two database instances 153
comparing two DDL files 159
comparing two objects 151
comparing two schemas 149
masking object attributes 141
order of comparisons 112
overview 108
results of 112
Compare Results window 161
Compare Wizard 109, 146
comparisons
in Application Manager 109
in Object Manager 110
configuration files, distributing 52
configuration tasks 45
configuring
database connections 47
hosts 46
repository connections 34, 48
Connect button 18
connecting
database 22, 42, 53, 57, 88
repository database 53
Connection Manager 23, 42
Connection Manager button 18
Connection Manager trees 42
Connection Status button 18
Connection Wizard 47
connections
database 43, 47
database folder 43
groups 44, 50
messages 20
online or offline 19
overview 42
repository 34, 43, 48
repository folder 43
Connections menu 17
Create
action icon 60
impact icon 62
Create Like action icon 60
creating
ad hoc SQL statements 179
application profiles 122
baselines 126, 129, 130
change filters 136
mask filters 141
objects 67
repositories 34, 121
scope filters 132
customer support 2
D
data structures
applying changes 161
recovering 119
database
analyzing impact of changes 61, 69, 70
archiving changes 65
commands 173, 179
connecting 53
duplicating schema and data 101
extracting objects 66
statistics 184
database connections
configuring 47
deleting from a group 52
editing in a group 51
folder 43
in groups 44, 50
overview 43
Database Connections folder 43
database instances
comparing 153
comparing with baselines 156
DDL files
comparing 159
importing 32, 33
deleting
application profiles 125
filters 146
scripts 26
Dependencies command 67
Dependencies pane 67
Dependencies tab 67
dialog box controls 16
Disconnect button 18
drag-and-drop
applying a change log 149
comparing two objects 112
in Object Manager 68
overview 19
Drop
action icon 60
impact icon 62
dropping objects 69
duplicating objects and data 101
E
Edit
action icon 60
impact icon 62
A

Index 205

B

C

D

E

F

G

H

I

J

K

L

M

N

O

P

Q

R

S

T

U

V

W

X

Y

Z

Edit Change Rule dialog box 139
Edit Data tool
  defining a query 181
  editing returned data 182
Edit menu 16
Edit OCDL tool 116
Edit Scope Rule dialog box 135
Edit Scripts tool 20, 64, 74, 92
  editing
    application profiles 124
    change filters 138
    mask filters 142
    objects 68
    privileges 184
    scope filters 133
encrypt password, options 83
Execute Privileges tool, overview 176
Execute SQL tool 172, 173, 179, 180
  extraction
    displaying status 19
    icon 59
    of objects 135
    on-demand 58, 66

F

features of Change Manager 15, 16
file management
  name extensions 20
  overview 20
File menu 16
Filter dialog box 58
  filtering objects 58
  filters
    associating with applications 144
    change filters 113
    deleting 146
    disassociating from applications 145
    mask filters 111
    overview 107
    scope filters 108
Filters folder 107

G

goal data structure 112
groups
  adding 50
  adding database connections 50
  copying 51
  deleting 52
  editing 51
  editing connections in 51
  overview 44
  setting up groups 50

Groups folder 43
GUI, common elements 16

H

Help
  full-text searching 21
  Help button 18
  locating information 21
  menu commands 17
  overview 21
  types of information 22
Host Login dialog box 76
Host Wizard 46, 48, 49
hosts
  configuring 46
  connecting 76, 130, 168
  verifying connection status 26
Hosts folder 43

I

icons
  action 59
  impact 24, 62
Impacted Objects tab 24, 62
Import DDL/OCDL command 117, 164
Import Objects to a Work Session dialog box 164
Invalidate impact icon 62

J

Job Log window 63
job log, viewing for a script 26
Job Scheduler tool
  archiving completed jobs 26
  creating baselines 130
  Job Queue tab 25, 26, 71, 77, 98, 131, 168
  processing OCDL files 166
  scheduling scripts 65, 75
  What tab 25, 75, 76
  When tab 25, 76
  Where tab 25, 130

L

loading data during migration 93
logging in 53, 76, 130, 168

M

managing
  applications 107
database changes 105
files 20
migrations 87
schema 57
Mask Filter Editor 141
mask filters
  adding a rule 143
  creating 141
  deleting a rule 144
  editing 142
  editing a mask rule 144
overview 111
use in baselines 147, 157
use in Compares 110
mask rules
  adding 143
  defining 141
  deleting 144
  editing 144
masking object attributes 141
menus
  Actions 17
  Connections 17
descriptions of options 16
  Edit 16
  File 16
  Help 17
  Options 17
  pop-up 17
  Tools 17
  View 16
  Window 17
Message Log 20
messages 20
Migrate
  action icon 60
  impact icon 62
migrating
  between databases 86, 99
  client-side analysis 96
duplicating objects and data 87
loading data 93, 100
objects and data 93, 95
overview 85
running the script 93
schema only 103
server-side analysis 97
setting preferences 88
tasks 94
unloading objects and data 93, 100
use of FTP 94
verifying 91
within the same database 101
workflow 87
monitors
  viewing 184

N
name propagation 165
New button 18

O
Object Manager
  Analysis Wizard 61
database connections 43
generating scripts 63
  Impacted Objects tab 62
overview 23, 58
Pending Actions tab 24, 60
retrieving objects 58
use in Compare process 110
object tree 19, 24
objects
  analyzing changes 61, 69, 70
  analyzing migrations 96, 97
clearing change requests 60, 73
comparing 151
creating 37, 67
dropping 37, 69
duplicating 101
editing 37, 68
extracting 19, 66, 135
filtering 58
masking attributes during a Compare 141
migrating 87
privileges 177, 184, 185
resolving dependencies 67
specifying changes 63
specifying migrations 95
supported actions 60, 62
verifying changes 60
verifying migrations 91
Objects tab 24
OCDL files
  concepts 113, 114, 115
database connections 43
for DDL compares 161
generating 162, 163, 164
importing 164
processing on the server 117
offline sessions 45
Online Help
  full-text searching 21
locating information 21
types of information 22
using 21
Open button 18
Options menu 17
options, analysis 62, 88
P

password encryption 83
patrolcl command
  assigning a group ID 78
  deleting immediate jobs 81
  deleting scheduled jobs 81
  details about immediate jobs 81
  details about scheduled jobs 81
  options 78
  output logs 81
  placing scheduled jobs on hold 81
  releasing held immediate jobs 81
  releasing scheduled jobs 81
  restarting a halted job 81
  running commands 77
  running immediate jobs 78
  running jobs 78
  setting up the UNIX host 82
  starting at specific procedures 78
  viewing summary of jobs 82
Pending Actions tab 24, 60
pending actions, clearing 60, 73
pop-up menus 17
privileges
  columns 186
  granting 185
  implementing 188
  modifying 184
  overview 177
  revoking 188
  setting 188
  verifying SQL syntax 187
product overview 14
product support 2
publishing changes 115

Q

query results 173, 180

R

Rebuild
  action icon 60
  impact icon 62
recovering data structures 119
Refresh button 18
Rename impact icon 62
repositories
  connecting 53
  creating 121
Repository Connection Wizard 48
repository connections
  configuring 34, 48
  folder 43
  overview 43
  resolving object dependencies 67
  restarting a script 26
results table
  editing returned data 182
  Execute SQL tool 173, 180
  roles for product access 188

S

Save button 18
saving a session 65
scheduling
  jobs on multiple servers 168
  scripts 75, 77
schema management tasks 57, 65
schemas, comparing 149
scope filters
  adding scope rules 134
  copying 132
  creating 132
  deleting scope rules 135
  editing 133
  extracting objects 135
  overview 108
  use in baselines 126
scope rules
  adding 134
  defining 108
  deleting 135
  editing 135
scripts
  archiving 26
  built-in 188
  deleting from the job queue 26
  files 20
  generating 63, 74
  managing 26
  placing on Hold 26
  releasing from Hold 26
  restarting 26
  running immediately 65, 93
  scheduling to run later 26, 65, 75, 93
  sequencing tasks 77
  verify host login 26
  viewing the job log 26
SELECT statement
  Edit Data tool 181
  results table 180
server-side analysis 62, 117, 165
server-side job scheduling 77
sessions
  files 21
  messages 20
online or offline 19
opening 57
saving 65
SQL statements
  creating 173
  generating a script 63, 74
statistics, viewing 184
status bar 19
Stop Extraction button 18
support, customer 2
synchronization
  applying changes 161
  overview 117
system messages 20

T
tables, editing data 182
tasks
  configuration 31, 45
  managing changes 120
  managing schema 65
  migrating objects and data 94
  using Change Manager tools 178
technical support 2
templates for baseline names 123, 125
toolbar
  buttons 18
  overview 17
tools
  Edit Data tool 181, 182
  Edit OCDL tool 116
  Edit Scripts tool 74
  Execute Privileges tool 176, 184
  Execute SQL tool 172, 179
  Job Scheduler tool 65, 75
  Monitors tool 184
  tasks 178
  Utilities tool 174
Tools menu 17

U
UNIX hosts, using with patrolcl 82
unloading data for migration 93
Utilities tool, overview 174
utility files 20

V
View menu 16
viewing
  change logs 149
  database statistics 184
  results table for a SELECT query 180

W
window controls 16
Window menu 17
wizards
  Analysis 61
  Application Profile 122
  Compare 109
  Connection 47
  Create a baseline 35, 129
  Host 46
  Repository Connection 48
work session 57
Notes